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Bolim 1. Giris

IBM System Storage DS3000 Storage Manager Version 2 (bu belgede Storage
Manager yazilimi seklinde adi geger), depolama altsistemlerinizi ydnetmek igin
kullanabileceginiz bir anasistem yazilimidir.

Bu belge, asagidaki AMD ya da Intel islemci tabanl igletim sistemlerinin her birinde
Storage Manager yazilimini nasil hazirlayacaginiza, kuracaginiza,
yapilandiracaginiza ve ¢alisacaginiza iligkin bilgi saglar:

* Microsoft Windows Server 2003 with Service Pack 1

* Novell NetWare 6.5

+ Red Hat® Enterprise Linux Advanced Server 3.0 (RHEL AS 3)

* Red Hat Enterprise Linux Advanced Server 4.0 (RHEL AS 4)

* SUSE Linux Enterprise Server 9 (SLES 9)

» SUSE Linux Enterprise Server 10 (SLES 10)

* VMware ESX Server 2.5.4

* VMware ESX Server 3.0.1

Storage Manager yazilimi tarafindan desteklenen igletim sistemlerini listeleyen

birlikte islerlik matrisi icin bkz. Ihttp://www.ibm.com/systems/storage/disk/d330004
ds3200/ ya da |nttp://www.ibm.com/systems/storage/disk/ds3000/ds3400/

IBM Destek (Support) Web sitesinden belgelerin edinilmesi

Sabit yazilim ve belge glncellemeleri saglanabiliyorsa, bunlari IBM destek Web

sitesinden yUkleyebilirsiniz. Storage Manager yaziliminin birimle birlikte génderilen

belgelerde tanimlanmayan 6zellikleri olabilir ve bu 6zelliklerle ilgili bilgileri icerecek

sekilde belgeler ara sira giincellenebilir ya da depolama altsistemi belgelerinde

bulunmayan ek bilgileri saglamak igin teknik gtincellemeler saglanabilir.

Guncellemeleri denetlemek icin asagidaki adimlari tamamlayin:

1. |http://www.ibm.com/servers/storage/support|adresine gidin.

2. Product Family (Uriin Ailesi) alaninda Select your product (Uriiniiniizii segin)
altinda Disk systems (Disk sistemleri) secenegini tiklatin.

3. Product (Uriin) alaninda IBM System Storage DS3200 ya da IBM System
Storage DS3400 seceneklerini tiklatin.

4. Go (Git) secenegini tiklatin.
5. Asagidaki segimleri yapin:

« Sabit yazihm gilincellemeleri ve benioku dosyalari icin Download (Yikle)
etiketini tiklatin.

* Belge giincellemeleri icin Install and use (Kur ve kullan) etiketini tiklatin.

Not: IBM Web sitesinde degisiklikler dizenli olarak yapihr. Sabit yazilimi ve belgeleri
bulma yordamlari bu belgedekilere gére degisiklik gdsterebilir.

Bu belgedeki notlar

Bu belgede asagidaki notlar yer almaktadir:
* Not: Bu notlar dnemli ipuglarini, yénlendirme ya da &neri bilgilerini icerir.

+ Onemli: Bu uyarilarda, uygunsuz ya da sorun yaratabilecek durumlari nlemek
Uzere size yardimci olabilecek bilgiler ya da dneriler bulunur.
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« Uyari: Bu notlar, programlarin, aygitlarin ya da verilerin zarar gérebilecegini
belirtir. Bu uyari notu, zararin meydana gelebilecedi yénerge ya da durumdan
hemen énce verilir.

Storage Manager yazilimi ¢cevrimici yardim ve tanilama programliari

Kurulus islemini bitirdikten sonra, asagidaki ¢cevrimici yardim sistemlerine bakin:

» Enterprise Management penceresi yardimi
Tum yénetim etki alaniyla nasil ¢galisilacagini 6grenmek igin bu ¢evrimigi yardim
sistemini kullanin.

* Subsystem Management penceresi yardimi

Tek tek depolama altsistemlerinin nasil yonetilecedini 6grenmek igin bu gevrimigi
yardim sistemini kullanin.

Bu yardim sistemlerine Storage Manager Istemcisinden erisebilirsiniz. Enterprise
Management ya da Subsystem Management penceresinden Help (Yardim)
segenegini tiklatin ya da F1’e basin.

Fiber Kanal tanilama programlari

Storage Manager yazilimini kurduktan sonra, Fiber Kanal anasistem veriyolu
bagdastiricilarini yénetecekseniz, QLogic SANsurfer Storage Management Suite ya
da Emulex HBAnywhere yardimci programini kurmayi disinin. Depolama
altsistemini kullanmadan 6nce, Fiber Kanal baglantilarinin dogru olarak ¢alistigindan
emin olmak i¢in bu tanilama uygulamalarini kullanabilirsiniz.

QLogic SANsurfer program dosyalari ve Emulex HBAnywhere yardimci programi
dosyalari, depolama altsistemiyle birlikte gdnderilen IBM System Storage DS3200
and DS3400 Support CD'sinde bulunur. Anasistem igletim sisteminiz igin gegerli olan
dosyalar CD’de yer alir. Ek bilgi icin program ¢evrimici yardimina bakin.

Not: QLogic SANsurfer program dosyalari ve Emulex HBAnywhere yardimci
programi dosyalari, DS3000 destek Web sitesinde bulunur.

Ek ozellikler

Ek 6zellikler, sinirli olan ya da temel depolama altsistemi modelinizle kullaniimayan
gorevleri gerceklestirmenizi saglayan gelismis islevsellik saglar. Ek bilgi almak igin,
bkz. [Bslim 10, “Ek &zelliklerin etkinlestirilmesi ve kullaniimasi”, sayfa 99,

DS3000 depolama altsistemi igin asagdidaki ek 6zellikleri satin alabilirsiniz:
« DS3200 Software Feature Pack
» DS3400 Software Feature Pack
» DS3000 FlashCopy Expansion License
» DS3000 Volume Copy License
» DS3000 FlashCopy Volume Copy License
» DS3000 Partition Expansion License
FlashCopy
FlashCopy 6zelligi, FlashCopy mantiksal sirlicllerinin olusturulmasini ve

y6netilmesini destekler. Bir FlashCopy mantiksal siriicisi, depolama
altsistemindeki, temel mantiksal stricl olarak adlandirilan, baska bir
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mantiksal strlictinin mantiksal anlik gérantistdar. Bir FlashCopy gérintasa,
tam bir fiziksel kopyanin mantiksal esdederi olsa da daha hizli yaratilir ve
diskte daha az yer kaplar.

FlashCopy gériintlsu, bir anasistem adreslenebilir mantiksal slrlclsi
oldugu icin, FlashCopy gorintisi kullanarak yedekleme yapabilirsiniz; bu
sirada temel mantiksal strlict ¢evrimigi durumda kalir ve kullanici tarafindan
bu sirtclye erisilebilir. Uygulama sinamasi ya da senaryo gelistirme ve
¢6zimleme islemleri gergeklestirmek icin FlashCopy mantiksal surticisiine
veri de yazilabilir. izin verilen en fazla FlashCopy mantiksal siiriiclisii sayis,
denetleyici modelinizin destekledigi mantiksal striict toplam sayisinin yarisi
kadardir.

VolumeCopy

VolumeCopy 6zelligi, bir depolama dizisindeki mantiksal sirlicl verilerini
¢ogaltmak igin kullanilan sabit yazilim tabanl bir mekanizmadir. Bu ézellik bir
sistem yOnetimi araci olarak, donanim blyitmeleri ya da basarim yénetimi
igin verileri diger sUrlicllere yeniden yerlestirmek, veri yedeklemek ya da
FlashCopy mantiksal surtict verilerini geri yuklemek gibi gbrevler igin
kullantlir.

VolumeCopy isteklerini, iki uyumlu sirici belirterek gdénderirsiniz. Bir stirlici
Source (Kaynak) ve digeri Target (Hedef) olarak belirlenir. VolumeCopy istegi
kalicidir, bu nedenle kopyalama isleminin ilgili tim sonuglari size bildirilebilir.

Not: VolumeCopy ve Logical Drive Copy terimleri bu belgede, Storage
Manager Client programi arabiriminde ve ¢evrimici yardimda birbirinin
yerine kullaniimigtir.

Partition Expansion

Partition Expansion (Bolim Genisletme) 6zelligini, depolama altsistemindeki
tanimli mantiksal strdcilerin timand birkag farkli bélim araciligiyla bir
SAN’a tanitmak igin kullanabilirsiniz. Bunu, her bir mantiksal striictiniin
tanimlanan bélimlerin her birinde bir LUN numarasina (0 - 31)
eslestiriimesiyle gerceklestirebilirsiniz. Bir mantiksal strlcd, bir defada
yalnizca bir bélimle eslestirilebilir. Bir depolama bélimiinde, eslestirilen
mantiksal siriicllere, yalnizca ilgili depolama bélimiinde tanimh Fiber Kanal
ve SAS anasistem veriyolu bagdastiricisi anasistem kapilari bulunan
anasistem sunucusu ya da sunucular erisebilir. Bu 6zellik, DS3000 depolama
altsisteminin, anasistem sunucusunda birden ¢ok sanal depolama sistemi
gibi islev gdérmesini saglar.

Partition Expansion ayrica kendilerine 6zgl disk depolama altsistemi ayarlari
olan farkli igletim sistemleri kullanan birden ¢ok anasistemin ayni DS3000
depolama altsistemine ayni anda baglanmasini da saglar. Bu, tirdes
olmayan anasistem ortami olarak da bilinir.

Gerekli terimler

Terminoloji hakkinda daha fazla bilgi igin, Storage Manager Enterprise Management
penceresindeki ya da Storage Subsystem Management penceresindeki cevrimigi
yardima bakin.

Bu belgeyi okurken asagidaki iki terim arasindaki farki anlamaniz énemlidir:

Yénetim istasyonu

Ydnetim istasyonu, DS3000 depolama altsistemini yénetmek icin kullanilan
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bir sistemdir. Asagidaki yéntemlerden birini kullanarak yénetim istasyonunu
depolama altsistemine baglayabilirsiniz:

» Depolama altsistemindeki denetleyicilere kurulacak TCP/IP Ethernet
baglantisiyla (bant disi ydntemiyle)

» Bir anasistem sunucusunda kurulu olan anasistem-araci yazihmiyla
kurulacak bir TCP/IP baglantisiyla; bu baglanti Fiber Kanal G/C yoluyla
dogrudan depolama altsistemine baglanir (bant igi ydntemi).

Ek bilgi almak igin, bkz.[‘Depolama altsistemi yénetim yéntemleri” sayfa 7,

Anasistem sunucusu
Anasistem sunucusu, DS3000 depolama altsistemine Fiber Kanal ya da SAS
G/C yoluyla dogrudan bagh bir sunucudur. Bu sunucu asagidaki gérevleri
gerceklestirmek icin kullantlir:

* Depolama altsisteminden veri (genellikle dosya bicimindedir) hizmeti
vermek.

» Uzaktan y6netim istasyonu olarak depolama altsistemine baglanti noktasi
islevi gérmek.
Notlar:

1. Anasistem ve anasistem sunucusu terimleri bu belgede birbirinin yerine
kullaniimigtir.

2. Bir anasistem sunucusu, ydnetim istasyonu iglevini de gérebilir.

Windows Server 2003 icin Storage Manager yazilimi
Storage Manager yazilim paketi, Microsoft Windows Server 2003 i¢in asagidaki
bilesenleri igerir:
« Storage Manager Agent (SMagent)
» Storage Manager Utility (SMutil)
» Storage Manager Client (SMclient)

» Storage Manager RDAC (Redundant Disk Array Controller; Yedek Disk Dizisi
Denetleyicisi )

Not: Storage Manager RDAC, Windows igin ¢oklu yol G/C’si (MPIO) Device
Specific Module (DSM) ¢oklu yol stricisini kurar. Storage Manager RDAC,
Linux RDAC’sinden farklidir.

Storage Manager Client (SMclient) istemcisini, yonetim istasyonuna kurun. SMclient
istemcisini anasistem ydnetim istasyonuna kurmak istege baglhdir.

Asagidaki bilesenleri yalnizca anasisteme kurun:
» Storage Manager RDAC (MPIO)

» Storage Manager Agent (SMagent)

» Storage Manager Utility (SMutil)

Storage Manager Client

Storage Manager Client (SMclient) bileseni, ydnetim depolama altsistemleri igin grafik
kullanici arabirimi (GUI) sagdlar. SMclient iki ana bilesen icerir:

« Enterprise Management. Enterprise Management bilesenini yénetim etki alani
icindeki depolama altsistemlerini eklemek, kaldirmak ve izlemek i¢in kullanin.

* Subsystem Management. Subsystem Management bilesenini bagimsiz bir
depolama alt sisteminin bilesenlerini ydnetmek icin kullanin.
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Event Monitor (Olay izleme), SMclient ile birlikte paketlenmis ayri bir programdir.
Event Monitor (Olay izleme) kuruluysa, Enterprise Management penceresi
kapaliyken depolama altsistemlerini izler. Artalanda slrekli caligir ve gok 6nemli bir
sorun olustugunda uyari iletileri génderebilir.

Not: Otomatik ESM sabit yazilim eszamanlama iglevini kullanmay! planliyorsaniz,
Event Monitor 6zelligini etkinlestirmelisiniz.

Yeni EXP3000 depolama genisletme kasasiyla ESM sabit yazilimini otomatik
eszamanlama: Otomatik ESM sabit yazilim eszamanlama islevini destekleyen bir
DS3000 depolama altsistemine bagli olan EXP3000 Uriintine yeni bir ESM
kurdugunuzda, bu 6zellik, yeni ESM’deki sabit yazilimi, var olan ESM’deki sabit
yazihimla otomatik olarak eszamanlayarak sabit yazilima iligkin yanlis eslesme
sorunlarini gozer.

Storage Manager RDAC (MPIO)

Storage Manager RDAC (MPIO), anasistem G/C yolundaki bir bilesende hata
¢iktiginda, denetleyicinin hata durumunda yedek sisteme ge¢cmesi icin gereken coklu
yol sirOcisind icerir.

Storage Manager Agent

Storage Manager Agent (SMagent), SMclient'in DS3400 depolama altsistemini Fiber
Kanal G/C yolu araciligiyla yapilandiracag ve izleyecegi bir yénetim yolu saglar. Bu
aracl, ayrica, istemci’nin anasistem {zerinde mi, yoksa TCP/IP adi iizerinden ag
ybnetim istasyonuna mi kurulduguna bagh olarak SMclient’a yerel ya da uzaktan
erisim saglar.

Not: Bu belgenin hazirlandigi tarih itibariyle, DS3200, bant ici ydnetimi desteklemez.

Storage Manager Utility
Storage Manager Utility (SMutil) yeni mantiksal sdrlcUleri dinamik olarak tanimlar ve
isletim istemine esler. Bu yazilim paketinde asagidaki bilesenler bulunur:
* hot_add yardimci programi

Yeni olusturulan mantiksal strticileri isletim sisteminde kaydetmek icin hot_add
yardimci programini kullanin. Ek bilgi almak icin, bkz. [*hot_add yardimci|
[programinin kullaniimasi” sayfa 94|

* SMdevices yardimci programi

Depolama altsistemi mantiksal surdcdlerini, isletim sistemi aygit adlariyla
iliskilendirmek igin SMdevices yardimci programini kullanin. Ek bilgi almak igin,
bkz.[‘SMdevices yardimci programinin kullaniimasi” sayfa 95

* SMrepassist yardimci programi

FlashCopy ya da VolumeCopy gérintisi olusturmadan énce énbellege alinan
verileri temizlemek icin SMrepassist yardimci programini kullanin. Ek bilgi almak
igin, bkz.|“SMrepassist yardimci programinin kullaniimasi” sayfa 95l

Not: SMrepassist yardimci programi, yalnizca Windows’ta kullanilabilen bir
yardimci programdir. Windows diginda bir igletim sistemi kullaniyorsaniz
dosya sisteminin baglantisini kesin.
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Linux icin Storage Manager yazilimi

DS3000 Storage Manager paketleri, Support CD'sinde ve |http://www.ibm.com/|
iservers/storage/support]| adresinde bulunan Linux igletim sistemlerinin iki gekirdekli
strimleri icin saglanir. Bu paketler yalnizca Intel ve AMD mimarisindeki x86 32 bitlik
(IA-32) ve x86 64 bitlik (AMD64 ve EM64T) islemcilere sahip sunucular igin
kullanilabilir.

Storage Manager yazilim paketleri, Linux igin asagidaki bilesenleri igerir:
« Storage Manager Runtime (SMruntime)

» Storage Manager Utility (SMutil)

» Storage Manager Client (SMclient)

* Linux RDAC

Not: Linux RDAC, Linux icin MPP (multipath proxy; ¢oklu yol vekili sunucusu)
¢oklu yol strlicisini kurar. Linux RDAC, Windows icin Storage Manager
RDAC’sinden farklidir. Linux RDAC, Linux i¢in Storage Manager yazihm
paketinden farkli bir paket olarak saglanir.

Storage Manager Client (SMclient) bilesenini ydnetim istasyonuna kurun. SMclient
istemcisini anasistem sunucusuna kurmak istege baghdir.

Asagidaki bilesenleri yalnizca anasisteme kurun:
» Storage Manager Utility (SMutil)

* Linux RDAC (MPP)

» Storage Manager Agent (SMagent)

Yonetim istasyonu bilesenleri

Asagidaki bilesenleri ydnetim istasyonuna kurun. Bu bilesenleri anasistem
sunucusuna kurmak istege baglidir.

» Storage Manager Runtime (SMruntime)

Bu bilesen, otomatik olarak Storage Manager Client ile birlikte kurulur. Diger
yazilim paketlerinin kurulmasi i¢in gerekli olan Java ¢alistirma ortamini icerir.

» Storage Manager Client (SMclient)

Depolama altsistemini bir anasistem sunucusundan ya da bir yénetim
istasyonundan ydnetmek i¢in bu bilesen gereklidir.

Anasistem bilesenleri
Asagidaki bilesenleri yalnizca anasisteme kurun:
» Storage Manager Utility (SMutil)

Bu bilesen, SMclient paketinde yer alir ve hot_add ve SMdevices yardimci
programlarini icerir.

- Linux RDAC (MPP)

Bu bilesen ¢oklu yol hata durumunda yedek sisteme gecis/onarim sonrasi geri
doénis yetenegi saglar.

Not: Linux RDAC, Linux igletim sistemleri i¢in Storage Manager paketindeki diger
yazilim bilesenleriyle paketlenmemigtir. Ayrica, her bir Linux ¢ekirdek strima
igin farkli bir RDAC siirlim{ oldugundan, Linux gekirdeginize iligkin
sUrimuandzin dogru oldugundan emin olmak igin en son benioku dosyasina
bakin.
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» Storage Manager Agent (SMagent)

DS3400 depolama altsistemi igin anasistem-araci (bant igi) yonetim ydntemini
kullanmay planlyorsaniz bu bilesen gereklidir. SMagent’i kurmadan énce Linux
RDAC’nin kurulmasi gerekir.

Notlar:

1. Linux igletim sistemi ortaminda DS3000 depolama altsistemlerini ydnetmek igin
tercih edilen yontem dogrudan (bant disi) ydntemdir.

2. Bu belgenin hazirlandig tarih itibariyle, DS3200, bant igi yonetimi
desteklemez.

NetWare icin Storage Manager yazilimi

Depolama altsistemi denetleyicisi sabit yazilimi, NetWare anasistemine bir DS3000
depolama altsistemi baglantisini destekler ancak, bu belgenin hazirlanma tarihi
itibariyle, Storage Manager yazilimi, NetWare ydnetim istasyonlarinda desteklenmez.
Ek bilgi almak icin, bkz.[Bslim 6, “Storage Manager yaziliminin standart bir NetWare]
lyapilandirmasina kurulmasi”, sayfa 63|

NetWare anasistem sunucusuna bagli DS3000 depolama altsistemini yénetmek igin,
Storage Manager SMclient programinin Windows ya da Linux striim0ni yénetim
istasyonuna kurmali ve DS3000 depolama altsistemine bant digi bir ynetim
baglantisi olusturmalisiniz. Windows ya da Linux yénetim istasyonundaki Storage
Manager Client programini nasil kuracaginiza iligkin bilgiler icin[B8lim 3, “Storaag;e|
Manager yazihminin standart bir Windows yapilandirmasina kurulmasi’| (sayfa[37) ya

da|Béliim 5, “Storage Manager yaziliminin bir Linux yapilandirmasina kurulmast’]
(sayfa51) baslikli konulara bakin.

Depolama altsistemi yonetim yontemleri

Storage Manager yazilimi, depolama altsistemlerinin yonetilmesi igin asagidaki iki
yéntemi sunar:

* Anasistem-araci (bant ici) ydnetim yéntemi (yalnizca DS3400)
* Dogrudan (bant digi ya da Ethernet) yonetim yéntemi

Dogru anasistem tipini elde etmek icin DS3000 depolama altsistemine dogrudan
(bant digi) yonetim baglantisi kurmalisiniz. Dogru anasistem tipi, DS3000 depolama
altsisteminin kendini anasistem sunucusunun igletim sistemi igin dogru
yapilandirmasini saglar. Bunu yaptiktan sonra, 6zel yer gereksinimlerinize gore, iki
ydnetim sisteminden birini ya da her ikisini de kullanabilirsiniz. Yazilim bilesenlerini
kurmaniz gereken yer sectiginiz yénetim yéntemlerine gére belirlenir.

Birden cok ydnetim istasyonundan ya da anasistemden ayni DS3000 depolama
altsistemine ydnetim baglantilari olusturursaniz, bir DS3000 depolama altsistemi en
¢ok sekiz eszamanli etkin ydnetim oturumunu desteklese de, DS3000 depolama
altsistemine bir kerede yalnizca bir etkin ydnetim baglantisi kurmalisiniz.
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Anasistem-araci (bant ici) yonetim yontemi (yalnizca DS3400 icin)
Anasistem-araci (bant ici) yénetim yéntemini kullanirken, depolama altsistemlerini
anasistem icin Fiber Kanal G/C yolu Gizerinden yénetirsiniz. Yénetim bilgileri
anasistemde iglenebilir ya da[Sekil 1] (sayfa[g) icinde gdsterildigi gibi, ag baglantisi
Uzerinden ybnetim istasyonuna aktarilabilir.

Not: Bu belgenin hazirlandidi tarih itibariyle, DS3200, bant i¢i ydnetimi desteklemez.

Anasistem-araci
yazihminin galistiriimasi

Anasistem bilgisayari

‘«——— Fiber Kanal G/C yolu

’ Denetleyici ‘ ***** i Ag—>

’ Denetleyici ‘ ,,,,,,,

Depolama altsistemleri

Not: Anasistem
yonetim istasyonu
olarak da islev gorur.

Yonetim istasyonu
(bir ya da daha ¢ok)

Sekil 1. Anasistem-araci (bant i¢i) yéntemiyle ydnetilen depolama altsistemleri

Depolama altsistemlerini anasistem-araci tzerinden yénetmenin avantajlari
asagidaki gibidir:

« Ethernet kablolarini denetleyicilere baglamaniz gerekmez.

* Depolama altsistemlerini aga baglamak icin DHCP/BOOTP sunucusu gerekmez.

+ [Bélim 2, “Kurulus igin hazwhk”l(sayfa icinde aciklanan denetleyici ag
yapilandirma gorevlerini gergeklestirmeniz gerekmez.

» Bir depolama altsisteminde bagimsiz denetleyiciler i¢in ayri ayri olmak yerine,
yalnizca anasistem igin bir anasistem adi ya da IP adresi tanimlanmasi yeterlidir.
Anasisteme baglanan depolama altsistemleri otomatik olarak algilanir.

Depolama altsistemlerinin anasistem-araci tizerinden ydnetilmesinin dezavantajlari

asagidaki gibidir:

* Anasistem-araci depolama altsistemindeki denetleyicilerle iletisim kurmak igin
erisim mantiksal sdriicisd adi verilen 6zel bir mantiksal strlcl gerektirir. Bu
nedenle, kullandiginiz anasistem bagdastiricisinin ve igletim sisteminin izin verdigi
en fazla mantiksal sUrlci sayisindan bir azini yapilandirmakla sinirlanirsiniz.

* Anasistem ve altsistem arasindaki Fiber Kanal yolu baglantisi kesilirse, altsistemi
ybnetemezsiniz ya da izleyemezsiniz.
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Not: Erisim mantiksal sirlcisine Universal Xport Device (Evrensel Xkapisi Aygiti)

adi da verilir.

Onemli:Anasisteminizde en fazla sayida mantiksal siiriicti yapilandiriimissa,
dogrudan yénetim yéntemini kullanin ya da mantiksal strtculerden birinin erigim
mantiksal surdictsu olarak kullanimindan vazgecin. Ek bilgi almak igin, bkz.

I'Desteklenen mantiksal siiriicii sayisi” sayfa 24}

Gereken anasistem-araci (bant i¢i) yonetim etkinlikleri
Anasistem-araci (bant i¢i) yénetim baglantilar olusturmak i¢in asagidaki genel
gbrevleri tamamlayin:

1.

DS3400 depolama altsistemi ve anasistem sunucusu arasindaki Fiber Kanal
baglantilarini yapin.

2. Anasistem sunucusuna TCP/IP kurun ve bir anasistem IP adresi olusturun.

Anasistem tarafindan yénetilen sistemlere iligkin yénergeler icin bkz.['AJ kurulusu
[gérevleri - Genel bakig” sayfa 29

Anasistem sunucusunda anasistem veriyolu bagdastiricisi aygit strlctsun,
SMclient, RDAC (Windows igin MPIO, Linux igin Linux RDAC) ve SMagent’|
kurun.

Storage Manager Agent Service programinin basarili olarak baslatildijindan
emin olun:

a. Start » Settings » Control Panel » Administrative Tools » Services (Bagslat
— Ayarlar — Denetim Panosu — Ydnetim Araclar — Hizmetler) seceneklerini
tiklatin. Services (Hizmetler) penceresi agllir.

b. IBM System Storage DS3000 Storage Manager 2 Agent’i bulun ve durumun
Started (Bagslatildi) oldugundan emin olun.

Storage Manager Enterprise Management penceresini agin ve ydnetim etki
alanina anasistem sunucusunun IP adresini ekleyin. Anasistem sunucusu
tarafindan algilanan tim DS3000 aygitlari, Enterprise Management penceresinde
goruntdlenir.
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Dogrudan yonetim (bant disi) yontemi
Dogrudan yénetim (bant disi) yéntemini kullanirken, depolama altsistemlerini her bir
denetleyiciye TCP/IP Ethernet baglantisi araciligiyla dogrudan ag tzerinden
ybnetirsiniz. Depolama altsistemini Ethernet baglantilari Gzerinden ydnetmek igin,
Once her bir denetleyicinin IP adresini ve anasistem adini tanimlamalisiniz.
Depolama altsistemi denetleyicilerinin her birinin (sayfa icinde gosterildigi
gibi RJ-45 baglacina bagli bir kabloyla Ethernet agina bagli olmasi gerekir.

Asagidaki sekilde depolama altsistemlerinin dogrudan yénetim (bant disi) yontemiyle
y6netildidi bir sistem gésterilmigtir.

Anasistem bilgisayari

Fiber Kanal ya da SAS
G/C yolu

’ Denetleyici ‘ ***** !

’ Denetleyici ‘ ,,,,,,,

Depolama altsistemleri

<+— Ethernet

Yo6netim istasyonu
(bir ya da daha ¢ok)

Sekil 2. Dogrudan yénetim (bant disi) depolama altsistemleri

Depolama altsistemlerinin dogrudan yénetim (bant dig) yéntemiyle yénetilmesinin

avantajlar asagidaki gibidir:

* Denetleyicilerle kurulan Ethernet baglantilari, SMclient yénetim istasyonu
Uzerinden Storage Manager programinin destekledigi herhangi bir isletim sistemini
calistiran bir anasisteme bagli depolama altsistemlerini yénetmenizi saglar.

» Denetleyicilerle iletisim kurmak igin erisim mantiksal surticisiine gerek yoktur.
Boylece, kullandiginiz anasistem veriyolu bagdastiricisi ve igletim sisteminin
destekledigi en fazla sayida mantiksal siriictyl yapilandirabilirsiniz.

» Fiber Kanal ya da SAS baglantilarinda sorun ¢iktiginda depolama altsistemini hem
ybnetip hem de depolama altsistemindeki sorunlari giderebilirsiniz.

Depolama altsistemlerinin dogrudan yénetim (bant digi) yéntemiyle yénetilmesinin

olumsuz ydnleri asagdidaki gibidir:

» Depolama altsistemi denetleyicilerini aga baglamak igin iki Ethernet kablosuna
gereksinim duyarsiniz.

* Aygit eklerken, her bir denetleyici igin ayri bir IP adresi ya da anasistem adi
tanimlamak zorunda kalirsiniz.
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« Ag hazirlama gérevleri gereklidir. Hazirlama gérevlerinin 6zeti igin, bkz.
[‘Kurulus icin hazirlik”, sayfa 27}

Onemili:

« DHCP/BOOTP sunucusu ve ag gorevleri gereksinimini énlemek igin,
denetleyicinin varsayilan TCP/IP adreslerini kullanin ya da denetleyiciye
statik IP adresleri atayin (bkz.|Cizelge 1).

+ DS3000 depolama altsistemlerinizi ydnetmek igin ana tretim agindan
bagka bir 6zel ag olusturun.

» Bant digi agi, Ethernet anahtarlarindan ya da gébeklerinden olusabilir
ancak, bu belgenin hazirlanma tarihi itibariyle basamaklanan gdébekler
desteklenmez.

Denetleyici TCP/IP adreslerinin tanimlanmasi
Asagidaki sekilde, depolama altsistemi denetleyicileri igin varsayilan ayarlar
gOsterilmektedir.

Cizelge 1. Varsayilan denetleyici TCP/IP adresleri

Denetleyici IP adresi Alt ag maskesi
A 192.168.128.101 255.255.255.0
B 192.168.128.102 255.255.255.0

DS3000 depolama altsistemi denetleyicisinin varsayilan TCP/IP adresini degistirmek
icin, 6nce varsayilan TCP/IP adreslerini kullanarak depolama altsistemiyle dogrudan
ybénetim baglantisi kurmalisiniz.

Storage Manager Client programini kullanarak denetleyicinin varsayilan TCP/IP
adresini degistirmek icin asagidaki adimlari tamamlayin:

1. Enterprise Management penceresinde yeni denetleyici TCP/IP adreslerini
tanimlamak istediginiz depolama altsistemini ¢ift tiklatin. Subsystem Management
(Altsistem Ydnetimi) penceresi agilir.

2. Tools (Araglar) etiketini tiklatin.

3. Tools (Araclar) sayfasinda, Change Network Configuration (AJ
Yapilandirmasini Degistir) secenegini tiklatin. Change Network Configuration (Ag
Yapilandirmasini Degistir) penceresi agllir.
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Tools > Change Network Configuration

Change Network Configuration

Selegt cortralier:
Controller in Siot A ¥

Host e SIMPLEX_Ctia
Etherret port: 1
MAC address: D a0 bi1d 23

Change configuration (port 1) Advance d

1 Optain from DHCP/Booty server

& Specity configuration:
Podtbess:  [i01883108
Subhet mask: |255.25500
Gateveay ooo

oK Cancel

Sekil 3. Change Network Configuration penceresi

4. Gecerli denetleyici etiketini secin ve denetleyici A ve B’ye iliskin gecerli TCP/IP
adres bilgilerini girin.
5. Yeni TCP/IP adreslerini uygulamak i¢in OK (Tamam) diigmesini tiklatin.

Onemli: Girdiginiz yeni TCP/IP adresi bilgilerinin dogrulugundan emin olun,
¢Unkl denetleyicilerin varsayilan TCP/IP adresleri bir kez degistikten
sonra, eski adresleri kullanarak depolama altsistemine dogrudan
y6netim baglantisi kuramazsiniz.

6. Subsystem Management penceresini kapatin.

7. Enterprise Management penceresinde, varsayilan TCP/IP adreslerini igeren
depolama altsistemi girigini silin.

8. Yaklasik bes dakika bekleyin ve yeni TCP/IP adreslerini kullanarak depolama
altsistemiyle yénetim baglantisini yeniden olusturun.

Not: Depolama altsistemini Enterprise Management penceresine eklemeden
6nce denetleyicilerdeki ag baglantisinin diizgun ¢aligsip calismadigini
anlamak igin yeni adreslerde 6nce ping komutunu galistirmak
isteyebilirsiniz.

Gereken dogrudan yénetim (bant disi) yénetim etkinlikleri

Dogrudan yénetim baglantisini kurmak igin agagidaki adimlari tamamlayin:

1. DS3000 depolama altsistemleri ve Ethernet agi arasinda Ethernet baglantisi
kurun.

2. Dogrudan yénetilen sistemler icin|Ag kurulusu gorevleri - Genel bak|§_| (sayfa
icindeki yonergeleri izleyin. DS3000 denetleyicilerine IP adresleri atayin.

3. SMclient yazihmini kurun.

4. Storage Manager yazilimini baglatin ve DS3000 denetleyicilerine (A ve B) iligkin
IP adreslerini ekleyin. Birden cok DS3000 depolama altsisteminiz varsa, her bir IP
adresini etki alanina ekleyin.
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Ornek bir agin incelenmesi

Asagidaki sekilde hem dogrudan yénetilen bir depolama altsistemi (Ag A), hem de
anasistem-araci tarafindan ydnetilen bir depolama altsistemi (Ag B) g&sterilmigtir.

AgA
TCP/IP Ethernet
Fiber Kanal ya da SAS
G/C yolu
Depolama
altsistemi
’ ‘ ’ ‘ finansi ’ H
Ag Anasistem bilgisayani,, || Y0netim istasyonu DHCP/BOOTP
yonetimi Denver — bir ya da daha ¢ok) sunucusu
istasyonu (IP adresi: - —
192.168.128.112
(SNME _tuzaklarl ) Anasistem adi: Denver_a
igin) (IP adresi: 192.168.128.101)
donanim adresi 00.a0.b8.02.04.20
B o Anasistem adi: Denver_b
Yonlendirici (IP adresi: 192.168.128.102)
donanim adresi: 00.a20.b8.00.00.d8
Ag B
TCP/IP Ethernet

Fiber Kanal G/C yolu

Anasistem bilgisayari |
Atlanta
(IP adresi
192.168.2.22)

.

Depolama
altsistemi
muhendisligi

Denetleyici
Denetleyici

]

Yoénetim istasyonu
(bir ya da daha ¢ok)

Sekil 4. Dogrudan ve anasistem-araci tarafindan yénetilen depolama altsistemlerini kullanan

ag ornegi

Dogrudan yonetilen depolama altsistemi

(sayfa[13) iginde Ag A, dogrudan ydnetilen bir depolama altsistemidir. AG A,

asagidaki bilesenleri icerir:
» Bir DHCP/BOOTP sunucusu

* SNMP tuzaklari igin bir NMS (Network management station; Ag yonetimi

istasyonu)

* Depolama altsistemine Fiber Kanal ya da SAS G/C yolu aracihdiyla bagdli bir

anasistem

« Depolama altsistemi denetleyicilerine Ethernet kablosuyla bagl bir yénetim

istayonu

Not: Denetleyicilerin statik TCP/IP adreslerini ya da varsayilan TCP/IP adreslerini
kullaniyorsaniz, DHCP/BOOT sunucusunu kurmaniz gerekmez.

Boélim 1. Girig
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Anasistem-araci tarafindan yénetilen depolama altsistemi

Sekil 4 (sayfa icinde AgJ B, anasistem-araci tarafindan yénetilen bir depolama
altsistemidir. A§ B, asagidaki bilesenleri igerir:

* Depolama altsistemine Fiber Kanal G/C yolu aracihiyla bagdli bir anasistem

* Anasistem sunucusuna Ethernet kablosu aracilifiyla bagli bir yénetim istasyonu

Yazilim bilesenlerinin kurulacagi yerler

Cesitli yazilim bilesenlerinin kurulacag yerler depolama altsistemlerinin nasil
ybnetilecegine goére belirlenir.

Yonetim istasyonlari

SMclient bileseni her bir yénetim istasyonuna ayri ayri kurulmalidir.

Anasistem sunuculari

Asagidaki yazihm bilesenleri her bir anasistem sunucusuna ayri ayri kurulmalidir.

Cizelge 2. Zorunlu anasistem yazilim bilesenleri

_ QLogic SANsurfer ya da
Isletim sistemi RDAC SMutil |LSIMPE |Emulex HBAnywhere QLRemote aracisi
Linux Evet (bkz. not 1) |Yes Evet (bkz. not 2) Yes (Evet)

(Evet)
Windows Server | Evet (bkz. not5) |Yes Evet (bkz. not 2) Yes (Evet)
2003 (Evet)
NetWare Yes (Evet) Evet (bkz. not 3)
VMWare ESX Bkz. not 4.
Server

Notlar:

1. Linux, Linux RDAC’yi (MPP) ¢oklu yol slrlcisi olarak kullanir. Ayrintili Linux
RDAC kurulus yénergeleri igin bkz. [‘Linux RDAC yaziliminin kurulmasi” sayfa 54}

2. Qlogic SANsurfer ya da Emulex HBAnywhere yazilim bilesenlerini yalnizca, IBM
Fiber Kanal anasistem veriyolu bagdastiricisi yénetimi icin ve anasistem
sunucusu anasistem veriyolu baddastiricisi ve DS3400 depolama altsistemi
arasindaki Fiber Kanal yolunda ortaya ¢ikan sorunlari gidermek igin kullanin.

3. QLRemote aracisi, Qlogic SANsurfer programi ile birlikte kullanilir ve NetWare
sunucusu olmayan bir sunucuya kurulmahdir. Yalnizca, IBM Fiber Kanal
anasistem veriyolu bagdastiricisi yénetimi ve NetWare anasistem sunucusu
anasistem veriyolu bagdastiricisi ve DS3400 depolama altsistemi arasindaki
Fiber Kanal yolunda ortaya gikan sorunlari gidermek igin kullanihr.

4. Bu belgenin hazirlanma tarihi itibariyle, Storage Manager yazilimi, VMware ESX
Server igletim sistemlerinde kullanilamaz. VMware iginde goklu yol isletimi igin bir
yerlesik aygit stirictsu vardir.

5. Windows, goklu yol siriicisl olarak Storage Manager RDAC (MPIO DSM)
kullanir.

Depolama altsistemlerini nasil ydnetmeyi planladiginiza bagh olarak, asagidaki ek
anasistem yazilim bilesenlerini kurmaya gereksinim duyabilirsiniz:

* SMclient (Windows Server 2003 ve Linux )
* SMagent (Windows Server 2003 ve Linux [yalnizca Linux RDAC ile])
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Notlar:

1.

DS3400 depolama altsistemlerini anasistem-araci yénetim yéntemiyle
ybnetecekseniz, SMagent programini bir anasistem sunucusuna kurun.
Anasistem sunucusunun bir ydnetim istasyonu olarak ¢alismasini istiyorsaniz,
SMclient’1 anasistem sunucusuna kurun. Anasistem sunucusu aga bagh degilse,
TCP/IP yazilimini kurup bilgisayara IP adresi atamalisiniz.

SAN baglantili bir yapilandirmanin olusturulmasi (Fiber Kanal)

Bu bélim asagidaki konular igerir:

SAN baglantili bir yapilandirmanin hazirlanmasi
SAN baglantili bir yapilandirmanin ayarlanmasina iligkin adimlar
Anasistem veriyolu bagdastiricilarinin Fiber Kanal anahtar ortamina baglanmasi

SAN baglantili bir yapilandirmanin hazirlanmasi
SAN baglantili bir yapilandirma olusturmadan 6nce, asagidaki bilgileri okuyun:

Ayni sunucudaki ¢oklu anasistem veriyolu bagdastiricilarinin ayni DS3400
denetleyici kapisini "gérmediginden” emin olun.

Coklu yol yapilandirmasi, her anasistemde, iki denetleyiciden birine bagh ayri bir
anahtar bélgesinde bulunan ikiser anasistem veriyolu bagdastiricisi bulunmasini
gerektirir.

Her bir anasistemdeki Fiber Kanal anasistem veriyolu bagdastiricisi ve her bir
DS3000 depolama altsistemindeki denetleyici kapisi tek bir Fiber Kanal
anahtarindan baglaniyorsa, kendi yéneltme yapisi bélgelerinde olmalidir.

Not: Tek anasistem veriyolu bagdastiricisi yapilandirmalarina izin verilir. SAN
baglantili bir yapilandirmada tek bir anasistem veriyolu bagdastiricisi varsa,
denetleyicinin, bir anahtar lzerinden anasistem veriyolu bagdastiricisina
Fiber Kanal baglantisi olmasi ve her iki denetleyicinin anasistem veriyolu
bagdastiricisiyla ayni SAN bdlgesinde bulunmasi gerekir.

Uyari: Tek anasistem veriyolu bagdastiricisi yapilandirmasinda bir yol
arizalanirsa, verilere erisim kaybi meydana gelebilir.

SAN baglantili bir yapilandirmanin ayarlanmasi
SAN baglantili bir yapilandirma ayarlamak igin asagidaki adimlari tamamlayin:

1.
2.
3.

Anasistem veriyolu bagdastiricilarini anahtara ya da anahtarlara baglayin.
DS3000 depolama altsistemlerini anahtarlara baglayin.
Uygunsa, gerekli bolgeleri Fiber Kanal anahtar(lar)inda ayarlayin.

Not: Bdlge olusturma ve bdlgelerin etkinlestiriimesine iligkin bilgi i¢in anahtarla
birlikte gdnderilen belgelere bakin.

Sistemi yapilandirin ve sistemi gériintilemek Uzere anahtarda oturum agarak
yapilandirmayi dogrulayin.

DS3000 depolama altsisteminin kurulmasina iliskin daha fazla bilgi igin Quick
Installation Guide (Hizh Kurulus Kilavuzu) adh yayina ve depolama altsistemiyle
birlikte génderilen Support CD’sindeki diger belgelere bakin.
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Anasistem veriyolu bagdastiricilarinin Fiber Kanal anahtar ortamina
baglanmasi

Anasistem sunucularindaki Fiber Kanal anasistem veriyolu bagdastiricilarini Fiber
Kanal anahtar ortamindaki DS3000 depolama altsistemi anasistem kapilarina

baglarken, anasistem veriyolu bagdastiricisi ve DS3000 anasistem kapilari arasinda
bire bir bélge olusturun.

Fiber Kanal anahtari iginde bir bdlge olusturmaya iliskin yénergeler igin Fiber Kanal
anahtariyla birlikte génderilen belgelere bakin.

|http://www.ibm.com/servers/storage/support/san/index.htmll adresinden anahtar
belgelerine iligkin baglantilari bulabilirsiniz.

Yapilandirma tipleri

Storage Manager yazilimini agagidaki yapilandirmalardan ikisinde kurabilirsiniz:
« Standart (kimelenmemis) yapilandirma

« Klmelenmis sunucu yapilandirmasi

Not: Asagidaki bolimlerdeki kimelenmis sunucusu yapilandirmalarina iligkin
sekiller NetWare ya da Linux’la ilgili degildir.

Standart (kiimelenmemis) yapilandirma
iginde standart (kimelenmemig) bir yapilandirma érneg@i gdsterilmektedir.

MPIO (Windows
icin), MPP (Linux
icin), SMutil,
Smagent

,,,,,,,,,,,

Anasistem bilgisayari

147 Fiber Kanal ya da SAS
‘ 1 G/C yolu

’ Denetleyici

| SMclient yazilimi
’ Denetleyici ‘ fffffff anasistem bilgisayarina
da yuklenebilir.

Depolama altsistemleri

SMclient

<+— Ethernet

Yo6netim istasyonu

Sekil 5. Standart (kiimelenmemis) yapilandirma 6rnegi
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Windows icin kiimelenmis sunucusu yapilandirmasi
iginde kiimelenmis sunucu yapilandirmasi 6rnegdi gdsterilmektedir.

MPIO, SMutil, SMagent

| & a |

Ethernet —

SMclient

Kiime sunucusu /" Kiime sunucusu
digim A o digim B

\

1

I
i
1
v
|

SMclient yazihmi
kiime dugumlerine de
yuklenebilir.

i Fiber Kanal igin,
' ybnetilen gébek

ya da anahtar,

kiime sunucusu
digimleri ve
depolama altsistemi
arasinda kullanilabilir.

Yo6netim istasyonu
(bir ya da daha ¢ok)

# Fiber Kanal ya da
SAS G/C yolu

’ Denetleyici ‘ ”””””

’ Denetleyici ‘ ”””””

Depolama altsistemi

Sekil 6. Klimelenmis sunucu yapilandirmasi érnegi

Sistem gereksinimleri

Bu boélimde Storage Manager yaziliminin donanim, yazihim ve isletim sistemi
gereksinimlerine iliskin ayrintil bilgiler verilmektedir.

Donanim gereksinimleri

(Cizelge 3 sayfa 18|icinde Storage Manager 2 yaziliminin kurulmasi igin donanim
gereksinimleri listelenmistir.
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Cizelge 3. Storage Manager 2 yaziliminin donanim gereksinimleri

Donanim bileseni Gereksinimler

YOnetim istasyonu (istemci Ydnetim istasyonu bilgisayari asagidaki donanimi gerektirir:

yazilimi icin) + Intel Pentium ya da Pentium esdegeri mikroiglemci (450
MHz ya da daha hizli)

» CD siricusu

» Fare ya da benzeri bir isaretleme aygiti

» Sistem bellegi: Windows Server 2003, Linux ve NetWare
icin: En az 256 MB (512 MB 6nerilir)

= Ethernet agi arabirim bagdastiricisi

* AGP ya da PCI video bagdastiricisi (AGP 6nerilir); ISA
bagdastiricilari desteklenmez

* 64 000 renkli, 1024 x 768 piksele ayarli ekran. izin verilen en
disik ekran ayari 256 renkli 800 x 600 pikseldir.

* Donanim tabanli Windows hizlandirmasi. Sistem bellegini
g6rintl bellegi igin kullanan masausti bilgisayarlar, Storage
Manager yazihmiyla galistiriimaz.

Onemli: Bazi sunucular, grafik yogunluklu yazilim galistirmak
lizere tasarlanmamistir. Sunucunuz Storage Manager kullanici
arabirimini gériintilerken sorun ¢ikiyorsa, sunucunuzun
g6rintt bagdastiricisini blyitmek durumunda kalabilirsiniz.

Anasistem bagdastiricilari, yéneltme yapilari ve yénetilen gébeklerle ilgili daha
ayrintili bilgi almak icin ServerProven Web sitelerine bakin:

Ihttp://www.ibm.com/servers/eserver/serverproven/compat/us/|

Ihttp://www.ibm.com/systems/storage/disk/ds3000/ds3200/|

|http://www. ibm.com/systems/storage/disk/ds3000/ds3400/|

Sabit yazilim diizeylerinin belirlenmesi

DS3000 depolama altsistemi, genisletme birimi, stirlici ve ESM sabit yazilim
sUrimlerini belirlemenin iki ydntemi vardir. Her bir ydntem bagli genigletme birimiyle
DS3000 depolama altsistemini yéneten Storage Manager Client’i kullanir.

Yoéntem 1

Subsystem Management penceresini acin ve Summary (Ozet) etiketinin Hardware
Components (Donanim Bilesenleri) béliminde Storage Subsystem Profile
(Depolama Altsistemi Profili) segenegini tiklatin. Storage Subsystem Profile penceresi
acildiinda, sabit yazihm bilgilerini gériintilemek icin asagidaki etiketlerden birini
segin.

Not: Storage Subsystem Profile penceresinde tim altsistemin profil bilgisi bulunur.

Bu nedenle, istediginiz bilgileri bulmak icin pek ¢ok bilginin arasinda gezinmek
zorunda kalabilirsiniz.
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Summary (Ozet) etiketi
+ Sabit yazilm sirimU (denetleyici sabit yazilimi)
* NVSRAM sirimi

Asagidaki 6rnekte Summary sayfasindaki profil bilgileri gértntilenir.

F Storage Subsystem Profile

Logical Drives | Drives | = Drive Chanhels | E‘f Enclozures | ﬁ Mappings | @A\I
3
[2] Surmmary [ cortralers | % Brrays
Current configuration ;I
Firmware wersion: 96.17.41.03
HVSRAM wersion: H1726D32LRI1TVO3

Pending configuration
Staged firmware download supported: Yes

Firmware wersion: Hone
HVSRAM wersion: Hone
Transferred on: Hone
Controller enclosure audible alarm: Disabled
NWERAN canfirmred for harteriss: Ve LI
Find:
-l o Save Az, | Close | Hela
Results:

Sekil 7. Summary sayfasindaki profil bilgileri 6rnegi

Controller (Denetleyici) etiketi
» Sabit yazilim sGrimi
» Appware strimu (Appware denetleyici sabit yazilmiyla ilgilidir)
» Bootware sirimu (Bootware denetleyici sabit yazilimiyla ilgilidir)
« NVSRAM sUriimi

Asagidaki 6rnekte Controller (Denetleyici) sayfasindaki profil bilgileri
g6rantdlenir.

&% Storage Subsystem Profile x|
E Logical Drives | a Drives | = Drive Channgls | E‘f Enclozures | ﬁ Mappings | @A\I
B Surmmary ! Controllers % Arrays
Controller in Enclosure 0, Slot A ;I
Atatus: Online —I
Current configuration
Firmware version: 96.17.41.03
Appware wersion: 96.17.41.03
Bootware wversion: 96.17.41.03
NVIRAM wersion: HN1726D3ZLRIL7V0O3
Pending configuration
Firmware wersion: Hone
st e trersinn: Mere =
Find:
I - & Save As.. | Cloge | Help
Results:

Sekil 8. Controller sayfasindaki profil bilgileri 6rnegi

Boélim 1. Girig
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Enclosures (Kasalar) etiketi
» Sabit yazilim sGrimi

Asagidaki drnekte Enclosures (Kasalar) sayfasindaki profil bilgileri
gbrantdlenir.

% Storage Subsystem Profile . 5'

E Summary | ! Cortrollers | % Arrays
E Logical Drives | Crives a Crive Channels E Enclosures | ﬁ Mappings All
Date of marmfacture: Jarmary 1, 2006 _;I
Z E3M Canisters Detected
ESM card status: Optimal —d
Firmware wersiomn: 0164
HMaximim data rate: 3 Gbps
Current data rate: 3 Ghps
Location: 4 (left)
Card communication: [1):4
Drndnct TTie FYRRANA ﬂ
Find:
I ;l El Save bz Help
Resuts:

Sekil 9. Enclosures sayfasindaki profil bilgileri 6rnegi

Drives (Siiriculer) etiketi
+ Sabit yazilim strimU (sUriict sabit yazilimi)

Asagidaki drnekte Drives (Surtculer) sayfasindaki profil bilgileri gérintllenir.

% Storage Subsystem Profile . il
@ Summary | ! Controllers | % Arrays
E Logical Drives Drives | a Drive Channels | E'@ Enclosures | ﬁ Mappings | Al
FROFILE FOR STORAGE SUBSV3TEM: SIMPLEX (10/24/06 7:21:00 PM) =
DRIVE.
SUMMARY

HNumber of driwes: L
Current driwve types: Serial Attached ZC3I (34%) (1)

BASIC:
TRAY, SLOT STATUS CAPACITY TYPE CUREENT DATA RATE FPRODUCT ID FIFMWARE VERSION
0,1 Optimal 33.902 GB 545 3 Ghps AT336754535 Bald
=
4 _>l_I
Find:
hd ﬁ Save As.. | Clusa Help |

Results:

Sekil 10. Drives (Sdrdcller) sayfasindaki profil bilgileri érnegi

Yoéntem 2

Subsystem Management penceresini acin ve Support (Destek) etiketi altinda
Download Firmware (Sabit Yazilimi YUkle) seceneklerini tiklatin. Sabit yazilim
bilgilerini gériintilemek icin asagidaki baglantilardan birini secin.
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Not: Ydéntem 2'yi yalnizca sabit yazilim suriimlerinin dogru oldugundan emin olmak
igin kullanin. Sabit yazilim slrimlerini denetledikten sonra, sabit yazilimi
istemeden yiklemeyi 6nlemek icin pencereleri iptal edin ya da kapatin.

Denetleyici sabit yazilimi ylikleme

+ Sabit yazilm sirimuU (denetleyici sabit yazilimi)
* NVSRAM sirimu

NVSRAM’i yiikleme
* NVSRAM siriimu
Siriicli sabit yazilimini yiikleme
+ Sabit yazilim strimu (sriict sabit yazilimi)

ESM sabit yazilimini yiikleme
* ESM sirimi

Microsoft Windows yazilim gereksinimleri

Storage Manager yazilim gereksinimleri ve Microsoft Windows isletim sistemi
gereksinimleri asagidaki bélimlerde anlatilir.

Storage Manager yazilim gereksinimleri

icinde Storage Manager yazilmini Windows ortamina kurmak igin gereken
disk alani ve ydnetici ayricaliklari listelenmistir.

Not: iginde belirtilen disk alani, kurulugtan sonra paketlerin kapladigi yeri
belirtir. Her bir yazilm paketinin kurulusu igin ayrica 150 MB bos disk alani
ayirmalisiniz.

Cizelge 4. Yazilim paketine gére Windows Server 2003 i¢in kurulus gereksinimleri

Windows Server 2003 i¢in disk Windows Server 2003 i¢in yonetici

Paket alani gereksinimi ayricaligi

140 MB Yonetici ayricaligr gerekli degildir.
SMclient
MPIO 2MB Yodnetici ayricaligr gereklidir.
SMagent 1 MB Ydnetici ayricaligi gereklidir.

50 MB (SMclient kurulu degilse)

SMutil 2MB Yonetici ayricaligr gereklidir.

Windows isletim sistemi gereksinimleri

Her ybnetim istasyonu, anasistem sunucusu ya da kime digimu i¢in asagidaki
isletim sistemlerinden biri gereklidir.

Onemli: En son desteklenen isletim sistemi ve anasistem yazilimi stiriimleri icin,
Storage Manager benioku dosyalarina ve |http:/www.ibm.com/servers/|
leserver/serverproven/compat/us/ adresine bakin.

Yénetim istasyonu

* Windows XP, Professional Edition

» Service Pack 1 (SP1) ile Windows Server 2003, Web Edition
* SP1 ile Windows Server 2003, Standard Edition
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» SP1 ile Windows Server 2003, Enterprise Edition
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Anasistem sunucusu

» SP1 ile Windows Server 2003, Web Edition

» SP1 ile Windows Server 2003, Standard Edition

» SP1 ile Windows Server 2003, Enterprise Edition

Kiime diigimu
* SP1 ile Windows Server 2003, Enterprise Edition

Linux yazilim gereksinimleri

Storage Manager yazilim gereksinimleri ve Linux igletim sistemi gereksinimleri
asagidaki bélimlerde anlatilir.

Storage Manager yazilim gereksinimleri

icinde Storage Manager yaziliminin Linux ortamina kurulmasi igin gereken
disk alani belirtilmistir.

Cizelge 5. Yazilim paketine gére Linux igin kurulugs gereksinimleri

Paket Disk alani gereksinimi

Storage Manager Client (SMclient) /opt dizininde 70 MB, /tmp dizininde 2 MB ,
/var dizininde 1 MB

Linux RDAC (MPP) 2 MB

Storage Manager Agent (SMagent) /opt dizininde 2 MB

Storage Manager Utility (SMutil) /opt dizininde 7 MB

Linux isletim sistemi gereksinimleri
Asagidaki cekirdek diizeyleri Linux isletim sistemleri icin gereklidir:
* 2.4 gekirdek (RHEL 3)
» 2.6 gekirdek (RHEL 4, SLES 9 ve SLES 10)

Desteklenen en son Linux igletim sistemleri, aygit strlictist duzeylerine iliskin
ayrintilar ve NetWare destegine ydnelik ¢oklu yol yapilandirmalarina iligkin
ybnergeler icin Storage Manager yazilimi benioku dosyalarina bakin.

NetWare yazilim gereksinimleri

Storage Manager yazilim gereksinimleri ve Novell NetWare isletim sistemi
gereksinimleri asagidaki bélimlerde anlatilir.

Storage Manager yazilim gereksinimleri

DS3000 depolama altsistemini yénetmek igin gereken Storage Manager yazilimi,
NetWare isletim sistemi ortami i¢in henliz kullaniimamaktadir.

NetWare anasistem sunucusuna bagh DS3000 depolama altsistemini ydnetmek igin,
Storage Manager SMclient programinin Windows ya da Linux sGriim0ini yénetim
istasyonuna kurup DS3000 depolama altsistemine bant digi bir ydnetim baglantisi
olusturmalisiniz.

Onemli: Belirli aygit stiriiciisti diizeylerine iliskin ayrintilar ve NetWare destegi icin
coklu yol yapilandirmasina iligkin yénergeler igin benioku dosyasina bakin.
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icinde Storage Manager yaziliminin NetWare anasistem ortamina
kurulmasi icin gereken disk alani belirtilmigtir.

Cizelge 6. Yazilim paketine gére NetWare icin kurulus gereksinimleri

Paket Disk alani gereksinimi
LSIMPE.cdm siiricisi 2 MB

IBM anasistem veriyolu bagdastiricisi aygit 2MB

surtcusu

NetWare isletim sistemi gereksinimleri

Her ybnetim istasyonu, anasistem sunucusu ya da kiime digimu igin asagidaki
isletim sistemlerinden biri gereklidir.

Onemli: En son desteklenen isletim sistemi ve anasistem yazilimi sGrimleri igin,
Storage Manager benioku dosyalarina ve|http://www.ibm.com/servers/
leserver/serverproven/compat/us/adresine bakin.

Yoénetim istasyonu

* Windows XP

* Windows Server 2003 with SP1

* Red Hat Enterprise Linux 3 ya da 4 (RHEL 3 ya da 4)

» SUSE Linux Enterprise Server 9 ya da 10 (SLES 9 ya da 10)

Anasistem sunucusu (yalnizca G/G baglantisi i¢in)
Support Pack 3 ya da daha sonraki sirimler ile Novell NetWare 6.5

Kiime diigiimi (yalnizca G/C baglantisi igin)
Support Pack 3 ile Novell NetWare 6.5

LSIMPE sitricusi
LSIMPE.cdm

Bu bilesenin siriimleri, Novell NetWare Support Pack’ler (Destek Paketleri) ya da
Novell Web sitesinde bulunan NetWare icin en son IBM anasistem veriyolu
bagdastiricisi aygit sirictstnde bulunur. Her zaman bu bilesenin en son strimanu
segin.

Not: Novell NetWare ortaminda, DS3000 depolama altsistemini dogrudan (bant disi)
yOntemiyle Windows ydnetim istasyonundan yénetmeniz gerekir.

Desteklenen mantiksal siirticii sayisi

Windows Server 2003, Linux ve NetWare icin desteklenen mantiksal stirlici sinirlari
asagidaki gibidir:
* Windows Server 2003, IBM anasistem veriyolu bagdastiricilarini ve onlarin

destekledigi aygit stricllerini kullandiginizda, en fazla 255 (LUN 0-254) mantiksal
surdclyd destekler.

* Linux, IBM anasistem veriyolu bagdastiricilarini ve onlarin destekledigi aygit
stUrtcilerini kullandiginizda, her bir depolama altsistemi igin en gok 256 (LUN
0-255) adet mantiksal sirlclyU destekler.
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Anasistem sunucusunda desteklenen mantiksal sirlici sayisi Ust siniri ve
depolama altsisteminden eglenebilecek mantiksal stirlici sayisi Ust siniri igin
Linux ¢ekirdek belgelerine bakin.

» SP3 ya da sonraki stirim(na iceren NetWare 6.5, IBM anasistem veriyolu

bagdastiricilarini ve onlarin destekledigi aygit strtictlerini kullandidinizda, her bir
depolama altsistemi icin en ¢cok 256 (LUN 0-255) adet mantiksal striclyU

destekler.

» DS3000 depolama altsisteminin destekledigi en fazla mantiksal striict sayisi

Cizelge 7|icinde listelenir.

Cizelge 7. Depolama altsistemi basina desteklenen en fazla mantiksal sdirlicti sayisi

Depolama birimi
bélimii basina en

En fazla FlashCopy

Maximum Logical
Drive Copy (En
Fazla Mantiksal
Siiriicii Kopyasi)

En fazla mantiksal fazla mantiksal mantiksal surict mantiksal
sliriicli sayisi stlirticii sayisi sayisi slrtciileri
256 32 (Bkz. not) 128 255
Notlar:

1.

Temel DS3000 modelleri icin en fazla dért bélim desteklenir. Bélim 4’ten B&IUm
16’ya blylitme yapmak icin DS3000 Partition Expansion License’1 (DS3000
B6lum Genigletme Lisansi) satin almalisiniz.

Her bir standart mantiksal sdrlicl, en cok doért FlashCopy mantiksal strtictsind
destekler.

Anasistem-araci yonetim yéntemi, depolama altsistemindeki denetleyicilerle
iletisim kurarken erisim mantiksal sdrdcisd adi verilen dzel bir mantiksal sirici
kullanir. Erisim mantiksal strictst kullanilabilir LUN’lardan birini kullanir. Bu
nedenle, depolama altsistemlerini anasistem-araci yazilimiyla ydnetirken, igletim
sistemi ve anasistem bagdastiricisinin destekledigi en fazla LUN sayisinin bir
azini kullanmak zorunda kalirsiniz. Erisim mantiksal strticistine Universal Xport
Device (Evrensel Xkapisi Aygiti) adi da verilir.

Onemli: FlashCopy mantiksal siiriiciisii, Windows Server 2003 ya da NetWare

ortaminda FlashCopy mantiksal strictsiniin temel mantiksal strtictsine
sahip ayni sunucuya eklenemez ya da bununla eslenemez. FlashCopy
mantiksal sUrlictstni bagka bir sunucuyla eslemelisiniz.
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Bolum 2. Kurulus icin hazirhk

Bu bélimde, Storage Manager yazilminin kurulusunu planlamaniza yardimci olacak
bilgiler bulunmaktadir.

Belirli bir isletim sistemine iliskin Storage Manager 2 Client ve anasistem yazilimini
kurmak i¢in bu belgenin ilgili bélimlerine bakin. Storage Manager 2 yazilim bilegeni
kurulug yordamlarini tamamladiginizda, [Béliim 8, “Storage Manager yaziliminin|
kurulusunun ve yapilandirmasinin tamamlanmasi’| (sayfa[71) ve[Bélim 9, “Windows|
anasistemlerine iliskin depolama yénetimi gérevlerinin tamamlanmasi’| (sayfa
baslikli konulardaki yordamlari gergeklestirin.

Windows kurulusunun planlanmasi ve hazirlanmasi

iginde Storage Manager yazilim bilesenlerinin kurulus sirasi gésteriimekte
ve Windows Server 2003 i¢cin Storage Manager yazilminin kurulugsunu planlamaniza
yardimci olacak bilgiler saglanmaktadir.

Cizelge 8. Windows ortaminda yazilim bileseni kurulus sirasi

Sistem tipi Yazilim kurulus sirasi

Ydnetim istasyonu SMclient

Anaﬁistem Sunucusu 14 |BM Fiber Kanal ya da SAS anasistem veriyolu bagdastiricisi aygit
ve kiime digimu shricisi

2. Storage Manager anasistem yazilim paketi agagidaki bilesenleri

kurabilir:

* SMclient (istege bagl)
Depolama altsistemini anasistem sunucusundan ydnetecekseniz
SMclient gerekir.

* MPIO (zorunlu)
MPIO (MPIO DSM olarak da adlandirilir), Windows Server 2003
icin RDAC yedek sisteme gegis siirlictisl olarak kurulur.

* SMagent (istege bagl)
Storage Manager kurulus sihirbazinda Typical Installation
(Standart Kurulug) secenegini belirlediginizde SMagent kurulur.
Anasistem-araci yénetim yéntemini kullanacaksaniz bu bilesen
gereklidir.

e SMutil (zorunlu)
SMutil, hot_add, SMdevices ve SMrepassist yardimci
programlarini igerir.

3. Anasistem veriyolu bagdastiricisi yénetim yazilimi (yalnizca Fiber
Kanal)

© Copyright IBM Corp. 2006 27



Linux kurulusunun planlanmasi ve hazirlanmasi

iginde Storage Manager yazilim bilesenlerinin kurulus sirasi gdsterilmekte
ve Linux i¢in depolama ydnetimi yaziliminin kurulusunu planlamaniza yardimci

olacak bilgiler saglanmaktadir.

Cizelge 9. Linux ortamina yazilim bileseni kurulug sirasi

Sistem tipi Yazilim kurulus sirasi

Yonetim istasyonu Storage Manager Client (SMclient)

(ve ydnetim

istasyonu olarak Bkz. [‘Kurulus sihirbazi kullanilarak Storage Manager 2 yaziliminin

kullanilan herhangi ~ |[kurulmas” sayfa 52,
bir anasistem
sunucusu)

—_

Anasistem sunucusu IBM anasistem veriyolu bagdastiricisi aygit stirtictisti (Linux
ve kiime digimi strima)

2. Linux RDAC (zorunlu)

Linux RDAC (MPP olarak da adlandirilir), Linux igcin RDAC hata
durumunda yedek sisteme gegis suriictisi olarak kurulur.

Bkz. ['Linux RDAC paketi” sayfa 53|
3. Storage Manager Agent (istege bagl)

Anasistem-araci (bant i¢i) yonetim yontemini kullanacaksaniz bu
bilesen gereklidir. Once Linux RDAC kurulmalidir (bkz. adim).
Linux ortaminda dogrudan (bant digi) yénetim yéntemi tercih edilir.

Bkz. |'Kurulus sihirbazi kullanilarak Storage Manager 2 yaziliminin|
[kurulmasi” sayfa 52

4. Storage Manager Utility

Bu zorunlu bilesen SMclient ile paketlenmistir ve hot_add,
SMdevices ve SMrepassist yardimci programlarini igerir.

5. (Istege bagh) Anasistem veriyolu bagdastiricisi yénetim yazilimi ve
QLRemote aracisi (yalnizca QLogic SANsurfer)
Fiber Kanal anasistem veriyolu bagdastiricisi tanilama iglevlerini

saglamak igin bu adimi tamamlayin. Anasistem veriyolu
bagdastiricisi ile gdnderilen kurulus belgelerine bakin.

Not: Linux RDAC, Storage Manager anasistem yazilim paketinden ayri olarak
saglanir. Her bir ¢ekirdek tipine bir tane olacak bigcimde iki Linux RDAC paketi
vardir:

* 2.4 gekirdegi (RHEL 3)
» 2.6 gekirdegi (RHEL 4, SLES 9 ve SLES 10)

NetWare kurulusunun planlanmasi ve hazirlanmasi

Storage Manager yazilimi NetWare isletim sistemi ortaminda kullanilamaz.

NetWare anasistem sunucusuna bagh bir DS3000 depolama altsistemini yénetmek
icin Storage Management SMclient programinin Windows ya da Linux strimand bir
yOnetim istasyonuna kurmali ve DS3000 depolama altsistemiyle bant digi bir ydnetim
baglantisi olusturmalisiniz.

[Cizelge 10 sayfa 29|icinde Storage Manager yazilim bilesenlerinin kurulug sirasi
gbsterilmekte ve depolama yénetimi yaziliminin kurulusunu planlamaniza yardimci
olacak bilgiler saglanmaktadir.
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Cizelge 10. Novell NetWare 6.5 ortaminda yazilim bileseni kurulug sirasi

Sistem tipi Yazilim kurulus sirasi

YOnetim istasyonu Storage Manager Client (SMclient)

(yalnizca Windows
ya da Linux yénetim

istasyonu)

NetWare anasistem | 1 Novell NetWare yerel hata durumunda yedek sisteme gegis aygit

Z“QUCUSU ve kime surticiisii (NetWare 6.5 igerecek bigimde otomatik olarak kurulur)
agumi

2. LSIMPE.cdm siriiclsi

3. Fiber Kanal ya da SAS anasistem veriyolu bagdastiricisi aygit
surdcasi

4. (istege bagh) Anasistem veriyolu bagdastiricisi yénetim yaziliminin
NetWare aracisi bileseni

Ag kurulusu gorevleri - Genel bakis

Depolama ydnetimi yaziimini kurmaya baglamadan énce, ag bilesenlerinin
kuruldugundan ve diizglin ¢alistigindan ve yazilimin diizgiin ¢galismasi igin gerekli
anasistem ve denetleyici bilgilerine sahip oldugunuzdan emin olun.

Asagidaki boélimlerde, dogrudan ydnetilen ya da anasistem tarafindan ydnetilen
depolama sistemlerine iliskin ag kurulusu ayarlariyla ilgili gérevlere bir genel bakig
saglanmistir:

Dogrudan yonetilen depolama altsistemleri: Ag kurulusuna genel bakis

Dogrudan yénetilen bir sistemin ag kurulusunun ayarlanmasi asagidaki genel
gorevleri igerir:

1.

Aga baglamak istediginiz tim donanim bilesenlerini kurun (anasistem sunuculari,
depolama altsistemleri ve kablolar). Kurulug bilgileri icin donanim aygitinizla
birlikte gbnderilen belgelere bakin.

Agda bagli depolama altsistemleri icin bir adlandirma kurali olusturun. Ek bilgi
almak igin, bkz.[‘Adim 1: Depolama altsistemlerinin adlandiriimasi” sayfa 30}

[Ek A, “Depolama altsistemi ve denetleyici bilgisi kaydi’] (sayfa |1 05|D baslikl
konudaki depolama altsistemi adlarini ve yénetim tiplerini kaydedin. [Cizelge 11]
(sayfa icinde tamamlanmisg bir bilgi kaydi érnegdi gosterilmektedir.

Not: Kalan adimlarda, donanim Ethernet adresleri ve IP adresleri gibi bilgileri
kaydetmek icin[Ek A, “Depolama altsistemi ve denetleyici bilgisi kaydr’|
(sayfa [105) baglikli konuya déndn.

Varsaylilan denetleyici IP adresini kuIIamyorsamz,|§|numaral| adima gegin. Tersi
durumda, ag ybneticisinden agdaki depolama altsistemlerinde bulunan her bir
denetleyicinin TCP/IP adresini ve anasistem adini edinin.|Adim 3: Anasistemlere|
[ve denetleyicilere IP adresi atanmasi| (sayfa [31) baslikli konuya bakin.
Denetleyici statik IP adreslerini (tercih edilen) kullanin; tersi durumda, belirli bir
denetleyiciye iliskin ag yapilandirma bilgilerini saglamak icin bir DHCP/BOOTP
sunucusu ayarlayin.

TCP/IP yaziliminin kuruldugundan emin olun. Ek bilgi icinJAdim 5 (Windows|
Server 2003 icin): TCP/IP iletisim kuralinin dogrulanmasi ve anasistem ya da
DNS cizelgesinin kurulmasﬂ(sayfa@ baslkli konuya bakin.

Aga bagli aygitlari agin.
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Anasistem tarafindan yonetilen sistemler: Ag kurulusuna genel bakis

Asagidaki adimlarda, ag tarafindan ydnetilen bir sistemin ag kurulusunu ayarlarken
gerceklestireceginiz gbrevlere genel bir bakis saglanmistir:

1.

6.

AgJa baglamak istediginiz tim donanim bilesenlerini kurun (anasistem sunuculari,
depolama altsistemleri ve kablolar). Kurulug bilgileri i¢in ilgili donanim aygitinizla
birlikte gdnderilen belgelere bakin.

Ada bagli depolama altsistemleri icin bir adlandirma kurali olusturun. Ek bilgi
almak igin, bkz.|“Ad|m 1: Depolama altsistemlerinin adIandmImasV’I
[Ek A, “Depolama altsistemi ve denetleyici bilgisi kaydi’|(sayfa [105) baslikli

konudaki depolama altsistemi adlarini ve ydnetim tiplerini kaydedin. |Qizelge 11|
(sayfa icinde tamamlanmis bir bilgi kaydi érnegdi gdsterilmektedir.

Not: Kalan adimlarda, donanim Ethernet adresleri ve IP adresleri gibi bilgileri
kaydetmek icin [Ek A, “Depolama altsistemi ve denetleyici bilgisi kaydr]
(sayfa [105) baslikli konuya dénain.

Anasistem-araci yaziliminin ¢alisacagi anasistem sunucusunun IP adresini ve

anasistem adini a§ yéneticisinden edinin.[Adim 3: Anasistemlere ve

[denetleyicilere IP adresi atanmasi| (sayfa[31) baslikli konuya bakin.

Not: Anasistem tarafindan y®netilen depolama altsistemleri yalnizca DS3400 ile
desteklenir.

TCP/IP yaziliminin kuruldugundan emin olun. Ek bilgi icin]Adim 5 (Windows|
Server 2003 icin): TCP/IP iletisim kuralinin dogrulanmasi ve anasistem ya da|
DNS cizelgesinin kurulmasi|(sayfa[34) baslikli konuya bakin.

Ada bagli aygitlari agin.

Adim 1: Depolama altsistemlerinin adlandiriimasi

Aginizi kurarken, depolama altsistemlerine iligskin adlandirma kurallarina karar verin.
Depolama yénetimi yazilimini kurarken ve ilk kez baslatirken, ydnetim etki alanindaki
tim depolama altsistemleri <unnamed> (adsiz) olarak gérinttlenir. Depolama
altsistemlerini tek tek yeniden adlandirmak igin Subsystem Management (Altsistem
Ydnetimi) penceresini kullanin.

Depolama altsistemlerini adlandirirken asagidaki etkenleri g6z énlinde bulundurun:

30 karakter siniri vardir. Adin éniindeki ve sonundaki tim bosluklar silinir.

Anlamasi ve hatirlanmasi kolay, benzersiz ve anlamli bir adlandirma sablonu
kullanin.

Tiretilmis ya da anlamini ¢gabuk kaybedebilecek adlar kullanmaktan kaginin.
Yazilim, depolama altsistemi adlarini gérintilerken Storage Subsystem
(Depolama Altsistemi) énekini ekler. Ornegin, bir depolama altsistemine

"Engineering” adini verirseniz, depolama altsistemi Storage Subsystem
Engineering olarak gérantllenir.

Adim 2: Depolama altsistemi adlarinin kaydedilmesi

Bir adlandirma sablonu Ozerinde karar verdikien sonra depolama altsistemi adlarini

[Ek A, “Depolama altsistemi ve denetleyici bilgisi kaydi’| (sayfa[105) baslikli konuda

bulunan bos bilgi kayit formuna kaydedin.
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icinde, icinde (sayfa[13) gdsterilen aga iligskin 6rnek bilgi kaydi
verilmektedir. Bu ag, dogrudan yénetim ve anasistem-araci yénetim yéntemlerinin
kullanildi§i depolama altsistemlerini igerir.

Cizelge 11. Bilgi kaydi 6rnegi

Depolama Yénetim Denetleyiciler-IP adresleri ve Anasistem-IP
altsistemi adi yéntemi anasistem adi adresi ve
Denetleyici A Denetleyici B anasistem adi
Finance Dogrudan IP adresi = IP adresi =
192.168.128.101 [192.168.128.102
Anasistem = Anasistem =
Denver_a Denver_b
Engineering Anasistem- IP adresi =
aracl 192.168.2.22
Anasistem =
Atlanta

Adim 3: Anasistemlere ve denetleyicilere IP adresi atanmasi

Depolama altsisteminizi bant disi ydnetim (dogrudan ydnetim) ydntemiyle yénetmeyi
planliyorsaniz, ag Uzerindeki tim depolama altsistemlerindeki her bir denetleyici igin
benzersiz bir IP adresi atayin. Bilgi kaydina her bir denetleyicinin IP adresini kaydedin
,S!Ek A, “Depolama altsistemi ve denetleyici bilgisi kaydi”, sayfa 10§|D. Daha sonra

dim 4: DHCP ya da BOOTP uyumlu sunucunun kurulmasi (sayfa bashkli

konuya gegin.

Not: DHCP/BOOTP sunucusu ve ag goérevlerini gerceklestirmemek icin denetleyici
varsayilan TCP/IP adreslerini kullanin ya da denetleyicilere statik IP adresleri
atayin. Statik TCP/IP adresi atamak icin denetleyicideki varsayilan TCP/IP
adresini kullanamiyorsaniz, [Dogrudan ydnetim (bant disi) y6ntemi|(sayfa
bashkli konudaki bilgilere bakin:

Daha sonralAdim 5 (Windows Server 2003 icin): TCP/IP iletisim kuralinin
dogrulanmasi ve anasistem ya da DNS cizelgesinin kurulmasi| (sayfa [34) baslikli
konuya gegin.

A ve B denetleyicisi igin sirasiyla 192.168.128.101 ve 192.168.128.102 varsayilan IP
adreslerini kullanarak DS3000 bant digi ydnetim baglantisi olusturabilirsiniz. IP
adreslerini Storage Manager Client Subsystem Management penceresini kullanarak
degistirebilirsiniz.

Yalnizca anasistem-araci yénetimi icin: DS4300 depolama altsistemini
anasistem-araci yénetim ydntemini kullanarak yénetmeyi planliyorsaniz,
anasistem-araci yazilimini kuracaginiz her bir anasistem icin bir IP adresi atayin.
Bilgi kaydina her bir anasistemin IP adresini kaydedin (Ek A, “Depolama altsistemi ve
denetleyici bilgisi kaydi”, sayfa 105). Daha sonralAdim 5 (Windows Server 2003 icin):
TCP/IP iletisim kuralinin dogrulanmasi ve anasistem ya da DNS cizelgesinin|

kurulmasi| (sayfa [34) baglikli konuya gegin.
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Adim 4: DHCP ya da BOOTP uyumlu sunucunun kurulmasi

Depolama altsistemlerini her bir denetleyiciye olan Ethernet baglantisiyla dogrudan
yénetmek igin bir DHCP ya da BOOTP uyumlu sunucu kurabilir ve agsagidaki
secenekleri yapilandirabilirsiniz:

* Yonlendirici/ag gegidi
* DNS sunucusu

* Anasistem adi
 DNS

Bu bélimde, Windows Server 2003 isletim sisteminde DHCP sunucusunun
kurulmasina iligkin ydnergeler saglanmaktadir.

Windows Server 2003 DHCP sunucusunun kurulmasi

BOQOTP statik adresleme 6zelligini destekleyen bir DHCP siriimin( kullanmaniz
gerekir. Bir DHCP sunucusu kullanmak icin DHCP Manager programi kurulmalidir.
Sistemde kurulu bir DHCP Manager programi varsa, [Bir kapsamin olusturulmasi ve|
[DHCP sunucusunun kurulmasi|(sayfa [32) baslikli konuya bakin.

DHCP Manager programinin kurulmasi
DHCP Manager programini kurmak icin asagidaki adimlari tamamlayin:

1. Sirasiyla Start » Control Panel » Add or Remove Programs (Baslat — Denetim
Masas!I — Program Ekle/Kaldir) seceneklerini tiklatin. Add or Remove Programs
(Program Ekle/Kaldir) penceresi agllir.

2. Soldaki pencere gézinde Add/Remove Windows Components (Windows
Bilesenlerini Ekle/Kaldir) se¢enegini tiklatin. Windows Components Wizard
(Windows Bilesen Sihirbazi) penceresi acilir.

3. Components (Bilesenler) alaninda Networking Services (Ag Olusturma
Hizmetleri) secenegini belirleyin. Daha sonra Details (Ayrintilar) dGgmesini
tiklatin. Networking Services (AJ Olusturma Hizmetleri) penceresi acilir.

Not: Networking Services alt bilesenlerinin timin( kurmak istemiyorsaniz, onay
kutusunu isaretlemeyin.

4. Subcomponents of Networking Services (AJ Olusturma Hizmetlerinin Alt
Bilesenleri) alaninda Dynamic Host Configuration Protocol (DHCP) (Dinamik
Anasistem Yapilandirmasi lletisim Kurali; DHCP) kutusunu isaretleyin. OK
(Tamam) dugmesini tiklatin.

5. Kurulug iglemini baglatmak igin Windows Components Wizard (Windows
Bilesenleri Sihirbazi) penceresinde Next (lleri) digmesini tiklatin.

6. lIstenirse, Windows Server 2003 dagitim dosyalarinin tam yolunu yazin ve
Continue (Devam Et) digmesini tiklatin.

7. Kurulus basariyla tamamlandiktan ve Windows Components Wizard (Windows
Bilesen Sihirbazi) penceresi acildiktan sonra Son digmesini tiklatin.

8. Add or Remove Programs (Program Ekle/Kaldir) penceresini kapatin. Art|k
|kapsam|n olusturulmasi ve DHCP sunucusunun kurulma5|’1 konusundaki
gorevleri gergeklestirebilirsiniz.

DHCP Manager programini kurduktan sonra ek bilgi icin DHCP Manager ¢evrimigi
yardimina bakin.

Bir kapsamin olusturulmasi ve DHCP sunucusunun kurulmasi
Kapsam, bir grup denetleyiciyi IP adreslerine gbre tanimlar. A Gzerindeki
denetleyicilere dinamik IP adreslerinin atanabilmesi igin, bir kapsam olusturup
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yapilandirmaniz gerekir. [Ek A, “Depolama altsistemi ve denetleyici bilgisi kaydr’]
(sayfa [105) baslikli konuya bakin. Baglamadan énce, gereken bilgileri belirlemek igin
ybnergeleri okuyun. Daha sonra, gerekili bilgileri ad yodneticinizden isteyin.

Bir kapsam olusturmak ve bir DHCP sunucusu kurmak icin asagidaki adimlari
tamamlayin:

1. Start » Administrative Tools » DHCP Server (Baslat — Y&netim Araglari —
DHCP Sunucusu) segeneklerini tiklatin. DHCP penceresi agilir.

2. Console (Konsol) agacinda, yapilandirmak istediginiz sunucuyu sag tiklatin ve
New Scope (Yeni Kapsam) secenegini belirleyin. New Scope Wizard (Yeni
Kapsam Sihirbazi) baglar.

3. TCP/IP istemcilerinin IP adresi kapsamini tanimlamak igin ekranda goériintllenen
ybnergeleri izleyin. Asagidaki alanlar tanimlanir:

* Kapsam adi ve agiklama

« Alt ag maskesi ve yapilandirmakta oldugunuz denetleyicilere iliskin IP adresi
araligi

* |P adresi araligindan ¢ikarmak istediginiz IP adresleri
» |P adresi kiralama slresi
* Genel DHCP segenekleri:

— Bir yonlendiricinin IP adresi

— Etki alani adi ve DNS sunuculari ya da Windows Internet Naming Service
(WINS) sunucular

4. Kapsami tanimladiginizda Yes, | want to activate this scope now (Evet,
kapsami simdi etkinlestirmek istiyorum) secenegini belirleyin. New Scope
Wizard (Yeni Kapsam Sihirbazi) penceresi agllir.

5. Finish (Son) digmesini tiklatin.DHCP penceresi acilir.

6. Console agacinda Scope (Kapsam) klasériinG agin.

7. Reservations (Rezervasyonlar) 6gesini sag tiklatin. New Reservations (Yeni
Rezervasyonlar) segenegini belirleyin. New Reservations (Yeni Rezervasyonlar)
penceresi acllir.

8. [P adresi rezervasyonunu tanimlamak i¢in asagidaki bilgileri yazin:
* Rezervasyon adi
* [P adresi
« Ethernet donanim MAC adresi
* Aciklama

9. Supported Type (Desteklenen Tip) alaninda Both (DHCP and BOOTP) (Her
ikisi [DHCP ve BOOTP]) secenegini belirleyin.

10. Add (Ekle) digmesini tiklatin.

11. Agdaki her bir denetleyici igin(sayfa -(sayfa arasindaki adimlari
tekrarlayin.

12. TUm degisikliklerin gecerli olmasi i¢in 6nce DHCP sunucusunu, daha sonra
depolama altsistemini yeniden baslatin.

13. ['Adim 5 (Windows Server 2003 icin): TCP/IP iletisim kuralinin dogrulanmasi ve|
anasistem ya da DNS gizelgesinin kurulmasi” sayfa 34| baglikli konuya gegin.
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Adim 5 (Windows Server 2003 icin): TCP/IP iletisim kuralinin
dogrulanmasi ve anasistem ya da DNS c¢izelgesinin kurulmasi

SMclient islevlerini etkinlestirmek icin asagidaki iki gérevi gerceklestirmenizi

gerektiren TCP/IP ag yiginini kurmaniz gerekir:

« TCP/IP iletisim kurali yazihminin yénetim istasyonuna ya da SMclient’i kurup
calistiracaginiz anasistem sunucusuna kuruldugundan emin olun.

* Anasistem ya da DNS cizelgesini ayarlayin.

Not: Denetleyici anasistem adlarinin, denetleyici IP adresleriyle eslestiginden emin
olun.

TCP/IP iletisim kurali yaziliminin kurulu oldugundan emin olmak ve anasistem ya da
DNS gizelgesini ayarlamak igin asagidaki adimlari tamamlayin:

1. Windows Explorer penceresini agin.

2. My Network Places (Ag Baglantilarim) klasérin sag tiklatin ve Properties
(Ozellikler) segcenegini belirleyin. Network Connections (Ag Baglantilari)
penceresi acllir.

3. Tanmimlanmis bir ag baglantisini sag tiklatin ve Properties (Ozellikler) secenegini
belirleyin.

4. Acilan Ag_adi Properties (Ozellikler) penceresinde, The Connection Uses The
Following ltems (Baglanti Asagidaki Ogeleri Kullanir) alaninda Internet
Protocol TCP/IP (Internet iletisim Kurali TCP/IP) onay kutusunu segin (6nceden
secilmediyse) ve OK (Tamam) digmesini tiklatin.

5. IP adresiyle iliskilendirmek (izere bir anasistem adi belirlemek icin DNS
gizelgesini giincelleyin. Bir DNS sunucunuz yoksa, IP adresi ve denetleyici adi
giriglerine baglanti olusturmak Uzere anasistemler dosyasini glincellemek igin bir
metin diizenleyicisi kullanin. Asagidaki érnekte Ag A'ya (Sekil 4 sayfa 13)
baglanan denetleyicilere iliskin anasistem gizelgeleri gésteriimektedir.

# Copyright (c) 1993-1999 Microsoft Corp.

+

This is a sample HOSTS file used by Microsoft TCP/IP for Windows.

This file contains the mappings of IP addresses to host names. Each
entry should be kept on an individual line. The IP address should

be placed in the first column followed by the corresponding host name.
The IP address and the host name should be separated by at least one
space.

H H B R

+*

Additionally, comments (such as these) may be inserted on individual
# lines or following the machine name denoted by a '# symbol.

# For example:

# 102.54.94.97 rhino.acme.com # source server
# 38.25.63.10 x.acme.com # x client host
127.0.0.1 localhost

192.168.128.101 denver_a

192.168.128.102 denver_b
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Adim 5 (Linux): TCP/IP iletisim kuralinin dogrulanmasi ve anasistem ya
da DNS cizelgesinin ayarlanmasi

Varsayilan kurulus islemi, TCP/IP yazilim paketini kurar.

Anasistemi ya da DNS ¢izelgesini kurmak i¢in asagidaki adimlari tamamlayin.
Denetleyici anasistem adlarinin, denetleyicilere iliskin IP adresleriyle eglestiginden
emin olun.

1. Bir IP adresiyle iligskilendirmek tzere bir anasistem adi belirlemek igin anasistem
cizelgesini ya da DNS cizelgesini gtincelleyin. Bir DNS ¢izelgeniz yoksa,
/etc/hosts dosyasindaki anasistem cizelgesini diizenleyin. isletim sistemi kok
dizine kurulmadiysa, sizin dizininiz farkh olabilir.

2. Depolama altsistemlerini bir glivenlik duvari aracihigiyla yénetmek igin glivenlik
duvarini TCP verilerindeki 2463 numarali kapiyi agacak sekilde yapilandirin.

Asagidaki drnekte bir Linux anasistem dosyasi gésterilmektedir.

# Do not remove the following line, or various programs
# that require network functionality will fail.

127.0.0.1 rh71_8500 localhost.localdomain
localhost 102.54.94.97 rhino.acme.com x.acme.com
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Boliim 3. Storage Manager yaziliminin standart bir Windows
yapilandirmasina kurulmasi

Not: Kiimeleme igin sistemi yapilandiriyorsaniz, [Bélim 4, “Storage Manage
[yaziliminin bir Windows kiime sunucusu ortamina kurulmasi’] (sayfa baslikli
konuya bakin.

Bu bélimde, standart (kimelenmemis) bir yapilandirmada Windows Server 2003 igin
Storage Manager yaziliminin nasil kurulacagi anlatiimaktadir.

Yazilimi kurmadan dnce asagidaki bilgileri okuyun:

« Dogru kurulus igin [Boliim 2, “Kurulus icin hazirlk’] (sayfa baslkli konuda
anlatilan tim hazirlik gérevlerini tamamladiginizdan emin olun.

* Her zaman kurulug ortamindaki benioku (Readme) dosyasini okuyun. Benioku
dosyasinda, bu belge hazirlandiginda bulunmayan énemli bilgiler vardir.

* Depolama ydnetimi yaziliminin bu sirimi Windows XP igletim sisteminin 64 bitlik
strimlerini desteklemez. Depolama ydnetimi yaziliminin kullanildigi tim ydnetici
islevlerinin 32 bitlik bir depolama ydnetim istasyonundan gerceklestiriimesi gerekir.

* Yinelenen olay iletilerini almayi énlemek igin olay izleme hizmetini yalnizca bir
depolama ydnetim istasyonunda yapilandirin. Enterprise Management penceresi
ve SMmonitor eszamanli olarak ¢alistirilirsa, yinelenen uyarilarin alinacagini da
unutmayin.

» Kurulus islemi sirasinda yeniden baslatma islemi yapmayin. Sistem, tiim Storage
Manager yazihmi bilesenleri kurulduktan sonra yeniden baslatilir.

Yeni kurulus islemi

Storage Manager yazilimi bilesenlerini yalnizca anasistem sunucularina ya da hem
anasistem sunucularina, hem de y6énetim istasyonlarina kurabilirsiniz.

Yoénetim istasyonu: Ydnetim istasyonu, depolama altsistemini yénetmek igin
kullandiginiz bir sistemdir. Yonetim istasyonunu depolama altsistemine asagidaki
sekillerden birinde baglayabilirsiniz:

» Depolama altsistemindeki denetleyicilere kurulacak TCP/IP Ethernet baglantisiyla

* Anasistem-araci yaziliminin kurulu oldugu bir anasistem sunucusuna kurulacak
TCP/IP ag baglantisiyla (Sunucu, Fiber Kanal ya da SAS G/C yoluyla depolama
altsistemine dogrudan baglidir)

Storage Manager SMclient yazilimini bir ydnetim istasyonuna kurmaniz gerekir.

Anasistem sunucusu: Anasistem sunucusu (ya da anasistem) Fiber Kanal G/C
yoluyla depolama altsistemine dogrudan bagl bir sunucudur.

Onemli: Storage Manager yazilimini kurmadan énce anasistem veriyolu
bagdastiricisini ve aygit stiriciisiini kurdugunuzdan emin olun.

Storage Manager yazilimini her bir anasistem sunucusuna asagidaki sirayla
kurmaniz gerekir.

1. SMclient (SMclient, yalnizca bu anasistem sunucusundan DS3000 depolama
altsistemini yénetmek icin gereklidir.)

2. RDAC (Windows igin MPIO, Linux igin MPP)
3. SMagent
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4. SMutil

Kurulus islemini yénetim istasyonunda baslatmak igin|Storage Manager anasistem|
lyazilim paketlerinin kurulmasi| (sayfa baslikli konuya bakin.

Kurulus islemini anasistemde baslatmak icin IStorport minikap! anasistem veriyolu|
bagdastiricist aygit siriicisiiniin kurulmasi| (sayfa|38) baslikli konuya bakin.

Storport minikapi anasistem veriyolu bagdastiricisi aygit sirliciistiniin

kurulmasi

IBM Fiber Kanal ya da SAS anasistem veriyolu bagdastiricisi, anasistem
sunucusuyla DS3000 depolama altsistemi arasinda arabirim saglar. IBM Fiber Kanal
ve SAS anasistem veriyolu bagdastiricilari Ust ug sistemler igin tasarlanmis, yiksek
basarimli, dogrudan bellek erigimli, veriyolu denetimli anasistem bagdastiricilaridir.
Fiber Kanal anasistem veriyolu bagdastiricilari, 6zel déngi dogrudan baglantiyi ve
ybneltme yapisi dénglsi baglantisini destekleyen tim Fiber Kanal gevrebirim
aygitlarini destekler. IBM anasistem veriyolu bagdastiricisi aygit striiciisi, isletim
sisteminin anasistem veriyolu bagdastiricisiyla iletisim kurmasini saglar.

Storage Manager yazilimi, Microsoft Storport Minikapi aygit strliclisi modelini temel
alan Fiber Kanal ya da SAS anasistem veriyolu bagdastiricisi aygit stirlicisu
destegini saglar. Microsoft Windows Server 2003 yayininda, SCSlport minikapi aygit
sUrGiclisi modelinin yerine Storport minikapi aygit strlictisi modeli sunulmustur. Bu
model, AMD64 ve EM64T sunucularini destekleyen ve Windows Server 2003 x64
basimlarindaki desteklenen tek aygit striicisi modelidir.

Storport Minikapi aygit striicilerini desteklemek Gzere Windows Server 2003 isletim
sisteminde Service Pack 1 ve en son ¢ikan Storport Minikapi galigirken uygulanabilir
dizeltmeler kurulu olmalidir. En son calisirken uygulanabilir Storport dlizeltmelerini
Ihttp://www.support.microsoft.com/kb/916048/en-us/ adresinden yiikleyebilirsiniz.
Denetleyici sabit yazilimi siriimleri ya da diger Microsoft glincellemeleri gibi diger
gereksinimler ve galigirken uygulanabilir dizeltmelerin en gincel strimleri igin
Microsoft Windows igletim sistemlerine iliskin Storage Manager benioku dosyasina
bakin.

Storage Manager anasistem yazilim paketlerinin kurulmasi

Bu bélimde, Windows isletim sistemiyle ¢alisan ydnetim istasyonlarina ve anasistem
sunucularina Storage Manager anasistem yaziliminin farkl bilesenlerinin nasil
kurulacag! anlatiimaktadir.

Yazihmi kurmadan énce, yénetim istasyonunda ya da anasistem sunucusunda
kurulus yazilim paketi icin en az 200 MB’lik kullanilabilir disk alani oldugundan,
kurulus sirasinda gegici dosyalarin ve kurulustan sonra son dosyalarin
bulundugundan emin olun.

Onemli: Bagimsiz bir anasisteme SMclient yazilimini kurup depolama altsistemlerini,
ag yerine Fiber Kanal ya da SAS G/C yolu araciligiyla yénetirken, TCP/IP yazilimini
anasisteme kurmaniz ve anasistemde bir IP adresi atamaniz gerekir.

Storage Manager anasistem yaziliminin dért bileseni olan SMclient, Storage
Manager RDAC (MPIO), SMagent ve SMuitil, tek bir anasistem yazilim paketi kurulus
dosyasinda toplanmistir. Bu anasistem yazilim paketi kurulus programini kullanarak
en cok dort paket kurabilirsiniz.
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Not: Microsoft Windows XP isletim sistemi yalnizca Storage Manager Client paketini
destekler. Windows XP isletim sistemine diger Storage Manager yazilim
paketlerini kurmayin. MPIO, Windows XP (izerinde desteklenmez.

Anasistem sunucusuna ya da ydnetim istasyonuna Storage Manager anasistem
yazilim paketlerini kurmak i¢in asagidaki adimlari tamamlayin.

Onemli: Bu kurulus yénergeleri, SAN &nytikleme ya da Uzaktan énytikleme diski

iceren anasistem sunuculari igin gecerli degildir. SAN énytkleme ve Uzaktan

O6nyUkleme diski, yalnizca DS3400 depolama altsistemleri tarafindan desteklenir.
1. Bu yazilimi kurmadan énce diger tim programlari kapatin.

2. IBM System Storage DS3200 ve DS3400 Support CD’sini CD stiriclsine takin.

Not: Windows igin Storage Manager anasistem yazilim paketini, DS3000
destek Web sitesinden yUklediyseniz, dosyalari karsidan yiklenen .zip
dosyasindan belirli bir dizine gikartmaniz gerekir. Bu dizine gidin ve
Windows anasistem yazilim paketi kurulus programina erismek igin
Windows dizinini segin. El numarali adima (sayfa gecin.

3. Windows masaustiinden My Computer (Bilgisayarim) simgesini gift tiklatin. My

Computer (Bilgisayarim) penceresi agilir.

4. Support CD’sinin bulundugu CD siriiclsin( ¢ift tiklatin. CD penceresi agllir.
5. CD’de isletim sistemi mimarinize iligkin dizini segin.

Dizin isletim Sistemi

WS03_x86_32bit Windows Server 2003 x86 32 bitlik basim
(IA32) Server, Enterprise Edition ve
DataCenter

WSO03_x64_64bit Windows Server 2003 x64 64 bitlik basim
(AMD64) Server, Enterprise Edition ve
DataCenter

6. Anasistem yazilim paketi kurucusunu baslatmak icin ytrattlebilir (.exe)
dosyasini (SMIA-WSxxx.exe gibi) ¢ift tiklatin.

Yazilim yUklenirken, InstallAnywhere Kurulus sihirbazi agilir. Sihirbazin
pencerelerinde goériintilenen yénergeleri sirasiyla izleyin.

7. Select Installation Type (Kurulus Tipini Seg) penceresi agildijinda asagidaki
segeneklerden birini secin (bkz. [Sekil 11 sayfa 40):

« Typical (Full Installation) (Standart [Tam Kurulus]): Bu varsayilan
segenek, tim paketleri sisteme kurar. Hangi kurulus tipini sececeginizi
bilmiyorsaniz, bu, gtivenli bir secenektir. Bu secenek, dért anasistem yazilimi
bileseninin tim0n( kurar. Bu bilesenler sunlardir: SMclient, MP1O, SMagent
ve SMultil.

+ Management Station (Yénetim istasyonu): Bu secenek, bir depolama
altsistemini yapilandirmak, ydnetmek ve izlemek icin gereken yazilimi kurar.
Bu secgenek, is istasyonu ya da yénetim bilgisayari icindir. Bu secenek,
yalnizca SMclient programini kurar.

* Host (Anasistem): Bu secenek, depolama altsistemi sunucu yazilimini kurar.
Depolama altsistemine bagl anasistem (sunucu) i¢in bu kurulus tipini kullanin
(yalnizca Windows Server 2003). Bu segenek, SMclient programi diginda tiim
anasistem yazilim bilesenlerini kurar.

+ Custom (Ozel): Bu secenek, kurulacak dzellikleri uyarlamanizi saglar.
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Onemli: Storage Manager Agent yazilimini kurmadan ve kullanmadan énce
MPIO paketini kurmaniz gerekir.

2] IBM DS3000 Storage Manager 2 : ! IEIIﬂ

InstallAmahere by Zero G

Cancel |

Select Installation Type

Typical {(Full Installation)
Installs all of the sofhware you'll need. This iz a safe choice if yau
do not know which installation type to zelect.

?__ Management Station
@ Includes the sofhware neaeded to configure, manage, and monitor a
storage array. This optien is for your waedestation or management PC.

a Host

Installs the storage aray server software. Use this type of installation
forthe host(zerver) connected to the array.

Custom
Choose this option to customize the features to be installed. Also, if
needed, use this option to install the Java Accessibility Bridge.

Fresious |

Sekil 11. Select Installation Type (Kurulus Tipini Seg) penceresi

8.

Next (ileri) digmesini tiklatin.

Onceden kurulmus Storage Manager yazilim paketleri varsa, Overwrite Warning
(Uyariy1 Gegersiz Kil) penceresi acllir.

Overwrite Warning (Uyariy1 Gegersiz Kil) penceresi aglilirsa, OK (Tamam)
diagmesini tiklatin.

Automatically Start Monitor (izlemeyi Otomatik Olarak Baslat) penceresi agilir.
Bu, belirtilen DS3000 depolama altsistemlerini izleyip SMclient programi
calismiyorken bu altsistemlerden gelen dnemli uyarilari iletecek olan olay izleme
hizmetidir.

Automatically Start Monitor (izlemeyi Otomatik Olarak Baslat) penceresinde
sisteminize iligkin segenegi belirleyin.

Notlar:

a. Otomatik ESM sabit yazilimi eszamanlamasi iglevini etkinlestirmek igin,
Event Monitor islevini etkinlestirmelisiniz. Automatically Start Monitor
(izlemeyi Otomatik Olarak Baslat) segenegini belirleyin. Ek bilgi almak igin,
bkz. ['Otomatik ESM sabit yaziliminin eszamanlanmasi” sayfa%l

b. Event Monitor (Olay izleme) hizmetini birden ¢ok sistemde baslatirsaniz,
ayni depolama dizisinden yinelenen hata iletileri alabilirsiniz. Yinelenen hata
iletileri almak istemiyorsaniz, Event Monitor hizmetini strekli ¢alisan tek bir
sistemde baslatin.
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1.

12.

13.

14.

Next (ileri) digmesini tiklatin.
Pre-Installation Summary (Kurulus Oncesi Ozeti) penceresi agilir.
Install (Kur) digmesini tiklatin.

Yazilim kurulurken, Installing IBM DS3000 Storage Manager (IBM DS3000
Storage Manager Kuruluyor) penceresi acilir. Kurulus islemi sirasinda
Installation/Remove (Kurulus/Kaldirma) durum penceresi de acilabilir. Yazilim
kurulduktan sonra, Install Complete (Kurulugs Tamamlandi) penceresi agllir.
Onemli:

Kurulus iglemi tamamlanmadan bir kurulug islemini iptal ederseniz (ilerleme
gubugu gorindr durumdayken), kurulus programi iptal edilen kurulus islemini
dogru bicimde temizleyemeyebilir ve anasistem yazilimi kurulus sihirbazi bir
kurulus ginlGgu olusturur. Ayrica, Add/Remove Program (Program Ekle/Kaldir)
penceresinde de programin dnceden kuruldugu belirtilebilir. Ancak, programi
kaldirmak istediginizde bir kaldirma hatasi gérintilenir ve girisi Add/Remove
program (Program Ekle/Kaldir) listesinden ¢ikarmak isteyip istemediginiz
sorulur. Girigi listeden kaldirmak igin Yes (Evet) digmesini tiklatin. Daha sonra,
xml dosyasini asagidaki dizinlerden birinden silmeniz gerekir:

* Windows Server 2003 32 bitlik yayin igin:
Windows_06nylkleme_siricisi_harfi:\Program Files\Zero G Registry

* Windows Server 2003 64 bitlik yayin igin:
Windows_06nyUkleme_suricisi_harfi:\Program Files (x86)\Zero G Registry

xml dosyasini silmezseniz, DS3000 Storage Manager Kurulus sihirbazini
yeniden calistirmak istediginizde, programin varolan bir sGriminin édnceden
kurulu oldugunu belirten ve bu strim0 gincellemek isteyip istemediginiz soran
bir ileti gérantdlenir. Ancak, OK (Tamam) digmesini tiklatip kurulus islemine
devam ettiginizde, dosyalar varolmayan Documents and Settings\
kullanici_oturum_agma_kimligiLocalSettings\ Temp\BenzersizDizinAd\
Windows\NULL dizinine kurulur. Bu dizinde kullanici_oturum_agma_kimligi ve
BenzersizDizinAdi farkli kuruluslar igin farkli adlar alir.
Windows_6nyukleme_siriclsi_harfi:\Program Files\Zero G Registry dizini,
olagan Windows Explorer (Windows Gezgini) gériniiminde gizlenmis olabilir.
Boyle bir durumda Windows Explorer (Windows Gezgini) uygulamasinin
ayarlarini Show hidden files and folders (Gizli dosyalari ve klasorleri goster)
olarak belirlemeniz gerekir.

ilerleme cubugu gériinmeden 6nce kurulusu iptal ederseniz, kurulus sihirbazi
iptal edilen islemi dogru bigimde temizler. Sihirbazi yeniden galistirmadan énce
herhangi bir sey yapmaniz gerekmez.

Yes, restart my system (Evet, sistemimi yeniden baglat) seceneginin segili
oldugundan emin olun.

Done (Bitti) digmesini tiklatin.

Bazi dosyalar ve program paketleri, yordamda dnceden belirtti§iniz dizine
kurulur. Asagida varsaylan dizinler gdsterilmektedir:

* Windows Server 2003 32 bitlik yayin i¢gin:
Windows_06nyUkleme_sirlcisi_harfi:\Program Files\IBM_DS3000

* Windows Server 2003 64 bitlik yayin igin:
Windows_06nyUkleme_siricisi_harfi:\Program Files (x86)\IBM_DS3000

Kurulus tamamlanir ve Windows yeniden baslatilir.

Onemli: islem tamamlanmadan énce kurma ya da kaldirma islemini birkag kez

iptal ederseniz ve yazilim kurma islemini yeniden gergeklestirmek isterseniz,

kurulus islemi ¢alismayabilir ve kurulus islemi tamamlandiktan sonra yazilim

kurulmamis olabilir. Kurulugun tamamlandigini belirten pencerede yazilimin
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kuruldugu dizin gésterilmektedir, ancak yazilim buraya kurulmamistir. Bu sorun
ortaya glkarsa, adimda (sayfa listelenen ilgili varsayilan dizinden .xml
dosyasini silin.

Yazilim paketlerinin kuruldugundan emin olmak igin [Kurulusun dogrulanmasi| (sayfa
baslikli konuya bakin.

Kurulusun dogrulanmasi

Anasistem yazilim paketi kurucusunun basariyla ¢alistigindan emin olmak igin
asagidaki adimlari tamamlayin:

1. Start » Settings » Control Panel (Baglat — Ayarlar — Denetim Masasi)
seceneklerini tiklatin.

Control Panel (Denetim Masasi) penceresi agilir. Add/Remove programs
(Program Ekle/Kaldir) 6gesini segin. Add/Remove Programs Properties (Program
Ekle/Kaldir Ozellikleri) penceresi agilir.

2. IBM DS3000 Storage Manager Host Software girisini bulun. Giriste, ilgili stirim
numarasi (02.17.x5.00) bulunur.

3. Kurulus basariliysa (hata bildirilmediyse), [Bélim 8, “Storage Manager yaziliminin|
[kurulusunun ve yapilandirmasinin tamamlanmasi’] (sayfa|71) baslikli konuya
gidin. Tersi durumda,|Storage Manager anasistem yazilim paketlerinin kurulmasi|
(sayfa baslikli konudaki adimlari yineleyin. Hata devam ederse, teknik destek
temsilcinizle gérusun.

SMclient ya da diger anasistem yazilim paketlerinin dogru bir sekilde kuruldugundan
emin olmak i¢in asagidaki adimlari tamamlayin:

Uyari:  Asagidaki yordam Registry Editor (Kayit Dosyasi Dizenleyicisi)
uygulamasini kullanmanizi gerektirir. Registry Editor uygulamasini yanlis bir sekilde
kullanirsaniz, isletim sisteminizi yeniden kurmanizi gerektirebilecek ciddi sorunlara
neden olabilirsiniz. IBM, Registry Editor uygulamasinin yanhg kullaniimasindan
dogabilecek sorunlari ¢ézebileceginiz konusunda garanti vermez.

1. Command Prompt (Komut istemi) penceresini agin ve regedt32 komutunu girin.

2. Windows Server 2003 x86 basimi icin \HKEY_LOCAL_MACHINE\SOFTWARE\
Storage kayit anahtarina gidin. Windows Server 2003 x64 basimi igin
\HKEY_LOCAL_MACHINE\SOFTWARE\WOW®6432Node\Storage anahtarina
gidin.

3. Kurdugunuz her bir yazilim paketi icin \HKEY_LOCAL_MACHINE\SOFTWARE\
Storage ya da \HKEY_LOCAL_MACHINE\SOFTWARE\WOW®6432Node\Storage
anahtari altinda bir klasér bulunur. ilgili klasér adini tiklatin. Sag panodaki Data
(Veri) stitununda siiriim gésterilir. ileride kullanmak Gizere her bir yazilim paketi
surimind kaydedin. (")rnegjin, (sayfa icinde Storage Manager Client
yaziliminin bu sunucuda kurulu ve SMclient paketinin striminiin 92.17.G5.12
oldugu gosterilmektedir.
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Sekil 12. Registry Editor (Kayit Dosyasi Diizenleyicisi) penceresi

Windows icindeki Storage Manager yazilimi bilesenlerinin kaldiriimasiyla ilgili ek bilgi
icin bkz.|‘Depolama ydnetimi yazilim bilesenlerinin kaldirilmasi” sayfa 96|

Depolama yonetiminin yapilandiriimasi

Storage Manager yazilimini kurduktan sonra|Béliim 8, “Storage Manager yaziliminin|
kurulusunun ve yapilandirmasinin tamamlanmasr’] (sayfa baslikli bélimde
aciklanan gérevleri tamamlayin.

» Depolama altsistemlerinin baslangigta otomatik olarak algilanmasi
* Aygitlarin eklenmesi

» Depolama altsistemlerinin adlandiriimasi

* Dizilerin ve mantiksal sUrtculerin olusturulmasi

» Denetleyici sabit yaziliminin ve NVSRAM'’in ylklenmesi

* Varsaylilan anasistem tipinin dogrulanmasi ve tanimlanmasi

= Uyar bildirimlerinin ayarlanmasi
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Bolum 4. Storage Manager yaziliminin bir Windows kiime
sunucusu ortamina kurulmasi

Bu bélimde, Storage Manager yaziliminin bir Windows kiime sunucusu ortamina
nasil kurulaca@i anlatiimaktadir. Yazilimi kurmadan énce [Béltim 2, “Kurulus icin|
(sayfa[27) baglikli konuda anlatilan tiim hazirlik gérevlerini tamamlayin.

Onemli: Yazilimi kurmadan énce her zaman isletim sisteminize iliskin Storage
Manager yazilimi benioku dosyasina bakin. Benioku dosyasinda, bu belge
hazirlandiginda bulunmayan énemli bilgiler vardir.

Kurulus 6ncesiyle ilgili 6nemli noktalar

Donanim kurma islemi, anasistem veriyolu bagdastiricilarinin ve depolama
altsistemlerinin kurulmasini igerir. DS3000 Storage Manager yazilimini kurmadan
6nce, tim donanim bilesenlerinin kiime sunucusu yapilandirmasina dogru bigcimde
takildigindan emin olun.

Yapilandirma secenekleri
Depolama altsistemini kiime diigimlerine dogrudan ya da Fiber Kanal anahtarlariyla

baglayabilirsiniz (yalnizca Fiber Kanal anasistem veriyolu bagdastiricilari igin).
ekil 13icinde (sayfa@) standart dogrudan baglanti ya da Fiber Kanal anahtari
baglanti yapilandirmalari gésterilmektedir. Her iki yapilandirma da tam yedeklik

saglar.
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Ara baglanti

Dagum A Dagim B
Anasistem Anasistem
bagdastiricilari bagdastiricilari

Fiber Kanal ya da
SAS baglantisi
(dogrudan)

Hia

Denetley|C| Denetley|0| Depolama altsistemi

Ara baglanti
Dagim A Dugum B
Anasistem Anasistem
bagdastiricilan bagdastiricilari

By Sy

Fiber Kanal
baglantisi
(Fiber Kanal

Anahtar An%”hatgﬁa”)

Hn

Denetley|C| Denetley|C|

Depolama altsistemi

Sekil 13. Depolama altsisteminin Fiber Kanal ya da SAS agina takilmasi

Anasistem veriyolu bagdastiricilar

Belirli anasistem veriyolu bagdastiricisi kurulus gereksinimleri ve yordamlari igin
anasistem veriyolu bagdastiricisiyla birlikte génderilen belgelere bakin. Asagidaki
konular g6z éntinde bulundurulmalidir:

« Ikili yol yapilandirmasi kullanmak igin asagidaki gérevleri gergeklestirin:
— Her bir digume iki anasistem bagdastiricisi takin.

— (Yalnizca Fiber Kanal anasistem veriyolu bagdastiricilari) Her bir digimdan iki
fiber optik kablosunu depolama altsistemine baglayin.
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» Depolama altsistemini bir Fiber Kanal Cekismeli DéngUst (FC-AL) aracihgiyla

baglarsaniz, déngtdeki her bir bagdastiriciya benzersiz bir sabit taniticinin
atandigindan emin olun. Sabit taniticilarin degistiriimesiyle ilgili ydnergeler igin
anasistem veriyolu bagdastiricisiyla génderilen belgelere bakin.

Anasistem bagdastiricisi igin dodru aygit stricisini kurdugunuzdan emin olun.
Desteklenen anasistem bagddastiricilar ve aygit stricdleriyle ilgili bilgiler igin IBM
System Storage DS3200 and DS3400 Support CD’sinde \HostAdapter dizininde
bulunan benioku dosyasina bakin.

Depolama altsistemleri

Belirli donanim kurulus gereksinimleri ve yordamlari i¢in donanimla birlikte gdnderilen
belgelere bakin. Depolama altsistemlerini dogrudan ydnetiyorsaniz, Ethernet
kablolarini her depolama altsistemindeki denetleyicilerin her ikisine de takmaniz
gerekir.

Storage Manager yaziliminin Windows Server 2003 icin bir kiime
ortamina kurulmasi

Storage Manager yazilimini ve kiime hizmeti yazihmini Windows Server 2003 igletim
sistemine kurmak i¢in asagidaki adimlari tamamlayin:

1.

Kime digimlerinin her birine anasistem veriyolu bagdastiricisi ve aygit
strictsunin kuruldugundan emin olun. Anasistem veriyolu bagdastiricisi ve
aygit siirtictisti kurulusuyla ilgili bilgi icin[Storport minikapi anasistem veriyolul|
lbagdastiricisi aygit stirlicisiiniin kurulmasi| (sayfa |48) baslikli konuya bakin.
Storage Manager yazilimini, kiimenin birinci digimui olacak anasistem
sunucusuna kurun. Kurulus ydnergeleri iin bkz.[‘Storage Manager anasistem|
[yaziim paketlerinin kurulmasi” sayfa 38}

Not: Storage Manager yazilimini var olan bir depolama altsistemine kurmadan
dnce, donaniminiza 6zel yapilandirma yoénergeleri icin donaniminizin
belgelerine bakin. Kime yapilandirmasindaki Storage Manager yazilimini
desteklemek tzere donanim igin 6zel bir yapilandirma gerekebilir.

Kume diski olarak kullanilacak LUN’lar olusturmak ve bu LUN’larin eslendigi
anasistem grubunun ya da anasistem kapilarinin anasistem tipinin Windows
2000/Server 2003 Clustered olarak ayarlandigindan emin olmak icin [B&ltim 8)
“Storage Manager yaziliminin kurulusunun ve yapilandirmasinin|
tamamlanmas!”|(sayfa|71)) baslikli konudaki yordamlari tamamlayin.

Kumenin ilk digiminde hot_add yardimci programini ¢alistirin. Yénergeler igin
bkz. ['hot_add yardimci programinin kullaniimasi” sayfa 94|

Not: Yeni eklenen mantiksal strtcileri (LUN’lar) gérmek igin kimenin ilk
digimind yeniden baglatmaniz gerekebilir.

Paylasilan tim mantiksal surtictleri NTFS (New Technology File System) olarak
bigimlendirin, bunlara birim etiketleri atayin ve her bir stirGic igin bir harf
belirleyin.

Onemli: Birinci kiime digimiindeki LUN’lara atanan kalici (sabit) sirlicl
harflerinin, diger kime dtgimlerinde de kullanilabilir oldugunu (bagka
sUrtculer tarafindan kullaniimadigini) dogrulamaniz gerekir. Kiimedeki
tim dugumler paylasilan her bir sirlict igin ayni sirict harflerini
kullanmalidir. Kalici sirict harfleri atamazsaniz, Windows her
digumde farkh slriict harfleri atayabilir, ancak bu durumda kiime
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diskleri dogru bigimde calismaz. Windows igletim sisteminin tim kiime
digumlerinde bélime ayni sirlci harfini atamasi icin kalici bir stiriict
harfi atayin.

6. Storage Manager yazilimini kiimenin ikinci digimune kurun.

Not: MPIO ve SMutil yazilim paketlerini kurmalisiniz. Depolama altsistemini bu
kiime digumuinden yénetmeyi diisiinmiyorsaniz, tim Storage Manager
yazilim paketlerini kurmaniz gerekmez.

Onemli: Microsoft kiime ¢éziimiiniin kurulusu sirasinda, asagidaki adimlar

digim 2°de gerceklestirmeniz gerekir:

a. Cluster Administrator programini baslatin.

b. Cluster Administrator programindan Join an existing cluster
(Varolan bir kimeye katil) segenegini belirleyin.

c. D0Ogum 1 Gzerindeki kimenin olusturulmasinda kullanilan kiimenin
adini girin.

d. Klmeyle bir baglanti kurduktan sonra Select Computer (Bilgisayar
Sec) sayfasinda Advanced (Gelismig) 6gesini tiklatin.

e. Advanced (minimum) configuration (Geligsmis (alt sinir)
yapilandirma) secenegini tiklatin.
7. Kumenin ikinci digiminde hot_add yardimci programini ¢aligtirin,
8. Kimedeki diger dugumler igin (sayfa veﬂ (sayfa numaral adimlar
yineleyin.
9. Kiime sunucusu yazilimini kurun. Yonergeler icin bkz.[*Windows Server 2003]
[izerinde kiime sunucusu yaziliminin kurulmasi” sayfa 49,

10. Kdme disk gruplarini, birinci kime dagimunden kiimedeki diger dagumlerin her
birine el ile tasiyin ve bunlarin ¢evrimici duruma getirilebildiklerinden emin olun.
Herhangi bir sorun olmadan ¢evrimici duruma getirilebiliyorlarsa, uygulama
yazilimi kurulugsuna devam edebilirsiniz. Herhangi bir sorunla karsilasirsaniz,
teknik destek temsilcinizi arayin.

Storport minikapi anasistem veriyolu bagdastiricisi aygit strlcusinin

kurulmasi

IBM Fiber Kanal ya da SAS anasistem veriyolu bagdastiricisi, anasistem
sunucusuyla DS3000 depolama altsistemi arasinda arabirim saglar. IBM Fiber Kanal
ve SAS anasistem veriyolu bagdastiricilari Gst ug sistemler icin tasarlanmis, ylksek
basarimli, dogrudan bellek erigimli, veriyolu denetimli anasistem bagdastiricilaridir.
Fiber Kanal anasistem veriyolu bagdastiricilari, 6zel-déngt dogrudan baglantisini ve
yoneltme yapisi déngisi baglantisini destekleyen tiim Fiber Kanal gevrebirim
aygitlarini destekler. IBM anasistem veriyolu bagdastiricisi aygit striictsi isletim
sisteminin anasistem veriyolu bagdastiricisiyla iletisim kurmasini saglar.

Storage Manager yazilimi, Microsoft Storport Minikapi aygit sirtictisti modelini temel
alan Fiber Kanal ya da SAS anasistem veriyolu bagdastiricisi aygit stirlicisi
destegini saglar. SCSlport minikapi aygit striiclisti modelinin yerine Microsoft
Windows Server 2003 yayininda Storport minikapi aygit stricisi modeli
sunulmustur. Bu, AMD64 ve EM64T sunucularini destekleyen Windows Server 2003
x64 basimlari igin desteklenen tek aygit stiriciisi modelidir.

Storport Minikapi aygit stirictlerini desteklemek izere Windows Server 2003 igletim
sisteminde Service Pack 1 ve en son gikan Storport Minikapi galisirken uygulanabilir
dizeltmeler kurulu olmalidir. En son ¢ikan Storport ¢aligirken uygulanabilir
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diizeltmeleri|http://www.support.microsoft.com/kb/916048/en-us/| Web sitesinden
yUkleyebilirsiniz. Denetleyici sabit yazilim strimleri ya da diger Microsoft
glncellemeleri gibi ek gereksinimler ve ¢calisirken uygulanabilir diizeltmelerin en
glincel srimleri igin Microsoft Windows isletim sistemlerine iliskin Storage Manager
benioku dosyasina bakin.

Windows Server 2003 lGizerinde kilme sunucusu yaziliminin kurulmasi

Onemli: Asagidaki yordamda bulunan adimlari gergeklestirmeden énce gerekli tim
Storage Manager yazilim bilesenlerinin tim kime digimlerine kuruldugundan emin
olun.

Kime sunucusu yazilimini kiime digimlerine kurmak igin asagidaki adimlari
tamamlayin:

1. Kime sunucusu yazilimini kiimenin birinci digimune kurun. Kiime sunucusu
yazilimini kurmak i¢in dogru yordamin bulundugu ilgili Microsoft Cluster Server
(MSCS) belgelerine bakin.

Not: Kurulus islemi sirasinda yeni bir kiime olusturmak istediginizi belirtin.

2. Cluster Administrator penceresinde tim kiime disk gruplarinin sorunsuz bir
sekilde cevrimici ve cevrimdisi duruma gectiklerinden emin olun.

3. Kime sunucusu yazilimini kimenin ikinci digimuine kurun. Kime sunucusuna
ek digim kurmak igin dogru yordamin bulundugdu ilgili MSCS belgelerine bakin.

Not: Kurulus islemi sirasinda var olan bir kiimeye katilmak istediginizi belirtin. Bir
defada bir kiime digimu ya da kalan t0m kiime daguimlerini ayni anda
ekleyebilirsiniz. Kiime diugumlerini, her defasinda bir tane olacak bigcimde
ekleyin.

4. Cluster Administrator penceresinin sol tarafinda hi¢ digim adi gérantilenmezse,
kiime sunucusu yazilimini yeniden kurun. Sorun devam ederse, teknik destek
temsilcinizle gérusun.

Depolama yonetiminin yapilandiriimasi

Storage Manager yazilimini kurduktan sonra|Bélim 8, “Storage Manager yaziliminin|
kurulusunun ve yapilandirmasinin tamamlanmasi’{ (sayfa|71) baslikli bélimde
aciklanan gérevleri tamamlayin.

» Depolama altsistemlerinin baglangigta otomatik olarak algilanmasi
* Aygitlarin eklenmesi

» Depolama altsistemlerinin adlandiriimasi

» Dizilerin ve mantiksal sUrtctlerin olusturulmasi

» Denetleyici sabit yaziliminin ve NVSRAM'’in yUklenmesi

* Varsayilan anasistem tipinin dogrulanmasi ve tanimlanmasi

» Uyar bildirimlerinin ayarlanmasi
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Bolim 5. Storage Manager yaziliminin bir Linux
yapilandirmasina kurulmasi

Bu bélimde, Linux igletim sistemi ortamina Storage Manager yaziliminin nasil
kurulacag! anlatilmaktadir.

Not: Bu belge, Linux on POWER tabanl anasistemlerin kullanimina iligkin bilgi
saglamaz.

Kurulusa genel bakis

Storage Manager yazilimini kurmadan énce asagidaki bilgileri okuyun:

* Yazilmi kurmadan énce isletim sisteminize iliskin Storage Manager yazilimi
benioku dosyasini okuyun. Benioku dosyasinda, bu belge hazirlandiginda
bulunmayan énemli bilgiler vardir.

. |B('5I[]m 2, “Kurulus igin ha2|rI|k’1 (sayfa baslkli konuda anlatilan tim hazirhk
gorevlerini tamamlandiginizdan emin olun.

» Ag bilesenlerini ayarladiginizdan ve ag bilesenlerinin dogru calistigindan emin
olun.

* Yazilimin calismasi icin gerekli anasistem ve denetleyici bilgilerine sahip
oldugunuzdan emin olun.

Yazilimi her bir anasistem sunucusuna asagidaki sirayla kurun:

1. Linux igletim sistemleri igin IBM anasistem veriyolu bagdastiricisi aygit
sUrdictsini kurun.

2. Linux RDAC yazilimini kurun.
3. Storage Manager 2 Agent yazilimini kurun.

4. Dogru anasistem tipini belirleyin. Bkz. [‘Anasistem erisiminin yapilandiriimasr’|

Not: Storage Manager 2 igin anasistem yazilimi paketleri icin varsayilan kurulus
dizini /opt/IBM_DS3000’dir.

IBM anasistem
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veriyolu bagdastiricisi aygit stiriictisiniin kurulmasi

IBM anasistem veriyolu bagdastiricisi, anasistem sunucusuyla DS3000 depolama
altsistemi arasinda arabirim saglar. IBM DS3000 anasistem veriyolu bagdastiricilar
Ust ug sistemler igin tasarlanmig, ylksek basarimli, dogrudan bellek erisimli, veriyo
denetimli anasistem bagdastiricilaridir. Fiber Kanal anasistem veriyolu
bagdastiricilari, 6zel-ddngl dogrudan baglantisini ve yéneltme yapisi dénglsi
baglantisini destekleyen tim Fiber Kanal ¢evrebirim aygitlarini destekler. IBM
anasistem veriyolu bagdastiricisi aygit strticisa, igletim sisteminin anasistem
veriyolu bagdastiricisiyla iletisim kurmasini saglar.

[
lu

Storage Manager yazilimini kurmadan dnce anasistem veriyolu bagdastiricisi aygit

strliciisting kurun. isletim sisteminize iliskin kurulus yénergeleri icin aygit siiriiciisii
paketinde bulunan benioku dosyasina bakin. Ek bilgi i¢in anasistem veriyolu
bagdastiricisiyla birlikte génderilen Installation and User’s Guide (Kurulus ve
Kullanici Belgesi) adli belgeye bakin.
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Gegerli benioku dosyasini ve en giincel IBM anasistem veriyolu bagdastiricisi aygit
surdcilerini[http://www.ibm.com/servers/storage/support/disk/| Web sitesinden
yUkleyebilirsiniz.

Kurulus sihirbazi kullanilarak Storage Manager 2 yaziliminin kurulmasi

DS3000 Storage Manager kurulus sihirbazi, anasisteme otomatik olarak kurulmasini
istediginiz yazim paketlerini segebileceginiz Java tabanl etkilesimli bir ydntemdir.
Kurulus sihirbazi, asagidaki yazihm paketlerini Linux anasistemine kurar:

* SMclient
* SMagent
e SMutil

Not: Storage Manager yazilimini kurmadan énce Linux anasistemine bir grafik

bagdastiricisinin kuruldugundan emin olun.

Kurulus sihirbazini kullanarak Storage Manager yazilimini kurmak igin asagidaki
adimlari tamamlayin:

1.
2.

Yazihmi kurmak igin gerekli olan kdk ayricaliklarinizin bulundugundan emin olun.
CD suriictsine IBM System Storage DS3200 and DS3400 Support CD’sini
yerlestirin ve gerekiyorsa, CD slrtctsinG ylkleyin.

SMIA-LINUXxxx anasistem yazilimi kurulus paketini CD’den sisteminizdeki bir
dizine kopyalayin.

Not: Storage Manager anasistem yazilimi paketlerinin en son strimin(
Ihttp://www.ibm.com/servers/storage/support/l Web sitesinden
yukleyebilirsiniz.

SMIA-LINUXxxx paketini kopyaladiginiz dizini degistirin ve Storage Manager

kurulus sihirbazini baglatmak igin asagidaki komutu yazin:

. /SMIA-LINUXXxXxx=02.17 .xX.Xxx.bin

Not: SMIA-LINUXxxx dosyasinin adini tam olarak yazin. Kullanilan dosya adi
ornektir.
Storage Manager kurulus sihirbazi Introduction (Girig) penceresi agilir.

Sihirbazin pencerelerinde gérlntilenen yénergeleri sirasiyla izleyin. Kurulus tipini
segerken agagidaki iki segenekten birini belirleyebilirsiniz (bkz. [Sekil 14 sayfa 53):

* Typical (Full) Installation (Olagan (Tam) Kurulus): Tim Storage Manager
yazilim paketlerini kurar

+ Management Station (Yénetim istasyonu): SMruntime ve SMclient
yazilimlarini kurar

* Host (Anasistem): SMruntime, SMagent ve SMutil yazilmlarini kurar
+ Custom (Ozel): Kurmak istediginiz paketleri secebilmenizi saglar

B2  windows, Linux, NetWare ve ESX Server icin DS3000 Storage Manager Kurulus ve Destek Kilavuzu


http://www.ibm.com/servers/storage/support/disk/
http://www.ibm.com/servers/storage/support/

Installéamawhere by Zera G

Cancel

select Installation Type

Typical (Full Installation)
Installs all of the software vou'll need. This is a safe choice if you
do not know which installation type to select.

Management Station

Includes the software needed to configure, manage, and monitor
a starage array. This optian is for your warkstation ar
management P,

5 Host
o ' Installs the storage array server software. Use this type of
iz installation far the host (server) connected to the array.

Custem
Choose this option to customize the features to be installed.

Previous Next

Sekil 14. Select Installation Type (Kurulus Tipini Seg) penceresi

Not: Storage Manager yazilim paketleri, varsayilan deger olarak /opt/IBM_DS3000
dizinine kurulur.

Linux RDAC paketi

RDAC paketinin kurulmasi yalnizca sistem bir anasistemse zorunludur. RDAC her bir
anasistem sunucusuna kurulmalidir. RDAC paketi, hata durumunda yedek
denetleyiciye gecis destegi icin gerekli olan ¢oklu yol aygit stirlictistini kurar. RDAC
aygit srlclsl paketini kurdugunuzda sistemi yeniden baglatmaniz gerekir.

Notlar:

1. RDAC yazilimini kurmadan énce anasistem veriyolu bagdastiricisi aygit
suUrlctstnl kurmaniz gerekir. Desteklenen anasistem veriyolu bagdastiricisi
aygit sirliclst duzeyleriyle ilgili bilgi icin Storage Manager 2 benioku dosyasina
bakin.

2. Linux RDAC, Storage Manager 2 anasistem yazilim paketinden ayri olarak
saglanir. Her bir ¢ekirdek tipine bir tane olacak bigcimde iki Linux RDAC paketi
vardir:

« 2.4 gekirdedi (RHEL 3)
- 2.6 gekirdedi (RHEL 4, SLES 9 ve SLES 10)

Sisteminize dogru Linux RDAC yazilimini kurdugunuzdan emin olun.

Onemli: Linux on POWER tabanli sunucularda Linux RDAC paketlerinin higbiri
kullanilamaz.
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3. Linux RDAC kurulusuyla ilgili en son yénergeleri, bagimliliklari ya da
sinirlamalariyla birlikte 6grenmek icin her zaman Linux RDAC paketi ile birlikte
gdnderilen benioku dosyasina bakin.

4. Bu Linux RDAC strimi, AVT/ADT (auto-volume transfer/auto-disk transfer;
otomatik birim aktarimi/otomatik disk aktarimi) kipini desteklemez. Linux RDAC
yaziliminin dogru bigimde calisabilmesi igin varsayilan deger olarak AVT/ADT
devre digi birakilmistir.

Linux RDAC kaynak dosyalarini RDAC kaynak .tgz dosyasini yerlestirdiginiz dizinde
paketinden ¢ikarmak igin komut istemine asagidaki komutu yazin ve Enter tusuna
basin:

tar -zxvf dosya adi.tar.gz

burada dosya adl, Linux RDAC kaynak dosyasinin adidir.

Kaynak dosyalar dizininiz/linuxrdac dizinine ya da dizininiz/linuxrdac-sdriim dizinine
(burada sdiriim, RDAC numarasini belirtir; 6rnegin, linuxrdac-09.01.B5.39 gibi)

cikarihr.

Aygit stricist modullerinin derlenmesine ve kurulmasina iliskin yordamlar igin bkz.
[‘Linux RDAC yaziliminin kurulmasi’}

Linux RDAC yaziliminin kurulmasi

Sinirlamalar

Linux RDAC, Linux anasistem sunucusuyla eslesen DS3000 depolama
altsistemindeki mantiksal sdrlculere iligkin ¢oklu yol hata durumunda yedek sisteme
gecis/onarim sonrasi geri dénls destegi saglar. Linux anasistem sunucusunda,
DS3000 depolama altsisteminin A ve B denetleyicilerinin (ikili denetleyici
yapilandirmaniz varsa) anasistem kaplilariyla Fiber Kanal ya da SAS (anasistem
veriyolu bagdastiricisi tipine baglidir) baglantisi olmalidir.

En son ilgili bagimliliklari 6grenmek igin Storage Manager benioku dosyasina bakin.
Benioku dosyasini Support CD’sinde ve |http://www.ibm.com/servers/storage/support/|
Web sitesinde bulabilirsiniz.

Desteklenen en son DS3000 depolama altsistemi modelleri, anasistem veriyolu
bagdastiricilari, aygit sGrtictleri, Linux ¢ekirdedi siriimleri ve glincellenmis benioku
dosyasi igin http://www.ibm.com/servers/storage/support/disk/| Web sitesine bakin.

Not: Listelenen kod diizeylerinin disindakiler desteklenmez. EK bilgi igin teknik
destek temsilcinizle gértsun.

* Linux SCSI katmani, atlanan (daginik) LUN’leri desteklemez. Eslenen LUN’lar
surekli degilse, Linux cekirdegi kalan LUN’lari taramaz. Atlanan LUN’un ardindan
gelen LUN’lar anasistem sunucusu tarafindan da kullanilamaz. LUN’lari her zaman
ardisik LUN numaralari kullanarak eslestirin.

» Fiber Kanal anasistem veriyolu bagdastiricilari olan bir anasistem sunucusunun
birden ¢ok anasistem veriyolu bagdastiricisi kapisi varsa ve her bir kapi her iki
denetleyiciyi de goriyorsa (bdlge olusturulmamis bir anahtar Gzerinden),
denetleyicinin hata durumunda yedek sisteme gecis islemi sirasinda Linux RDAC
strlictst G/G hatalari verebilir. Béyle bir durumda, her bir anasistem veriyolu
bagdastiricisi kapisinin DS3000 depolama altsistemi icinde yalnizca bir denetleyici
gbrmesi icin Fiber Kanal anahtarinda birden ¢ok bdlge olusturmak Gizere birden
¢ok, bagl olmayan Fiber Kanal anahtari kullanin.
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Onkosullar

Bagli depolama altsistemi yoksa, sanal anasistem veriyolu bagdastiricisi aygit
slrlclstnG ylkleyemezsiniz. Bu olanaksizlikla ilgili olarak anasistem sunucusunu
DS3000 depolama altsistemine baglayip hot_add yardimci programini
calistirabilirsiniz.

Not: DS3000 depolama altsistemi Uizerindeki anasistem sunucusu bélimiinde
hicbir LUN eslenmemisse, hot_add yardimci programi mpp_Vhba moddlini
getirmez.

Linux RDAC siiriicusl, LUN’un silinmesini desteklemez. Eslenen mantiksal
surdctleri sildikten sonra sunucuyu yeniden baslatmaniz gerekir.

mpp_Upper ve mpp_Vhba araclarini iceren RDAC sirlcl yiginini ve diisik
dizeyli anasistem veriyolu baddastiricisi aygit strlicisind modprobe ¢ekirdek
modull yardimci programini kullanarak yiklemeyin ya da kaldirmayin. RDAC
stricl yigininda modprobe yardimci programinin kullaniimasi kullanicinin
sorumlulugundadir. IBM, RDAC sUricl yigininda modprobe yardimci programinin
kullanimini desteklemez. RDAC siiriict yiginindaki tim saricileri kaldirmak igin
rmmod yardimci programinin kullaniimasi da desteklenmemektedir. Striict
yiginini kaldirmaniz gerektiginde sistemi yeniden baslatin.

Linux RDAC sirliciisli, gunzip sikistirilmis tar dosyasi biciminde bir kaynak kodu
paketi olarak yayinlanmistir. Sirlici kaynak paketini agmak igin Linux konsol
penceresinde su komutu girin: tar -zxvf rdac-LINUX-xx.xx.xx.xx-source.tar.gz;
burada xx.xx.xx.xx, RDAC slrlcUsinln yayin dlzeyini belirtir. Kaynak dosyalar,
linuxrdac dizinine ya da linuxrdac-sdridm dizinine ¢ikarilir (burada sdriim, RDAC
numarasini belirtir; drnegin, linuxrdac-09.01.B5.39 gibi).

Linux RDAC sirtictsind kurmadan énce anasistemde veriyolu bagdastiricisi aygit
surdctsuni olusturun ve kurun. Aygit srdcistiniin kurulmasiyla ilgili ydbnergeler
icin anasistem veriyolu bagdastiricisi aygit strlicist benioku dosyasina ya da
anasistem veriyolu bagdastiricisi Installation and User's Guide (Kurulus ve
Kullanici Kilavuzu) adli yayina bakin. Anasistem veriyolu bagdastiricisi aygit
suriictsini kaynak agagtan olusturmaniz gerekiyorsa, aygit sirticisi kaynak
agaci, kaynak kodu paketinde bulunur. Bu aygit stiriiciistiniin RDAC kurulusundan
Once ylUklenmesi gerekir.

Anasistem sunucusunda birden ¢ok saticinin farkli anasistem veriyolu
bagdastiricilari ya da ayni saticinin farkli anasistem veriyolu bagdastiricisi
modelleri olabilir, ancak DS3000 depolama altsistemlerine yalnizca bir anasistem
veriyolu bagdastiricisi modeli baglanabilir.

Linux ¢ekirdek stirim0nin olusturulacagi ¢ekirdek kaynak agacinit RDAC suriicisi
paketini kurmadan énce kurdugunuzdan emin olun.

Yalnizca SUSE Linux dagitimi icin

SUSE Linux ortami icin Linux RDAC yazilimini kurmak ve ayarlamak igin asagidaki
adimlari tamamlayin:

1.
2.

SUSE dagitimindan cekirdek kaynagini kurun.
Su komutu yazarak gekirdek kaynagiyla bir yazim baglantisi olusturun:
In -sf Jusr/src/linux-sirimi /usr/src/1inux

Cekirdek sirimanin aygit striictist ve ¢alisan gekirdek arasinda
eszamanlandiindan emin olmak igin Linux konsol penceresinde asagidaki
komutu yazin. Her bir komutu yazdiktan sonra Enter tusuna basin:

 cd /usr/src/linux
* make mrproper (¢ekirdek agacini tamamen temizler)
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* - cp /boot/config-"uname -r* .config (yeni yapilandirma dosyasini kopyalar)
* make oldconfig (.config dosyasini kullanarak yapilandirmayi gtinceller)
* make dep (bagimliliklari yeniden olusturur)

* make modules (modulleri olusturur) (yeni ¢ekirdek strimlerinde zorunlu
degildir)
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SUSE Linux ve Red Hat Linux icin RDAC sliricusuniin olusturulmasi

1.
2.

linuxrdac dizinine gidin.

Bu dizindeki eski stiriici modullerini kaldirmak igin su komutu yazin ve Enter
tusuna basin:

make clean

Birden gok islemcinin (SMP g¢ekirdegi) oldugu tiim suriici moddillerini ve yardimci
programlarini bir sunucuda derlemek igin asagidaki komutu yazin ve Enter
tusuna basin:

make

RDAC siiriiclisi kurulusu

1.

Gekirdek modiili agacina sirtici modullerini kopyalamak ve 6nyiikleme
sirasinda gereken RDAC sUrici modullerini ve tim sirict modullerini iceren
yeni RAMdisk resmini (mpp.img) olusturmak i¢in make install komutunu yazin ve
Enter tusuna basin.

ilk RAMdisk resmi olarak kernel version.img dosyasini kullanan yeni bir
OnylUkleme menisu segenegdi eklemek icin olusturma isleminin sonunda
gorlntlilenen ybénergeleri izleyin. as the initial RAMdisk image.

Linux RDAC kurulusunun sonuna dogru, All of your loopback devices are in use
(TUm geriddéngl aygitlariniz kullanimda) hata iletisini gériirseniz, RDAC RAMdisk
olusturulmazsa ve kurulug sirasinda hata olusursa, Linux konsol penceresinde
asagidaki komutlari yazin:

insmod loop (Bu komut, geridéngl aygit strtictisini ¢ekirdege yikler.)

make uninstall (Bu komut, dnceki basarisiz RDAC siricisini kaldirir.)

make install (Bu komut, RDAC sUriclsin( yeniden kurar.)

Onemli: Sunucu Red Hat Enterprise Linux 3.0 isletim sistemini calistiriyorsa,

asagidaki alandaki /sbin/mkinitrd komut dosyasini 3000°den 15000’
degistirin:
if['uname -m' = "ia64"];

then IMAGESIZE=400

else IMAGESIZE=15000
fi

Asagidaki yénergeler belirli Red Hat ¢ekirdek strimlerinde caligabilir. Asagidaki
grub.conf érnegine benzer bir bigcimde yeni énylkleme sec¢eneginde ¢ekirdek
Onylkleme parametresi olarak ramdisk_size=15000 degerini ekleyin.

Not: Gercek metin sistem kurulus yapilandirmasina bagl olarak farkli olabilir.

title Red Hat Linux Advanced Server-up (2.4.9-e.27smp)

root (hd0,6)

kernel /vmlinuz-2.4.9-e.27smp ro root=/dev/hda7 ramdisk_size=15000
initrd /mpp-<kernel version>.img

RDAC siuruclsu kurulus sonrasi islemler

1.
2.

Yeni Onyiikleme Meniisii secenegini kullanarak sistemi yeniden baslatin.

Sarlcl yigininin dogru bigimde ylklendiginden emin olmak igin Ismod komutunu
yazin.

Not: Red Hat dagitimlarinda asagidaki modullerin yiklenmesi gerekir: scsi_mod,
sd_mod, sg, mpp_Upper, mpp_Vhba(*) ve anasistem veriyolu bagdastiricisi
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aygit strGclleri. SUSE Linux dagitimlarinda asagidaki modullerin
ylklenmesi gerekir: sg, mpp_Upper, mpp_Vhba(*) ve anasistem veriyolu
bagdastiricisi aygit srtcaleri.

3. RDAC suructsunin kullanilabilir fiziksel LUN’lari buldugundan ve bunlar igin
sanal LUN’lar olusturdugundan emin olmak igin Is -IR /proc/mpp komutunu yazin
ve Enter tusuna basin.

Artik LUN’lara G/C’leri gdnderebilirsiniz.

4. MPP yapilandirma dosyasinda (/etc/mpp.conf) ya da /var/mpp/devicemapping
sabit baglama dosyasinda degisiklik yaparsaniz, RAMdisk resmini yeniden
olusturmak ve yeni dosyayi icerecek bigimde degistirmek icin mppUpdate
komutunu kullanin. Béylece, yeni yapilandirma dosyasi (ya da surekli baglama
dosyasi) sistemin bir sonraki baslatilisinda kullanilabilir.

MPP slrtcusine iliskin tim hata ayiklama ve hata iletilerini yakalamak igin
/etc/syslog.conf dosyasinda kern.debug, kern.notice, kern.info ve kern.warning
giriglerinin olmasi gerekir.

Proc girigleri
RDAC surtcistnin kullanilabilir fiziksel LUN’lari buldugundan ve bunlar igin sanal

LUN’lar olusturdugundan emin olmak igin Is -IR /proc/mpp komutunu yazin ve Enter
tusuna basin.

Linux igletim sistemi, aygit striicisi bilgilerini kullanici alanina aktarmak igin
cekirdegdin kullandigi 6zel bir yalnizca bellek ve yazilim tarafindan olusturulmus
dosya sistemi olan bir /proc dosya sistemi saglar.

Proc sahte dosya sistemi, /proc dizinine yiklenir. Linux SCSI altsisteminin proc dosya
sistemi dizini /proc/scsi‘dir. Her bir anasistem veriyolu bagdastiricisi aygit striicis(,
/proc/scsi altinda bir alt dizin olugturur.

Linux RDAC (MPP) siirlicisu proc girigleri asagidaki gibidir:
» /proc/mpp

MPP sirtcusune iligskin giris.
 /proc/scsi/mpp/bagdastirici_numarasi

MPP sanal anasistem bagdastiricisina iliskin giris. Bu, sistemden sisteme farklilik
gOsterebilir ve SCSI orta katmani tarafindan atanir.

» /proc/mpp/depolama_sistemi_adi
Anasistemin gorebildigi her bir altsisteme iligkin giris.
» /proc/mpp/depolama_sistemni_adi/controllerA/B

Anasistem tarafindan gérulen her bir altsistemin (zerindeki iki hedefe iligkin
girisler. Her depolama altsisteminde iki denetleyici vardir.

» /proc/mpp/depolama_sistemi_adi/controllerA/B/disik_dizeyli_stirlci/HCT#

dlistik_dizeyli_stirticl, herhangi bir QLogic, Emulex ya da LSI Logic anasistem
veriyolu bagdastiricisi olabilir. HCT#, Host# (SCSI orta katmani tarafindan atanan
dUsUk diizeyli stiriiciiniin anasistem numarasi), Channel# (anasistem veriyolu
bagdastiricisi kartinin tek ya da iki kapili olmasina baghdir) ya da Target# (disik
dlzeyli anasistem veriyolu bagdastiricisi aygit strtictsu tarafindan ilgili altsistem
Uzerindeki denetleyiciye atanan hedef numarasi) olabilir.

» /proc/mpp/depolama_sistemi_adi/controllerA/B/dlisiik_dizeyli_sdriicl

Mantiksal surtculer ya da mantiksal stricilerin LUN numaralarinin depolama
altsistemindeki anasistem bdlimune eslestirildikleri ve bu yoldan ya da
baslatici(anasistem)-hedef birlesiminden géruldikleri seklidir.
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Sirekli adlandirma

Linux SCSI aygit adlari anasistem yeniden baslatildijinda degisebilir. UUID adi
verilen benzersiz bir taniticiya gore aygitlari eslestiren kullanici taniml aygit adlari
olusturmak igin devlabel gibi bir yardimci programin kullaniimasi tercih edilir.

Bu belgenin hazirlandigi zaman itibariyle devlabel yardimci programi Red Hat
Enterprise Linux 3 dagitiminin bir pargasi olarak sunulmaktadir.

RDAC siuruclsu paketinin kaldiriimasi ve yeniden kurulmasi/
guncellenmesi

RDAC suriict paketini kaldirmak icin make uninstall komutunu yazin ve Enter tusuna
basin.

Not: RDAC siriicu paketini yeniden kurmak ya da gliincellemek i¢in make uninstall
komutunun ardindan yeni RDAC surtcisi kaynak kodu demetindeki /linuxrdac
dizini altinda make uninstall komutunu girin.

Cekirdek glincellemesi
Cekirdek giincellemesini uyguladiktan ve yeni cekirdegi baslattiktan sonra, yeni
cekirdege iliskin MPP Initrd resmini olusturmak icin asagidaki adimlari tamamlayin:
1. Linuxrdac kaynak kodu dizinine gidin.
2. make uninstall komutunu girin.
3. [SUSE Linux ve Red Hat Linux icin RDAC siirliclisiiniin olusturulmasi| (sayfa

ve |RDAC siiriiclisii kurulusul (sayfa|57) baslikli konularda agiklanan siriicii
olusturma ve kurulus yordamini izleyin.

ilk RAMdisk resmi (initrd)

ilk RAMdisk Resmi (initrd resmi), strticlyd, make install komutuyla kurdugunuzda
otomatik olarak olusturulur. Onylikleme yUkleyici yapilandirma dosyasinda, yeni
olusturulan bu resme iligkin bir giris olmasi gerekir.

initrd resmi, mpp-"uname -r’.img dosya adiyla ényikleme bélimiinde bulunur
(6rnegin, mpp-2.4.21-9.ELsmp.img gibi).

SirGci gincellemesi icin, sistemde MPP’ye iligkin 6nceki giris varsa, sistem
y6neticisi, dnylikleme yUkleyicisi yapilandirma dosyasindaki MPP girigini uygun bir
sekilde degistirmelidir. Cogu durumda, ¢ekirdek siriimi ayniysa degisiklik yapmaya
bile gerek kalmaz.

Yeni bir initrd resmi olusturmak icin mppUpdate komutunu girin; bu islem énceki
resim dosyasinin Uzerine yeni resim dosyasini yazar.

initrd resmine UgUncU kisi strGclleri eklemeniz gerekiyorsa, /etc/sysconfig/kernel
dosyasini (SUSE Linux) ya da /etc/modules.conf dosyasini (Red Hat Linux) bagimsiz
yazilim satici firma tarafi sirict girigleriyle dizenleyin. Yeni bir RAMdisk resmi
olusturmak i¢in mppUpdate komutunu ¢alistirin.

Eslenen mantiksal sirlculerin (LUN’lar) eklenmesi ve silinmesi

Linux RDAC, sunucunun yeniden baglatiimasina gerek kalmadan yeni eslenen
LUN’un yeniden taranmasini destekler. Yardimci program, Linux RDAC sulrlcUslyle
ayni pakette yer alir. Programi hot_add ya da mppBusRescan komutunu girerek
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baslatabilirsiniz. hot_add komutu, mppBusRescan komutuna iligskin simgesel bir
baglantidir. Her iki komut i¢in de man sayfalari vardir.

Linux RDAC suricisl, LUN’un silinmesini desteklemez. Eslenen mantiksal
surdculeri sildikten sonra sunucuyu yeniden baslatmaniz gerekir.
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Gecici kurulus dosyalarinin kaldiriimasi
Gegici kurulus dosyalarini gecici dizinden kaldirmak icin asagidaki adimlari
tamamlayin:
1. Komut istemine asagidaki komutu yazip Enter tusuna basin.
rm /kurulus_dizini/SMx-LINUX.rpm
burada kurulus_dizini, kurulug dosyalarinin gikartilacagi dizindir.
2. Dogrulamak icin,y yazin ve Enter tusuna basin.

Storage Manager yaziliminin kaldirilmasi

Bu bélimde Storage Manager yaziliminin bir ya da birden gok Linux yénetim
istasyonundan ya da anasisteminden kaldiriimasina iliskin yordamlar
aciklanmaktadir. Yazilim kaldirma yordamlarini, rpm uyumlu, GUI tabanli bir paket
yoneticisi kullanarak da gerceklestirebilirsiniz.

['Storage Manager yaziliminin kaldirilmasr’| bdlimiinde, SMutil, SMclient, SMagent ve
SMruntime paket adlari kurulmus ya da kurulacak olan paket adlarinin énekleridir.
Kurulu olan Storage Manager yazilim paketlerinin tam adlarini belirlemek igin, komut
istemine rom —qa | grep SM yazin. Sistem, kurulu paket dosyasi adlarini gérintiler.

Storage Manager yaziliminin énceki bir sirimini kaldirmak igin asagidaki adimlari
gerceklestirin.

Not: Bir yazihm bilesenini kaldirdiktan sonra anasistem sunucusunu yeniden
baslatmaniza gerek yoktur. Yazilim kaldirma islemi sirasinda, anasistem
varolan depolama altsistemi eslemelerini ve depolama yapilandirmalarini tutar
ve yeni istemci yazihmi da bunlari tanir.

DS3000 Storage Manager kurulus sihirbazi, Storage Manager anasistem yazilimini
kurmak i¢in belirlediginiz dizinde bir Uninstall (Kurulugu Kaldirma) dizini olusturur. Bu
dizinin varsayilan dosya adi /opt/IBM_DS3000 olur. Dizinde Uninstall_IBM_DS3000
adh bir dosya bulunur. Anasistem yazilimini kaldirmak i¢in bu dizine gidin ve
asagidaki komutu yazin:

# sh ./Uninstall_IBM_DS3000

Sihirbaz acildiginda yénergeleri izleyin.

Depolama yonetiminin yapilandiriimasi

Storage Manager yazilimini kurduktan sonra[Bélim 8, “Storage Manager yaziliminin|
kurulusunun ve yapilandirmasinin tamamlanmasi’|{ (sayfa|71) baglikli bélimde
aciklanan gérevleri tamamlayin.

» Depolama altsistemlerinin algilanmasi

» Aygitlarin eklenmesi

* Depolama altsistemlerinin adlandiriimasi

 Dizilerin ve mantiksal sirdcilerin olusturulmasi

» Denetleyici sabit yaziliminin ve NVSRAM'’in yiklenmesi

* Varsayilan anasistem tipinin dogrulanmasi ve tanimlanmasi
» Uyari bildirimlerinin ayarlanmasi
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Boliim 6. Storage Manager yaziliminin standart bir NetWare
yapilandirmasina kurulmasi

Bu bélimde, Storage Manager yaziliminin Novell NetWare isletim sistemi ortaminda
nasil kurulacag! anlatiimaktadir.

Depolama altsistemi denetleyicisi sabit yazilimi, NetWare anasistemine DS3000
depolama altsistemi baglantisini destekler ancak, bu belgenin hazirlanma tarihi
itibariyle, Storage Manager yazilimi, NetWare ydnetim istasyonlarinda desteklenmez.

NetWare anasistem sunucusuna bagh DS3000 depolama altsistemini ydonetmek igin,
Storage Manager SMclient programinin Windows ya da Linux sGrim0ni yénetim
istasyonuna kurup DS3000 depolama altsistemine bant disi bir ydnetim baglantisi
olusturmalisiniz. Storage Manager Cl|ent programini Windows y®netim istasyonuna
nasil kuracaginiza ili

standart bir Windows yapilandirmasina kurulmasr
‘Storage Manager yaziliminin bir Linux yapilandirmasina kurulma3|
baslkli konulara bakin.

Bu bdlimde, anasistem veriyolu bagdastiricisi aygit siricisinin, LSIMPE.cdm
sUrlcustnin ve NetWare yerel hata durumunda yedek sisteme gecis aygit
stirlictistintin nasil kurulacagr anlatilir. Dogru kurulus igin(Bélim 2, “Kurulus icin|

(sayfa 27) iginde anlatilan tim hazirlik gdrevlerini gerceklestirin.

Onemli: Yazilimi kurmadan énce her zaman isletim sisteminize iliskin Storage
Manager yazilimi benioku dosyasina bakin. Benioku dosyasinda, bu
belgenin hairlanma tarihi itibariyle bulunmayan énemli bilgiler vardir.

IBM anasistem

veriyolu bagdastiricisi aygit strlcusiunin kurulmasi

IBM anasistem veriyolu bagdastiricisi, anasistem sunucusuyla DS3000 depolama
altsistemi arasinda arabirim saglar. IBM anasistem veriyolu bagdastiricilari, Ust uc
sistemler i¢in tasarlanmis, yiksek basarimli, dogrudan bellek erisimli, veriyolu
denetimli anasistem bagdastiricilaridir. IBM Fiber Kanal anasistem veriyolu
bagdastiricilari, 6zel déngl dogrudan baglantiy1 ve yéneltme yapisi déngisu
baglantisini destekleyen tim IBM Fiber Kanal ¢evrebirim aygitlarini destekler. IBM
SAS ve Fiber Kanal anasistem veriyolu bagdastiricisi aygit strlcdileri, isletim
sisteminin anasistem veriyolu bagdastiricisi ile iletisim kurmasini saglar.

isletim sisteminize iligkin kurulus yénergeleri icin aygit siirliciisii paketinde bulunan
benioku dosyasina bakin. Daha fazla bilgi igin, anasistem veriyolu bagdastiricisi ile
birlikte gdnderilen Kurulus ve Kullanici Kilavuzu adli belgeye bakin.

LSIMPE aygit suricuisinin ve NetWare yerel hata durumunda yedek
sisteme gecis aygit siricisinin kurulmasi

© Copyright IBM Corp. 2006

NetWare yerel hata durumunda yedek sisteme gegis aygit strtictleri, Novell NetWare
isletim sistemi ortaminda desteklenen tek hata durumunda yedek sisteme gegis aygit
sUrtculeridir. NetWare yerel hata durumunda yedek sisteme gegis aygit stricileri
(MM.NLM ve NWPA.NLM), varsayilan deger olarak NetWare 6.5 ile birlikte kurulur.

Onemli:

1. Belirli bir NetWare isletim sistemi stirimu i¢in her zaman en son destek
paketindeki Novell NetWare yerel hata durumunda yedek sisteme gecis aygit
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surdctsitnd kullanin. Ayrica, LSIMPE.CDM dosyasinin en son Novell Support
Pack icindeki en son strimini ya da IBM DS3000 destek Web sitesinde
bulunan, NetWare icin IBM anasistem veriyolu bagdastiricisi aygit srtictisindeki
surdmund kullanin.

2. Hata durumunda yedek sisteme gecis/onarim sonrasi geri dénls
yapilandirmasina iliskin en son yénergeler icin Storage Manager benioku
dosyasina bakin.

LSIMPE.CDM aygit sirlicisl, Novell NetWare ortaminda Novell yerel coklu yol aygit
sUrictstnin DS3000 depolama altsistemlerinde olusturulmus NetWare anasistemine
eslenmis olan mantiksal siriiculeri tanimasini saglamak igin kullanihr. LSIMPE.cdm
aygit srlclsl, IBM DS3000 anasistem veriyolu bagdastiricisi aygit stiriicistiniin
paketinde ve Novell igletim sistemi dagitim CD’sinde bulunan &ézel bir strtci
modaliddar.

Gecerli LSIMPE.cdm aygit slrlictsi icin IBM anasistem veriyolu bagdastiricisi aygit
siiriiclisii benioku dosyasina bakin. En son benioku dosyasini http://www.ibm.com/
lservers/storage/support/disk/ adresinden bulabilirsiniz.
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Bolim 7. DS3400 depolama altsisteminin VMware ESX Server
yapilandirmasiyla kullaniimasi

Not: Bu belgenin hazirlanma tarihi itibariyle, DS3200 depolama altsistemi, VMware
ESX Server yapilandirmalarini desteklemez.

Onemli: Bu belgenin hazirlanma tarihi itibariyle, DS3000 Storage Manager yazilimi
VMware ESX Server isletim sistemlerinde kullanilamaz. Bu nedenle,
DS3400 depolama altsistemlerini VMware ESX Server anasisteminizle
ybénetmek igin, Storage Manager Client yazilimini (SMclient) bir Windows
ya da Linux ydnetim ig istasyonuna kurmaniz gerekir. (Bu, tarayici tabanli
VMware Management Interface igin kullandiginiz is istasyonu olabilir.)

DS3000 Storage Manager 2 Client yaziimini (SMclient), Windows ya da Linux
yonetim istasyonuna nasil kuracaginiza iliskin yénergeler icin [Bolim 3, “Storag
|Manager yaziliminin standart bir Windows yapilandirmasina kurulmasi’{ (sayfal37) ya
da|Boliim 5, “Storage Manager yaziliminin bir Linux yapilandirmasina kurulmasr’
(sayfa[51) baslikli konulara bakin.

DS3400 depolama altsistemini bir VMware ESX Server anasisteminde kullanmaya
iliskin ek bilgi i¢in Storage Manager yazilimi benioku dosyasina bakin.
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Ornek yapilandirma
icinde bir VMware ESX Server yapilandirmasi érnegi gsteriimektedir.

Ethernet

Yonetim istasyonu ESX sunucu

<+——Fiber Kanal G/C yolu

Ethernet —»

‘ Denetleyici ‘

‘ Denetleyici ‘

Depolama altsistemleri

Sekil 15. VMware ESX Server yapilandirmasi érnegi

Yazilim gereksinimleri

Bu boélimde, DS3400 depolama altsistemiyle bir VMware ESX Server anasistem
isletim sistemini kullanmak icin gereken yazilimlar agiklanmaktadir.

Yonetim istasyonu
Asagidaki yazim Windows ya da Linux ydnetim istasyonu igin gereklidir:
1. SMruntime (yalnizca Linux)
2. SMclient (Windows ve Linux)

Not: VMware icin eslestirme depolama bélim0 anasistem tipi Linux’tur.

Anasistem (VMware ESX Server)
ESX Server iriinl igin asagidaki yazihm gereklidir:
1. VMware ESX Server 2.5.4 ya da 3.0.1
2. Fiber Kanal HBA’lari igin VMware saglanan aygit stricisU

3. VMware tarafindan saglanan QLogic siriici hata durumunda yedek sisteme
gecis ayari

4. VMware Tools (DS3400 mantiksal siriculerinin kullanildigi tim sanal makinelere
kurulur)

VMware ESX Server sinirlamalari igin, Storage Manager yazilimi benioku dosyasina
bakin.
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Kiimeleme:

Bir kime yapilandirmasi olusturmak istiyorsaniz, bu bélimde listelenen zorunlu
anasistem yazilimlarinin yani sira Microsoft Cluster Services yazilimini da
kullanmaniz gerekir.

VMware ESX Server ile Windows kiimelemesine iligkin bilgi igin
Ihttp://www.vmware.com/support/pubs/| adresindeki ESX Server Installation Guide
(Kurulus Kilavuzu) kilavuzuna bakin.

Diger VMware ESX Server anasistem bilgileri

VMware ESX Server anasisteminizin ayarlanmasiyla ilgili ek bilgi icin
|http://www.vmware.com/support/pubs/l adresinde bulunan belgelere ve benioku
dosyalarina bakin.

VMware ESX Server isletim sisteminin bir IBM sunucusuna kurulmasiyla ilgili ek bilgi
icin|http://www.ibm.com/systems/support/| adresine bakin.

Depolama altsistemlerinin yapilandiriimasi

Depolama altsistemlerini yapilandirmadan énce anasistem sunucusunu, SAN
ybneltme yapisini ve DS3400 denetleyicilerini yapilandirmaniz, denetleyiciler igin
baslangi¢ IP adresleri atamaniz ve SMclient programini Windows ya da Linux
ybnetim istasyonuna kurmaniz gerekir. Bu yordamlar bu belgede asagidaki
bélimlerde anlatihr:

VMware ESX Server anasisteminizin ayarlanmasi

VMware ESX Server anasisteminizin ayarlanmasiyla ilgili ek bilgi igin
[ESX Server anasistem bilgileri| (sayfa baslikli konuya bakin.

VMware ESX Server anasisteminizin ayarlanmasiyla ilgili ek bilgi igin
[ESX Server anasistem bilgileril (sayfa baslikli konuya bakin.

SAN yéneltme yapisinin ayarlanmasi

Bolge olusturmayla ilgili bilgiler de icinde olmak Gizere SAN y®neltme yapisinin
ayarlanmasiyla ilgili bilgi edinmek icin [SAN baglantili bir yapilandirmaniny
flusturulmasi (Fiber Kanal)| (sayfa[15) baslikli konuya bakin.

Baslangi¢ IP adreslerinin atanmasi

DS3400 denetleyicilerine baslangi¢ IP adreslerinin atanmasiyla ilgili ek bilgi igin
13: Anasistemlere ve denetleyicilere |P adresi atanmasi| (sayfa baslikh konuya
bakin.

SMclient’in bir Windows ya da Linux yénetim istasyonuna kurulmasi
SMclient'in bir Windows yénetim istasyonuna kurulmasiyla ilgili ek bilgi icin
‘Storage Manager yaziliminin standart bir Windows yapilandirmasina kurulmasr’
(sayfa [37) baslkli konuya bakin.

SMclient programinin bir Linux yénetim istasyonuna kurulmasiyla ilgili ek bilgi icin
B6lUm 5, “Storage Manager yaziliminin bir Linux yapilandirmasina kurulma3|’1 (sayfa
51) baslikli konuya bakin.

Depolama yénetimi kurulusunun ve yapilandirmasinin tamamlanmasi
Depolama yénetimi kurulusu ve yapilandirma gérevlerinin tamamlanmasiyla ilgili bilgi
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icin|B6Iim 8, “Storage Manager yaziliminin kurulusunun ve yapilandirmasinin

tamamlanmasr’| (sayfa|71) baslikli konuya bakin.

LUN’larin depolama bdlimiyle eslestirilmesi

Bu bélimde, VMware ESX sunucularina 6zel LUN esleme islemleriyle ilgili notlar
bulunmaktadir. LUN’lari bir béliimle eslestirmenin anlatildigr yordamlar igin |LUN’larin
bir bdliimle eslestirilmesi| (sayfa baslikli konuya bakin.

LUN’larinizi VMware Gzerinde eslestirirken asagidaki bilgilere dikkat edin:

* LUNlari her zaman LUN 0'dan baglayan ardisik sayilari kullanarak esglestirin.
Ornegin, LUN’lar1 0; 1; 2; 3; 4; 5 gibi herhangi bir sayiyi atlamadan ardisik sayilarla
eslestirin.

» Her bir bélimde bir LUN 0 eslestirmeniz gerekir.

* Yapilandirmaniz LUN paylasimini gerektirmiyorsa (tekli ya da ¢oklu bagimsiz ESX
sunuculari, yerel sanal kiime), her bir mantiksal stirictinin dogrudan bir
anasisteme ya da bir Gye olarak tek bir anasistemle bir anasistem grubuna
eslestiriimesi gerekir.

» Birden ¢ok ESX sunuculari arasindaki LUN paylagimi yalnizca, VMotion 6zelliginin
etkinlestirildigi anasistemleri ya da Microsoft Cluster diigimlerini yapilandirirken
desteklenir. Birden gok ESX Server Urinlyle eslestiriimis LUN’larda, erigim kipini
Shared (Paylasiml) olarak degistirmeniz gerekir. LUN’lari ESX sunucularina iliskin
bir anasistem grubuyla eslestirebilirsiniz; bdylece, anasistem grubunun tim Gyeleri
bu LUN’lar kullanabilir. ESX Server ile Windows Clustering hakkinda bilgi igin
[http://www.vmware.com/support/pubs/|adresindeki ESX Server Installation Guide
(Kurulus Kilavuzu) kilavuzuna bakin.

Depolama yapilandirmasinin dogrulanmasi
Depolama yapilandirmasinin dogru oldugunu onaylamak tzere DS3400 depolama
altsistemine bakmak icin asagidaki adimlari tamamlayabilirsiniz:
1. Sunucuyu acin.

2. QLogic BIOS baglatilirken Fast!UTIL kurulus programina girmek igin Ctrl+Q
tuslarina basin.

3. FastlUTIL ekraninda gérintilenen ilk anasistem veriyolu bagdastiricisini segin.

4. Host Adapter Settings (Anasistem Bagdastiricisi Ayarlari) segenegini belirleyin
ve Enter tusuna basin.

5. Scan Fibre Devices (Fiber Aygitlari Tara) secenegini belirleyin ve Enter tusuna
basin. Asagidaki gibi bir sonug gérintilenir:

Scan Fibre Channel Loop

ID Vendor Product Rev Port Name Port ID
128 No device present 0520

129 IBM 1726 0520 200400A0b00FOA16 610C00
130 No device present

131 No device present

132 No device present

133 No device present

134 No device present

135 No device present

Not: Yapilandirmanin kablo baglantisina bagl olarak birden ¢ok érnek gérebilirsiniz.
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Bir DS3400 denetleyicisi gdrmezseniz, kablo baglantisinin, LUN eslestirmesinin
yapildigini ve anahtar icin bdlge olusturuldugunu dogrulayin.
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Bolim 8. Storage Manager yaziliminin kurulusunun ve
yapilandirmasinin tamamlanmasi

Bu bdlimde, Storage Manager 2 yaziliminin Enterprise Management ve Subsystem
Management 6zelliklerinin, Windows, Linux ve NetWare igletim sistemi ortamlarindaki
kurulus gorevlerini tamamlamak tzere kullaniimasina iliskin bilgiler bulunmaktadir.

Not: Bu belgenin hazirlanis tarihi itibariyle, DS3000 Storage Manager 2 yazilimi,
NetWare isletim sistemlerinde kullaniimaz. Storage Manager 2 yazilimini
NetWare anasisteminizde yapilandirmak igin, bu bélimdeki gdrevleri bir
Windows ya da Linux yénetim istasyonundaki SMclient istemcisini kullanarak
tamamlayin.

Storage Manager 2 yazihminin kurulusunu tamamlamak igin asagidaki gérevleri
gergeklestirin. Bu gbrevlerin her biri asagidaki bélimlerde ayrintili olarak ele
alinmistir.

Depolama altsistemlerini algilama.

Gerekiyorsa aygit ekleme.

isterseniz uyari bildirimleri ayarlama.

Depolama altsistemlerini adlandirma.

Sabit yazihmi ve NVSRAMyi yiikleme.

Dizi ve mantiksal sUriiculer olusturma.

Varsayilan anasistem tipini dogrulama ve tanimlama.
Turdes olmayan anasistemleri yapilandirma.
Mantiksal surtculeri bdlimle eslestirme.

Diger depolama altsistemi gérevlerini gerceklestirme.

©COVW N RMWND -
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Storage Manager yaziliminin baslatiimasi

Storage Manager yazilimini baglatmak igin asagidaki ydontemlerden birini secin:

+ Windows icin: Start » Programs » Storage Manager 2 Client (Baslat —
Programlar — Storage Manager 2 Istemcisi) seceneklerini tiklatin.

+ Linux icin: (Varsayilan deger olarak) /opt/IBM_DS3000/client/SMclient komutunu
girin.

Storage Manager yazilimini baglattiginizda Enterprise Management (Kurumsal
Yoénetim) penceresi acilir. Enterprise Management penceresini asagidaki gérevleri
gerceklestirmek icin kullanin:

+ Depolama altsistemlerini ekleme ve algilama
* YOnetim etki alaninizdaki tim depolama altsistemlerini gérintileme

» Script Editor aracini kullanarak toplu depolama altsistemi ydnetim gdrevlerini
gerceklestirme

Task Assistant ve Initial Setup Tasks pencerelerinin kullaniimasi

Task Assistant, Enterprise Management penceresindeki genel gbrevleri
gerceklestirmeyi segebileceginiz merkezi bir konum saglar. Subsystem Management
penceresi igin Initial Setup Tasks, her bir bireysel altsistem icin gergeklestirilen genel
gorevleri saglar.
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Enterprise Management penceresinde, Task Assistant, asagidaki gérevler igin birer
kisayol saglar:

* Depolama altsistemlerini ekleme

* Depolama altsistemlerini adlandirma ya da yeniden adlandirma
» Uyari hedeflerini ayarlama

» Depolama altsistemlerini yénetme

Subsystem Management penceresinde, asagidaki gérevler igin birer kisayol saglanir:
* Depolama altsisteminin bulunmasi

* Depolama altsistemini adlandirma ya da yeniden adlandirma

» Depolama altsistemi parolasinin ayarlanmasi

* Anasistemlerin yapilandiriimasi

» Depolama altsisteminin yapilandiriimasi

Task Assistant yardimci programini agmak igin Enterprise Management penceresinde
View » Task Assistant (Gorinim — Goérev Yardimcisi) segenegini belirleyin ya da

ara¢ cubugundaki Task Assistant simgesini tiklatin. ;E‘

Task Assistant penceresi agilir. Enterprise Management Window Task Assistant
yardimci programi icin bkz. |Sekil 16 (sayfa.
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il Enterprise Management Window Task Assistant

What are the Enterprize and Subsystetn Management Windows'?

Which Task Would You Like To Perform?
The Taszk Assistant helps you complete tasks guickly and easily within the Enterprize Management
Windowy. Please choose atask:

Initial Setup:

Add Storage Subsystems
You must add a storage subsystem to the management domain befare it can be

configured ar managed.

MamefRename Storage Subsystems
Marnitig & storage subsystem and providing a comiment makes it easy to find the
array within the management domain or determine itz physical location.

Configure Aletts
Iﬁ h Configuring aletts alloves you to receive email or =MMP nhotification whenever
|1L| U | there are critical problems on & storage subsysten.

Subsystem Management:

Manace a Storage Subsystem
Launch the Subsystem Management YWindowe to perform configuration tasks Sjll
»

A b e G G _..|._.._1_1.. iy

e e s e e e o g o e B i

K

{1 Don't showe the task assistant &t start-up again
Mote: To dizplay the Tazsk Assistant again, zelect YWiew == Tazk Azsistant.

Sekil 16. Enterprise Management Window Task Assistant

Not: Task Assistant penceresi, pencerenin altindaki Don’t show the task assistant
at start-up again (Baslarken gérev yardimcisini bir daha gériintileme) onay
kutusunu isaretlemedeginiz takdirde, Enterprise Management penceresinin her
acllisinda otomatik olarak acilir.

Subsystem Management penceresinde, Initial Setup Tasks penceresini agmak igin
(bkz.|Sekil 17 sayfa 74) Summary (Ozet) sayfasinin Ust kismindaki Perform Initial
Setup Tasks baglantisini tiklatin.
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Llze these 3 steps to et up the storage subsystem:

“iewy Infarmation About These Tazks

1) Locate the Storage Subsystem

Z | Rename the Storage Subsystem

.3 Set g Storage Subsystem Password

=

I Confiure Host Access

Configure storage subsystern (2 options):

Automatic (Simple)
Manual (Advanced)
Optional:

“Yiewy and Enable Premium Festures

Change Metwark Configuration

{1 Do not shovee this again for this storage subsystem

Cloze

Sekil 17. Subsystem Management penceresindeki Initial Setup Tasks penceresi

Not: Initial Setup Tasks penceresi, pencerenin altindaki Do not show this again for
this storage subsystem (Depolama altsistemi icin bunu bir daha gérintlileme)
onay kutusunu isaretlemediginiz takdirde, Subsystem Management
penceresinin her agilisinda otomatik olarak agilir.

Depolama altsistemlerinin algilanmasi

Depolama altsistemlerini algilamay gergeklestirmek icin asagidaki adimlari
tamamlayin:

1. Storage Manager yazilimini baslatin. Ek bilgi almak igin, bkz.|“Storage Manager|
[yaziiminin baslatiimas1” sayfa 71| istemci yazilimi baslar ve Enterprise
Management penceresi agilir. Daha sonra, Enterprise Management penceresinin

Sekil 18

Ustinde (Sekil 18icinde (sayfa gOsterilen) Task Assistant penceresi ve Select
Addition Method penceresi agllir.
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Your management domain is not configured to monitar or manage any storage
subsystems, Choose a method for the addition of storage subsystems:

% 2utomatic:

Dizcovers starage subsystems automatically within the local sub-netwark.
The discovery process may take several minutes to complete.

O Marusl

option iz typically used only to add a storage subsystern that[.eoutside the

Add storage subsystems by host or controller [P address or Est name. Thiz
local sub-network.

(8], Cancel Help

Sekil 18. Select Addition Method penceresi

2. Yerel alt aja badlanan tiim anasistemleri ve depolama altsistemlerini algilamak
icin Automatic (Otomatik) secenegini belirleyin. Yerel alt aga baglanan aygitin IP
adresini belirlemek icin Manual (El ile) secenegini belirleyin.

Not: Baslangicta otomatik algilamadan sonra Enterprise Management
penceresinin yenilenmesi 1 dakika kadar surebilir.

ekil 19 (sayfa icinde baslangigta otomatik algilamadan sonra Enterprise
Management penceresi gosterilir.
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Sekil 19. Enterprise Management penceresi

3. Enterprise Manager penceresinde her bir anasistem ve depolama altsisteminin
gorintilendiginden emin olun.
Gortntilenmeyen bir anasistem veya depolama altsistemi varsa asagidaki
gbrevleri tamamlayin:

Donanimi ve donanim baglantilarini olasi sorunlar igin denetleyin (belirli
yordamlar icin donanim belgelerine bakin).

Depolama altsistemlerinin algilanmasina iliskin daha fazla bilgi igin Enterprise
Management gevrimici yardimina bakin.

Dogrudan yénetim yéntemini kullaniyorsaniz, tim anasistemlerin ve depolama
altsistemlerinin ayni alt aga bagh oldugundan emin olun. Anasistem-araci
yéntemini kullaniyorsaniz, anasistem ve depolama altsistemleri arasindaki
Fiber Kanal baglantisinin yapilmis oldugundan emin olun.

Depolama altsistemini dogrudan ydnetilen bir sistem igin kurmayla ilgili olarak
[Baltim 2, “Kurulus igin hazirlik (sayfa [27) iginde anlatilan tim hazirlik
adimlarinin tamamlandigindan emin olun. Tium adimlar tamamlanmigsa,
depolama altsisteminin IP adreslerini eklemek icin Add Device (Aygit Ekle)
secenegini kullanin. Denetleyicilerin her iki IP adresini de ekleyin. Tersi
durumda, depolama altsistemini ydnetmeye ¢alistiginizda, kismen ydnetilen
aygit hatasi iletisi géranttlenir.

Anasistem-araci yontemini kullaniyorsaniz, agsagidaki adimlari tamamlayin:
a. SMagent yardimci programinin anasistemde kurulu oldugundan emin olun.

b. Depolama altsistemleriyle SMagent’in kurulu oldugu anasistem arasinda
Fiber Kanal baglantisi oldugundan emin olun.

c. [B8lim 2, “Kurulus icin hazirlik] (sayfa [27) iginde anlatilan tim hazirlik
adimlarinin tamamlandidindan emin olun. Tamamlanmiglarsa, asagidaki
adimlar tamamlayin:

1) Hot_add yardimci programini ¢alistirin.
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2) |Anasistem-araci yaziliminin durdurulmasi ve yeniden baslatiimasi|
(sayfa baslikl konuda anlatilan bilgileri kullanarak SMagent’|
yeniden baglatin.

3) Enterprise Management penceresinde anasistemi tiklatin ve Tools »
Rescan (Araclar — Yeniden Tara) seceneklerini tiklatin.

Not: Bazi durumlarda, bir depolama altsistemi, otomatik algilamadan sonra aygit
agacinda yinelenebilir. Yinelenen depolama ydnetimi simgesini, Enterprise
Management (Kurumsal Y6netim) penceresinde Remove Device (Aygiti
Kaldir) segenegini kullanarak aygit agacindan kaldirabilirsiniz.

4. Her depolama altsisteminin durumunun Optimal (En uygun) oldugundan emin
olun. Bir aygitin durumu Unresponsive (Yanit vermiyor) olarak gértiniyorsa,
aygiti sag tiklatin ve bunu yénetim etki alanindan silmek icin Remove Device
(Aygiti Kaldir) segenegini kullanin. Daha sonra, yonetim etki alanina tekrar
eklemek igin Add Device (Aygit Ekle) secenegini kullanin. Aygit gcikarmaya ve
eklemeye iligkin ydnergeler icin Enterprise Management penceresi ¢evrimici
yardimina bakin.

Aygitlarin eklenmesi

Enterprise Management penceresinden el ile daha fazla anasistem ya da depolama
altsistemi eklemek igin Edit » Add Storage Subsystem (Diizenle — Depolama
Altsistemi Ekle) segeneklerini belirleyin. Bu segenegi, Storage Manager Client iginden
bir depolama altsistemi grubu secip yénetmek ve ybénetilecek aygitlari ve
baslangigtaki algilamada bulunamayan aygitlari eklemek igin kullanabilirsiniz. Ek bilgi
icin Enterprise Management penceresi ¢evrimici yardimina bakin.

Onemli:

» Belirlenmeyen bir aygit eklerken, aygitin basarili bir sekilde eklendigini ve
depolama altsistemini ydnetebileceginizi dogrulayan bir pencere agillir.
Belirlenmeyen aygit grubunda listelenen herhangi bir aygit, dogru olarak
algilanincaya kadar ydnetilemez. Baglantilarin yapildigindan emin olun ve aygiti
eklemeyi yeniden deneyin.

» SAN’da bulunan ve anasistem-araci yazilimiyla yoénetilen depolama altsistemlerine
yeni depolama altsistemleri eklediginizde, anasistem-araci hizmetini durdurmal ve
yeniden baglatmalisiniz. Anasistem-araci hizmeti yeniden baglatildiginda, yeni
depolama altsistemi algilanir. Daha fazla bilgi igin, bkz.[‘Anasistem-araci|
[yaziiminin durdurulmasi ve yeniden baslatiimasi” sayfa 96| Sonra Enterprise
Management penceresine gidin ve yeni depolama altsistemlerini ydnetim etki
alanina eklemek i¢in Tools » Rescan (Araclar - Yeniden Tara) seceneklerini
tiklatin.

* Dogrudan (bant digindan) ydnetim ydntemi kullanilarak ydnetilen mevcut
depolama altsistemlerine yeni depolama altsistemi eklediginizde, her iki
denetleyicinin de IP adreslerini belirttiginizden emin olun.

Uyari bildirimlerinin ayarlanmasi

Yoénetim etki alanina aygit ekledikten sonra, depolama altsistemindeki kritik olaylarin

raporlanmasi igin uyar bildirimleri ayarlayabilirsiniz. Asagidaki uyari bildirimi

segeneklerini kullanabilirsiniz:

+ Belirlenmis bir ag yonetim istasyonuna (NMS; Network Management Station)
SNMP (Simple Network Management Protocol; Basit A Y6netimi iletisim Kurali)
tuzaklari bildirimi

» Belirlenmis e-posta adreslerine bildirim
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Not: Depolama altsistemlerini yalnizca ydnetim etki alani icinde izleyebilirsiniz.
Event Monitor (Olay izleme) hizmetini kurmazsaniz, Enterprise Management
penceresi acik kalmaldir. Bu pencereyi kapatirsaniz, yénetilen depolama
altsistemlerinden higbir uyari bildirimi almazsiniz. Ek bilgi igin Enterprise
Management penceresi gevrimigi yardimina bakin.

Uyar bildirimini ayarlamak igin Enterprise Management penceresinden Edit »
Configure Alerts (Dlizenle — Uyarilari Yapilandir) segeneklerini tiklatin.

SNMP tuzaklari araciligiyla bir NMS’ye uyari bildirimi gelmesini ayarlamak igin

asagidaki adimlari tamamlayin:

1. IBM System Storage DS3200 ve DS3400 Support CD’sini NMS (zerindeki CD
sUrtcisune takin. Belirlenmis ydnetim istasyonunu yalnizca bir kez kurmalisiniz.

2. SM2MIB dizinindeki SM2.MIB dosyasini NMS’ye kopyalayin.

3. Yonetim bilgi tabani (MIB) dosyasini derlemek Gzere NMS icin gereken adimlari
izleyin. Daha fazla bilgi icin ag yoneticinizle gérisiin ya da depolama yénetimi
yazilimiyla birlikte génderilen belgelere bakin.

Depolama altsistemlerinin adlandiriimasi

Depolama altsisteminizi adlandirmak igin asagidaki adimlari tamamlayin:

1. Enterprise Management penceresinde, bir depolama altsistemi segin, depolama
altsistemini sag tiklatin ve Rename (Yeniden Adlandir) secenegini belirleyin.
Rename Storage Subsystem (Depolama Altsistemini Yeniden Adlandir) penceresi

acihr.
=101 ]
Edit Wiew Tools Help %
A QB BB A
EI—34Bboﬂom Marme ITypeI Status Metwark Management Type I Comment |

|J:'|—Out-0f-Eiand Storage Subsystems FULL % @ Optirnal Out-of-Band
yaterm FLILL

iil Rename Storage Subsystem

Storage Subsystem name (max 30 characters]

e I Cancel | Help |

@ I |Aut0matic discovery completed. Found 1 host{s) andfor storage subsystem(s). l

Sekil 20. Rename Storage Subsystem (Depolama Altsistemini Yeniden Adlandir) penceresi

2. Depolama altsisteminin adini yazin (bkz.|Cizelge 12 sayfa 105)). Daha sonra OK
(Tamam) dugmesini tiklatin. Depolama altsisteminin adini degistirmenin,
anasistem uygulamalarinin depolama altsistemine erigimi yitirmelerine neden
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olabilecegini belirten bir uyari iletisi gériintilenir. Devam etmek igin Yes (Evet)
segenegini ya da depolama altsistemini adlandirmayi iptal etmek icin No (Hayir)
secenegini tiklatin.

Bu yordami, adlandiriimamis her depolama altsistemi igin tekrarlayin. Ek bilgi

icin, Subsystem Management penceresi ¢evrimigi yardimindaki depolama
altsistemlerini yeniden adlandirma konusuna bakin.

Denetleyicinin, NVSRAM’nin, ESM’nin ve sabit disk surticlisi sabit
yaziliminin yiklenmesi

Not: DS3000 depolama altsistemi denetleyici sabit yaziimi, NVSRAM, EXP3000

ESM ve sabit disk slirlictisii sabit yaziliminin en son strimlerini
[ttp://www.ibm.com/servers/storage/support/disk] adresinden yiikleyebilirsiniz.

Onemli:

1.

IBM, (cift denetleyicili yapilandirmada) “eszamanli sabit yazilim yiuklemesi” olarak
da adlandirlan sabit yazilimin G/G ile yiklenmesini destekler. Eszamanl sabit
yazilim yiklemesine gegcmeden dnce, sabit yazilm kodu ya da DS3000 Storage
Manager anasistem yazilimi paketinde bulunan benioku dosyasinda bu destekle
ilgili herhangi bir sinirlandirma olup olmadigina bakin.

Sabit yazihmi ve NVSRAM'yi, tek denetleyicili DS3000 depolama altsistemine
yUklerken tim G/C etkinligini durdurun, ¢link(i anasistem sunucusu ve DS3000
depolama altsistemi arasindaki badlantilari kaybedersiniz.

Bu bélimde, DS3000 depolama altsistemi denetleyicisi sabit yazilimini ve NVSRAM,
EXP3000 ESM sabit yazilimini ve siirlict sabit yazilimini ylklemeye iligkin
yonergeler bulunmaktadir. Normalde, DS3000 depolama altsistemi sabit yazilim
yUkleme sirasi denetleyici sabit yazilimiyla baslar, NVSRAM ve ESM sabit
yazilimlariyla devam eder ve sabit disk slrliclisi sabit yazilimiyla son bulur.

Denetleyici ya da NVSRAM sabit yaziliminin yuklenmesi

DS3000 depolama altsistemi denetleyici sabit yazilimini ve NVSRAM'yi yiklemek igin
asagidaki adimlari tamamlayin:

1.

Enterprise Management penceresinden depolama altsistemini ¢ift tiklatarak
Subsystem Management penceresini acin.

Support » Download firmware » Download Controller Firmware (Destek —
Sabit Yazilimi Yikle — Denetleyici Sabit Yazihmi Yikle) seceneklerini tiklatin.
Download Controller Firmware penceresi,|Sekil 21 sayfa 80| icinde gosterildigi gibi
acihr.
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2 Download Controller Firmware i x|

Select a firmware file to transfer nev contraller firmmeare from this management station to Storage

Subsystem FLLL,

 Cartroller Firmuwar
Currert contraller firmware version: Prainta 9617 41 05

Selected controller firmvare file:

File informeation:

I Tranater NYSRAM fils with controler fimevare
Currert NVSRAM version: N17260320R8 714

Selected WY ERANM fils:
[ Gislect Fils

File: infiormetion:

Transter, Cancel Help

Sekil 21. Download Controller Firmware penceresi

3. Denetleyici sabit yazilimi segcmek icin Selected controller firmware file (Secilen
denetleyici sabit yazilim dosyasi) alaninin yanindaki Select File (Dosya Sec)
secenegini tiklatin.

4. NVSRAM dosyasini se¢mek icin Transfer NVSRAM file with controller
firmware (Denetleyici sabit yazilimiyla birlikte NVSRAM dosyasini aktar) onay
kutusunu segebilirsiniz ve Selected NVSRAM file (Secilen NVSRAM dosyasi)
alaninin yanindaki Select File (Dosya Seg) segenegini belirleyebilirsiniz.

5. Transfer (Aktar) secenegini tiklatin.

ESM sabit yaziliminin yliklenmesi
ESM sabit yazilimini yiiklemek igin asagidaki adimlari tamamlayin:

1. Subsystem Management penceresinde, Support » Download firmware -
Download Environmental (ESM) Card Firmware (Destek — Sabit Yazilimi
Yikle — ESM Karti Sabit Yazilimini YUkle) seceneklerini tiklatin. Download
Environmental (ESM) Card Firmware (ESM Karti Sabit Yazilimini Y{ikle)
penceresi acllir.
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£ Download Environmental {ESM) Card Firmware L x|

Select a firmware file to transter new firmware from this menagement station to the selected environmental (ESM) cards on Storage
Subsystem FC.

 Drive enclosure:

Select enclosures: [~ Select &l

Mairmum Card A Card B
Data Rate Product ID Product 1D
Enclosure 1 |3 Ghps lEm-ESXs  |o158 IPh 2120400 0158 IPh 2120400 | |

Card
Manutacturer

Card &
Firmware

Card B
Firtnware

Enclasure 1D Status

~ESM firmware

Selected ESM firmware file informstion:

Select File:..

Please select enclosures and specify firmware file.

Start | Cloze | Help |

Sekil 22. Download Environmental (ESM) Card Firmware penceresi

2. YUklemeyi tim kasalara yénlendirmek icin Select All (TumunU Seg) onay
kutusunu isaretleyin. Tek tek kasalari segerken Cirl tusunu basili tutarak bir
kasay! ya da kasa birlesimlerini secebilirsiniz.

3. ESM sabit yazilim dosyasini se¢gmek icin Select File (Dosya Se¢) secenegini ve
ESM sabit yazilimini yiklemeye basglamak igin Start (Baglat) secenegini tiklatin.
Confirm Download (YUklemeyi Onaylayin) penceresi agilir.

4. Yes (Evet) yazin ve yikleme islemini basglatmak icin OK (Tamam) digmesini
tiklatin.

5. Segili tim kasalara ESM sabit yaziliminin yiklenmesi tamamlandiktan sonra
Close (Kapat) secenegini tiklatin.

Not: Tek denetleyicili yapilandirmaniz varsa ya da ESM sabit yazilimini gift
denetleyicili bir yapilandirmaya yiklemek icin birden ¢ok kasa segtiyseniz,
ESM sabit yazilimi yiklenirken tim G/C etkinligini durdurun. Her defasinda
yUkleme igin bir kasa secerseniz, ESM sabit yazilimini yUklerken sunucu,
G/C etkinligini yonetir. Ancak, sabit yazilim gincellemelerini gergeklestirmek
igin tim G/C etkinligini durdurmaniz tercih edilir.

Otomatik ESM sabit yaziliminin eszamanlanmasi

Otomatik ESM sabit yazilimini eszamanlama islevini destekleyen bir DS3000
depolama altsistemine bagli varolan depolama genisletme kasasina yeni bir ESM
kurdugunuzda, yeni ESM’deki sabit yazilim varolan ESM’deki sabit yazilimla otomatik
olarak eszamanlanir. Bu, ESM sabit yazilim eslesmeme durumlarini otomatik olarak
cozer.

Not: Otomatik ESM sabit yazilimi eszamanlamasi, yalnizca depolama genisletme
kasasindaki ESM’ye, ESM sabit yazilim dosyasi basaril bir sekilde
yUklendikten sonra gerceklestirilebilir.

ESM sabit yaziliminin otomatik olarak eszamanlanmasini etkinlestirmek igin
sisteminizin agagidaki gereksinimleri karsiladigindan emin olun:

» Storage Manager Event Monitor programi kurulu ve ¢alisiyor olmali.

» DS3000 depolama altsistemi, Storage Manager Client (SMclient) Enterprise
Management penceresinde tanimlanmalidir.
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Surici sabit yaziliminin yuklenmesi

Bu bdlimde, DS3000 s(irlict sabit yazihminin yiklenmesine iligkin yonergeler
bulunmaktadir. Ek bilgi icin gevrimici yardima bakin.

Onemli: Siiriici sabit yazilimini yiikleme islemini baglatmadan énce asagidaki

gorevleri tamamlayin:

» Slrici sabit yazilimini DS3000 depolama altsistemine yliklemeden 6énce
tim G/G etkinligini durdurun.

» Sabit yazilim blyUtmesi igin se¢tiginiz strtculere erigimi olan tim
mantiksal srtculerin dosya sistemlerini kapatin.

» Sir0ci sabit yazilimi blyGtmesi igin seg¢tiginiz strtictlerdeki tim verilerin
tam yedegini alin.

Sar0cl sabit yazihmini yiklemek igin asagidaki adimlari tamamlayin:
1. Enterprise Management penceresinde depolama altsistemini ¢ift tiklatarak
Subsystem Management penceresini acin.

2. Support » Download firmware » Download Drive Firmware (Destek — Sabit
Yazilimi Yikle — Sdrlci Sabit Yazilimini YUkle) segeneklerini tiklatin.
Download Drive Firmware penceresi agllir.

E= Download Drive Firmware - Select Packages

Select the drive firmware packages you swould like to transfer. If you have mare than one type of drive (vendor ahd capacity], vou
may select up to four packages to transter at a time.

~Current drive firmware package information

Drive procduct IDs and firtnware versions: ST336T5455(BA1E)

~Selected packacy

Packages to be fransferred:

Remove

Package infarmation:
Crive wvendor:
Drive product ID:
Proposed firmware:
Compstible firmweare:
HiExt = | Cancel | Help |

Sekil 23. Download Drive Firmware penceresi

3. YUklemek istediginiz sabit yazilimin bulundugu sunucu dizinini bulmak icin Add
(Ekle) secenegini tiklatin.

4. YUklemek istediginiz sabit yazilim dosyasini segin ve OK (Tamam) segenegini
tiklatin. Dosya daha sonra Selected Packages (Secilen Paketler) alaninda
listelenir.

5. Yuklemek istediginiz diger strlcu tiplerine iligkin sabit yazilim dosyasini segin
ve OK (Tamam) digmesini tiklatin. Ek dosyalar daha sonra Selected Packages
(Secilen Paketler) alaninda listelenir. Toplam en fazla dért siiriict tipi
segcebilirsiniz.

6. YUklemek istediginiz sabit yazilim dosyalarinin timini seginceye kadar,
numarall adimi yinelemek i¢in Add (Ekle) segenegini tiklatin.
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7.

8.

Yiiklenecek sabit yazilim paketlerinin belirlenmesini bitirdikten sonra Next (ileri)
secenegini tiklatin.

Select Drive (Sirticii Seg) penceresinde (Sekil 24]icinde gésterilen),
Compatible Drives (Uyumlu SiirGculer) etiketini tiklatin. Compatible Drives
(Uyumlu Siruculer) sayfasinda, segtiginiz sabit yazilim paketi tipleriyle uyumlu
surdcdlerin bir listesi bulunur. Farenizle birden ¢ok sirlclyU tek tek segerken
Ctrl; birden cok slrlicliyl dizi olarak segmek icin Shift tusunu basili tutun.
lsayfa 82 ve |5 sayfa 82|numarali adimlarda segtiginiz uyumlu sabit yazilim,
sectiginiz sUrlcullere ylklenir.

£+ Download Drive Firmwa

The fallowing tables digplay drives that are compatible and incompatible with the packages you selected. You may updsate the
firrmare on one o multiple drives, even if they are not &t the same initial firmware level. Select the drives you wish to update &t
this time.

Important: “ou must stop all 110 and unmount any file system on all logical drives accessing the selected drives before starting
the transfer process

-Selected firrmware packages - iz
Drive product ID= and firmware versions: ST33673455(BA1E) ‘

Select drives: [ Select al

Compatible Drives | Incompatible Drives I

Selectediavailable drives: 141

endor ProductlDlEnclosure Slot Type Current 1...| Propose... Status Array Mode

= Back Finizh... Cancel | Helg |

Sekil 24. Select Drive penceresi

9.

10.

Not: Yuklemek igin segtiginiz sabit yazilim paketleri, Compatible Drives
(Uyumlu Surtculer) sayfasinda listelenebilir. Striicindzin Grin taniticisi,
sabit yazilim tipiyle eslesiyor, ancak sayfada uyumlu olarak
listelenmiyorsa, ek yénergeler icin teknik destek temsilcinizle gértsan.

numarall adimda sectiginiz uyumlu her sirtctye, sirici sabit yazilimini
yUklemeyi baslatmak icin Finish (Son) diigmesini tiklatin.

Download Drive Firmware uyari penceresi acildiginda ve Do you want to
continue? (Devam etmek istiyor musunuz?) iletisi gérintilendiginde, yes (Evet)
yazip, slr(icU sabit yazihmini yiklemeye baslamak icin OK (Tamam) segenegini
tiklatin. Download Progress penceresi, [Sekil 25 sayfa 84| iginde gosterildigi gibi
acilir. Yukleme islemi tamamlanincaya kadar isleme midahale etmeyin.
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Drives updated:

“endor I Product 1D I Enclosure I it I Type IPerosed Flr...l Array | Status | Progress |
IBM-ESXS ST33675455 .0 1 by SAS BA1E 1 Optirrial Successful

[-Progress summar’

|
 Scheduled In progress Failed-partis| Failed-invalid state  Failed-other Mot attempted Successtul
i1 i i i 0 i 1

Transter More... | Slop | Save As... | Close | Help |

Sekil 25. Download Progress penceresi

Sabit yazihm yiklemesinin yapilacagdi suricllerin durumlari, successful
(basarill) ya da failed (basarisiz) olarak gdsterilinceye kadar in progress
(ilerliyor) olarak gosterilir.

11. SUr0cl icin yikleme basarisiz olursa, asagidaki iki adimi tamamlayin:
a. Hata ginlugini kaydetmek igin Save as (Farkli kaydet) digmesini tiklatin.

b. Subsystem Management penceresinde Support » View Event Log (Destek
— Olay Gunliguani Gérintile) segeneklerini tiklatin ve teknik destek
temsilcinizi aramadan énce depolama altsistemi olay gunlligini kaydetmek
icin asagidaki gbrevleri tamamlayin.

1) Select all (TUmin0 Sec) segenegini tiklatin.
2) Save as (Farkli Kaydet) secenegini tiklatin.
Close (Kapat) digmesinin etkinlesmesi siriicl sabit yaziliminin yikleme
isleminin tamamlandigni belirtir.
12. Close (Kapat) secenegini tiklatin.

Dizilerin ve mantiksal slriciulerin olusturulmasi

Onemli: Depolama altsistemindeki dizileri ve mantiksal siriictleri her
degistirdiginizde bir depolama altsistemi profili olusturun ve bunu givenli bir yerde
saklayin. Bu profil, bir olaganudstu bir durumunda yapilandirmayi kurtarmaniza
yardimci olacak mantiksal ve fiziksel disk yapilandirma bilgileri de dahil olmak tzere,
ayrintili denetleyici bilgilerini igerir. Profili alinmig ve kaydedilmis DS3000 depolama
altsisteminde olusturulan mantiksal sricilerdeki profili kaydetmeyin.

Depolama altsistemi profilini kaydetmek icin asagidaki adimlari tamamlayin:

1. Subsystem Management penceresinde Summary » Storage Subsystem Profile
(Ozet — Depolama Altsistemi Profili) seceneklerini belirleyin. Storage Subsystem
Profile (Depolama Altsistemi Profili) penceresi agilir.

2. Save As (Farkh Kaydet) secenegini tiklatin.

3. Kaydedilmesini istediginiz béliimleri segin ve Profili kaydetmek Gizere bir dosya
adi yazin.
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Stok, durum, tanilama ve basarim verilerini depolama altsisteminden toplamak ve tek
bir sikistiriimis dosyaya kaydetmek igin, iginde gosterildigi gibi Summary »
Gather Support Information (Ozet — Destek Bilgisi Topla) seceneklerini de
tiklatabilirsiniz.

ERFULL I6M Syste: rage DS3000 Storas

Support = Gather Support nformation
Gather Support Information

Specify a file name and lcation for the support data file and lick stert to save all support data

File:

[ Browse
St Close

Sekil 26. Gather Support Information penceresi

Fiber Kanal ya da SAS sabit disk slrtculeri kimesi, bagimsiz yedek disk dizisi
(RAID) olusturmak Gizere mantiksal olarak birlikte gruplandirilir.

Mantiksal sdrticd, depolama altsistemine veri depolamak icin olusturdugunuz temel
yap! olan mantiksal bir yapidir. isletim sistemi bir mantiksal siiriiclyii tek bir stiriici
olarak tanir. Uygulamanin veri kullanilabilirligi gereksinimlerini karsilamak ve G/G
basarimini en Ust diizeye ¢ikarmak icin bir RAID dlzeyi segin.

Bir dizide desteklenen maksimum slrtct sayisi 30°dur. Her dizi 1 - 256 arasinda
mantiksal strictye béltnebilir.

Diziler ve mantiksal strlculer olusturmak igin asagidaki adimlari tamamlayin:

1. Enterprise Management penceresinde, Subsystem Management penceresini
acmak i¢in depolama altsistemini ¢ift tiklatin.

2. Configure (Yapilandir) etiketini tiklatin.

3. Create Logical Drives (Mantiksal Suriiculer Olustur) segenegini tiklatin. Create
Logical Drives sihirbazi,[Sekil 27 sayfa 86|iginde gosterildigi gibi baglar.

Not: Anasistemleri daha 6nceden yapilandirmadiysaniz, bir uyari iletisi
goruntdlenir. lletileri okuyun ve OK (Tamam) segenegini tiklatin; daha sonra
Create Logical Drives sihirbazi ile devam edin.

B6lim 8. Storage Manager yaziliminin kurulusunun ve yapilandirmasinin tamamlanmasi 85



&3 FULL IBM System Storage DS3000 Storage Manager 2 {Subsystem Management)

Configure = Create Logical Drives

Create Logical Drives - Select Capacity Type

Chaose the type of capacity to use:

& Unconfigured capacity: create a new an array and logical drive.

B oy 2 (ReD )
rray 3 (RAID 53
ety 4 (RAID 5)
rrsy § (RAID 31
rray 6 (RAID 5)
ray 7 (RAD 5)
rray B (RAID 51

ey 3 (RAID 5)

Sekil 27. Create Logical Drives sihirbazi penceresi

4. Unconfigured Capacity (Yapilandiriimamis Kapasite) ya da Free Capacity (Bos
Kapasite) onay kutusunu isaretleyin. Dizileri ve mantiksal slrlicileri olusturmak
icin ydnergeleri izleyin. Ayrica bkz. ['Bos ya da yapilandiriimamis kapasitederi
mantiksal strlictlerin olusturulmasi’}

5. [‘Anasistem erigiminin yapilandiriimasi” sayfa 87|baglikli konuya gegin.

Not: Kime yapilandirmalari igin, mantiksal sirlici ekler veya silerseniz, bunlari hem
A, hem de B digiimlerine bildirmeniz gerekir.

Bos ya da yapilandiriimamis kapasiteden mantiksal surlculerin
olusturulmasi

Create Logical Drive sihirbazini kullanarak, bos ya da yapilandiriimamis kapasite
digumlerinden mantiksal siriiculer olusturmak igin asagidaki adimlari tamamlayin:

1. Create Logical Drives sihirbazi baslar ve Select Capacity Type gértntilenir.
Unconfigured capacity (Yapilandiriimamis kapasite) ya da Free capacity (Bos
kapasite) onay kutusunu isaretleyin ve Next (lleri) secenegini tiklatin.

Not: Free capacity (Bos kapasite) secenegini belirlediginizde, sihirbaz iginde
ilerlemeden 6nce, ilk olarak varolan diziden bos kapasite digimini
secmelisiniz.

2. Drive Selection Choices icerigi gérintilendiginde Automatic (Otomatik) ya da
Manual (El ile) segenegini belirleyin ve Next (ileri) segenegini tiklatin. Automatic
(Otomatik) segenegini belirlediyseniz, adim 3 ile devam edin. Manual (El ile)
segenegini belirlediyseniz, adim 4’e gegin.

Not: Otomatik segenegi, hizli ve kolay yapilandirma igin tercih edilir. Bu yontem,
otomatik olarak olusturulmus sirlict ve kapasite segenekleri listesinden
secim yapmanizi saglar. El ile segenedi, ileri diizey kullanicilara yeni bir dizi
olusturmak igin sirtculeri belirlemenin yolunu sunar.

3. Choose Configuration (Automatic Configuration) igerigi goriintilendiginde, bir
RAID diizeyi secin ve Finish (Son) segenegini tiklatin.
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Not: Secilen RAID diizeyine bagh olarak, otomatik yapilandirma, depolama
altsisteminde kalan tim yapilandiriimamis kapasiteyi yapilandirir. Neyin
yapilandirilacagina iligkin ayrintilar igin Configuration summary
(Yapilandirma 6zeti) alanini denetleyin.

4. [Sekil 28iginde gosterildigi gibi Manual Drive Selection igerigi goriintalendiginde,

RAID dizeyini secin. Unselected drives (Secili olmayan siricller) alanindan

sUrlclleri segin ve siriclleri Selected drives (Secili strtculler) alanina tagimak

icin Add (Ekle) segenegini tiklatin. Selected drives (Secili stirliciiler) alaninda

Calculate Capacity (Kapasiteyi Hesapla) secenegini tiklatin ve sonra Next (ileri)

secenegini tiklatin.

5 FULL IBM System Storage DS3000 Storage Manager 2 (Subsystem Management)

| &
| Summary I Configure ] Modify
Confisure = Create Logicel Drives
Create Logical Drives - Manual Drive Selection
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Sekil 28. El ile sdirticti segimi igerigi

5. Specify Logical Drive icerigi goértntllendiginde, kapasiteyi, adini ve mantiksal
strticiiye iliskin G/G &zelliklerini belirtin ve Next (ileri) secenegini tiklatin.

6. Map Logical Drive To Host (Mantiksal Sirlicliyl Anasistemle Eslestir) icerigi
gorintlilendiginde, mantiksal sirlicllyl hemen eglestirmek icin Map now (Simdi
Eslestir) secenegini ya da mantiksal sriiclyl daha sonra eglestirmek icin Map
later (Daha Sonra Eslestir) segenegini belirleyin ve Next (ileri) secenegini tiklatin.

Not: Mantiksal strliclyl hemen eglestirmek igin anasistemin ya da anasistem
grubunun énceden yapilandiriimis olmasi gerekir (devam etmeden 6nce
mantiksal striiciiniz i¢in bir LUN numarasi atadiginizdan emin olun). Map
later (Daha Sonra Eslestir) secenegini belirlerseniz, mantiksal striclyu,
Create Host-to-Logical Drive Mappings (Anasistem Mantiksal SiricU
Eslesmeleri Olustur) sihirbazi iginden eslestirebilirsiniz. Ek bilgi almak igin,

bkz. ['LUN’larin bir béliimle eslestiriimesi” sayfa 89}

Anasistem erisiminin yapilandiriimasi

Anasistem sunucusundaki mantiksal strlcdleri kullanmadan énce, erisim igin
anasistemi tanimlamali ve yapilandirmalisiniz.

Anasistem erisimini yapilandirmak igin asagidaki adimlari tamamlayin:
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1. Subsystem Management penceresinde Configure (Yapilandir) etiketini tiklatin.
Asagidaki seceneklerden birini segin:

* Anasistem erisimini otomatik olarak yapilandirmak i¢in Configure Host
Access (Automatic) (Anasistem Erisimini Yapilandir (Otomatik)) secenegini
tiklatin ve sihirbaz yénergelerini izleyin. Sihirbazdaki yénergeleri
tamamladiktan sonra, bu yordamla iginiz biter.

Not: Anasistemleri otomatik olarak bulmak igin Storage Manager 2 Agent
hizmeti galigiyor olmahdir. llerlemeden 6nce, SMagent yardimci
programinin kurulu oldugundan emin olun.

* Anasistem erigimini el ile yapilandirmak igin Configure Host Access (Manual)
(Anasistem Erisimini Yapilandir (El ile)) segenegini tiklatin ve adim E ile devam
edin.

2. Configure Host Access (Manual) (Anasistem Erigsimini Yapilandir (El ile)) sihirbazi
basladiginda, bir anasistem adi ve anasistem tipi belirleyin ve daha sonra Next
(lleri) secenegini tiklatin.

Not: Bir anasistem sunucusundaki mantiksal strtculeri kullanmadan énce,
dogru anasistem tipini belirlemelisiniz. Anasistem tipi, depolama altsistemi
denetleyicilerinin, denetleyicilerin bagh oldugu anasistemlerdeki igletim
sistemlerinin her biriyle nasil galisacagini belirler. Desteklenen anasistem
tipleri igin, Storage Manager yazilimi benioku dosyasina bakin.

3. Specify HBA Host Ports igerigi gériintilendiginde, Selected HBA host port
identifiers/aliases (Secili HBA anasistem kapisi taniticilari/diger adlar) alaninda
bilinen ya da yeni anasistem veriyolu bagdastiricilarini ekleyin ve daha sonra
Next (ileri) secenegini tiklatin.

4. (istege bagl) Specify Host Group igerigi gériintiilendiginde, mantiksal siiriicillerle
erisimi paylasacak bir anasistem grubu belirtin. Anasistem grubu belirttiginizde,
yeni bir anasistem grubu olusturabilirsiniz ya da énceden tanimlanmisg, varolan bir
anasistem grubu secebilirsiniz. No (Hayir) ya da Yes (Evet) secenegini belirleyin
ve daha sonra Next (ileri) secenegini tiklatin.

Anasistem gruplarinin tanimlanmasi

Anasistem grubu, Storage Partitionin (Depolama Bolimleme) topolojisindeki, bir ya
da daha ¢ok mantiksal strliclye paylasimli erisim gerektiren anasistem
sunucularinin mantiksal toplulugunu tanimlayan bir 6gedir. Tanimli bir anasistem
grubundaki anasistemlerin, anasistem gruplarindan bagimsiz olarak tek tek
depolama bdélimlerine erismesine izin verebilirsiniz. Anasistem grubuna ya da bir
anasistem grubundaki tek bir anasisteme mantiksal siirlici-LUN eslemelerini
yapabilirsiniz.

Onemli: Bir Storage Partitioning ek ézelligi satin aldiysaniz, ek 6zelligin
etkinlestirildiginden emin olun. Ek &zelligi etkinlestirmek igin anahtarinizla
birlikte gbnderilen yénergelere bakin ya da ek 6zellidi etkinlestiremiyorsaniz
teknik destek temsilcinizi arayin.

Not: Anasistem grubunu tanimlarken tiirdes olmayan anasistemleri
yapilandirabilirsiniz. Bu 6zellik, farkl isletim sistemleri calistiran anasistemlerin
tek bir depolama altsistemine erismesini saglar.

Anasistem grubunu tanimlamak i¢in asagidaki adimlari tamamlayin:
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Subsystem Management penceresinde Create Host Group sihirbazini baglatmak
icin Configure » Create Host Group (Yapilandir — Anasistem Grubu Olustur)
seceneklerini tiklatin.

Create Host Group icerigi gérintiilendiginde anasistem grubu icin bir ad girin ve
var olan anasistemleri, anasistem grubuna ekleyin.

Bu sihirbazi tamamlamak igin OK (Tamam) secenegini tiklatin.

Not: Anasistem grubuna anasistem eklemek igin, var olan anasistemler dnceden
erisim i¢in yapilandirilmis olmalidir. Anasistem eklemeden énce bir
anasistem grubu olusturabilirsiniz ve daha sonra Create Host Access
(Manual) sihirbazini kullanarak anasistem ekleyebilirsiniz. Ek bilgi almak
igin, bkz.|“Anasistem erisiminin yapilandiriimasi” sayfa 87l

LUN’larin bir bolimle eslestirilmesi

LUN’lar bir bélumle eslestirildiginde, her biri bir mantiksal sirlciye atanir.

Yeni ya da varolan bir bélime LUN’lar eslestirmek igin asagidaki adimlari
tamamlayin:

1.

Subsystem Management penceresinde sihirbazi baslatmak icin Configure »
Create Host-to-Logical Drive Mappings (Yapilandir — Anasistem - Mantiksal
Sarliclt Eslemeleri Olustur) segeneklerini tiklatin.

Select Host igerigi gérintilendiginde bir anasistem ya da anasistem grubu segin
ve Next (lleri) segenegini tiklatin.

Select Logical Drives icerigi gérintiilendiginde, belirlenen anasistemle
eslestirmek istediginiz mantiksal suriicileri segin ve Finish (Son) segenegini
tiklatin.

Diger depolama altsistemi yonetim goérevlerinin gerceklestirilmesi

Asagidaki listede, gerceklestirebileceginiz dijer depolama altsistemi yénetim
gorevleri anlatiimaktadir. Subsystem Management penceresinden asagidaki gérevleri
gerceklestirebilirsiniz.

CGalisirken degistirilebilir pargalar olusturma (Configure » Configure Hot Spares )
(Yapilandir — Galisirken Degistirilebilir Parcalari Yapilandir)

Mantiksal surtculeri ve galisirken degistirilebilir pargalari otomatik olarak
olusturma ( Configure » Automatic Configuration) (Yapilandir — Otomatik
Yapilandirma)

Altsistem icin anasistem topoloji yapilandirmalarini dizenleme (Modify » Edit
Topology) (Degistir — Topolojiyi Dizenle)

Depolama altsistemi parolasini yazma ya da degistirme (Tools » Set or Change
Password) (Araclar — Parola Belirle ya da Degistir)

Ortam tarama ayarlarini gériintileme ya da degistirme (Tools » Change Media
Scan Settings) (Araglar — Ortam Tarama Ayarlarini Degistir)

Depolama altsistemini ya da bilesenlerini bulma (Tools » Locate) (Araglar — Bul)

Ek 6zellikleri gortntileme ya da etkinlestirme (Tools » View/Enable Premium
Features) (Araclar — Ek Ozellikleri Gérlntile/Etkinlestir)

Depolama altsistemindeki kasa taniticisi numaralarini degistirme (Tools » Change
Enclosure ID Numbers) (Aracglar — Kasa Taniticisi Numaralarini Degistir)

Denetleyici saatlerini eszamanlama (Tools » Synchronize Controller Clocks)
(Araglar — Denetleyici Saatlerini Eszamanla)
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* Ag yapilandirmasini degistirme (Tools » Change Network Configuration)
(Araglar — Ag Yapilandirmasini Degistir)

» Pilin yasini yeniden ayarlama (Tools » Reset Battery Age) (Araclar — Pil Yagini
Yeniden Ayarla)

+ lsletim sisteminden sistem ayarlarini devralma (Tools » Inherit System Settings)
(Araglar — Sistem Ayarlarini Devral)

* Ana olay ginligini gérintileme (Support » View Event Log) (Destek — Olay
GUnlGginG Gérintdle)

* Depolama altsistemi verilerinin timin0 kaydetme (Support » Gather Support
Information) (Destek — Destek Bilgisi Toplama)

» Denetleyiciyi cevrimici ya da ¢gevrimdisi yerlestirme (Support » Manage
Controllers) (Destek — Denetleyicileri Yonet)

Bunlar ve diger depolama altsistemi yénetimi gérevleri hakkinda ek bilgi igin,
Subsystem Management gevrimigi yardimindaki ilgili konulara bakin.

ileri diizeyde kullanicilar icin: Tools » Script Editor (Araglar — Metin Diizenleyici)
segeneklerini tiklatarak, Enterprise Management penceresinden diger depolama
altsistemi yénetim goérevlerini gerceklestirebilirsiniz. Ek bilgi igin Enterprise
Management penceresi ¢evrimici yardimina bakin.

90 windows, Linux, NetWare ve ESX Server icin DS3000 Storage Manager Kurulus ve Destek Kilavuzu



Not: Depolama altsistemiyle ilgili bir sorun varsa, depolama altsisteminin yanindaki
Enterprise Management penceresinde Needs Attention durum isareti
gérintilenir. Subsystem Management penceresinde Summary (Ozet)
sayfasinin durum alaninda Storage Subsystem Needs Attention baglantisi
gorintllenir. Recovery Guru’yu agmak igin baglantiyi tiklatabilirsiniz. Ayrica,
Subsystem Management penceresinde Support » Recover from Failure
(Destek — Arizayi Gider) segeneklerini tiklatarak Recovery Guru’yu
acgabilirsiniz.
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Bolim 9. Windows anasistemlerine iliskin depolama yonetimi
gorevlerinin tamamlanmasi

Bu bélimde, Windows isletim sistemi ortamlarinda mantiksal strlcUlerin eklenmesi
ya da silinmesi, hot_add ve SMdevices yardimci programlarinin kullaniimasi,
anasistem-araci yaziliminin baslatilmasi ve durdurulmasi ve Storage Manager
bilesenlerinin kaldirilmasi anlatiimaktadir.

Mantiksal suriculerin eklenmesi ya da silinmesi

Standart (kimelenmemis) ya da kiime yapilandirmasina mantiksal sirlici eklemek
ya da var olan mantiksal surtictleri bu yapilandirmalardan silmek igin asagidaki
yordamlari kullanin.

Standart (kimelenmemis) Windows Server 2003 yapilandirmasi

Standart bir yapilandirmada mantiksal slrlicl olusturmak ya da bunlari silmek igin
asagidaki yordamlari kullanin.

Mantiksal surtculerin olusturulmasi

Storage Manager yazilimini kullanarak mantiksal suriict olusturdugunuzda, Windows
Server 2003 igletim sistemine yeni mantiksal strtculer eklemeniz gerekir. Her bir
mantiksal stirlicl (dizi degil) Windows Server 2003 tarafindan tek bir disk strlicis
olarak taninir.

Mantiksal strtclleri olusturduktan sonra Storage Manager yazilimiyla saglanan
hot_add ve SMdevices yardimci programlarini galistirin. hot_add yardimci programi,
yeni olusturulan mantiksal sirlclleri, sistemi yeniden baslatmadan isletim sistemine
ekler. SMdevices yardimci programi, mantiksal sirtculeri, iliskilendirildikleri isletim
sistemi aygit adlarina gére tanitir. Ek bilgi icin]hot_add yardimci programinin|
kullanllma3|| (sayfa ya da|SMdevices yardimci programinin kullaniimasi| (sayfa

95) baslikli konuya bakin.

Mantiksal siirticlilerin silinmesi

Uyari: Mantiksal sirtculeri siimeden ya da Storage Manager yaziliminin
yapilandirmasini ilk duruma getirmeden énce kiime fiziksel disk kaynaklarini, isletim
sistemi bélimlerini ve atanmamis strici harflerini silmek igin Disk Administrator
programini kullanmaniz gerekir. Bu islem, kayit dosyasi bilgilerinin zarar gérmesini
onler.

Storage Manager yazilimiyla mantiksal sdrlcUleri silmeden énce asagidaki adimlari
tamamlayin:

1. Bolumleri silmek ve mantiksal strtculerle iliskilendirilmis strtict harflerinin
atamasini kaldirmak igin Disk Administrator programini kullanin.

2. MOmkinse, yapilandirma bilgilerini kaldirmak icin sistemi yeniden baglatin.

Windows Server 2003 icin kiime sunucusu yapilandirmasi
Kime sunucusu yapilandirmasinda mantiksal slriici olusturmak ve buradaki
mantiksal strtcileri silmek igin asagidaki yordamlari kullanin.

Mantiksal siriculerin olusturulmasi
Windows Server 2003 kiime sunucusu ortamina mantiksal slr(ict eklemek igin
asagidaki adimlari tamamlayin:
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1. Dizileri ve mantiksal sirtculeri olusturmak igin Storage Manager Client
programini ve bu dizi ve mantiksal sirdcdleri ilgili kime anasistem grubuna
atamak i¢in depolama bdélimlemesini kullanin.

2. Yeterli kime kaynaginin sahip oldugu kiime digumdine yeni mantiksal surtciler
eklemek i¢in hot_add yardimci programini kullanin.

3. Disk Administrator programini kullanarak, yeni mantiksal strlcilerde disk
bélamleri olusturabilir, bunlari bigimlendirebilir ve bu disk bélimlerine slricl
harfleri atayabilirsiniz.

4. Kume yapilandirmasindaki kalan kiime digimlerinin her birinde, kime
digimune yeni mantiksal sdrtculer eklemek igin hot_add yardimci programini
kullanin.

5. Birinci kime digumuinde, yeni mantiksal strlcilerdeki yeni disk bélimlerini
kullanarak kiime fiziksel disk kaynaklari olusturmak icin Cluster Administrator
programini kullanin.

Not: Cluster Administrator programinda ¢alisirken kullanilabilir disk listesinde
yeni disk gériintilenmezse, sunucuyu yeniden baslatmaniz gerekebilir.

6. Birinci kime dugimindeki kime kaynaklarini ¢gevrimici duruma getirin.
7. Yeni olusturulan kiime fiziksel disk kaynaklarini, kime yapilandirmasindaki diger
digimlere tasimak icin Cluster Administrator programini kullanin.

8. Kume yapilandirmasindaki diger digimlerde de kaynaklarin ¢gevrimici duruma
geldiginden emin olun.

Mantiksal sitirticlilerin silinmesi

Uyari: Kayit dosyasindaki bilgilerinizin zarar gérmemesi icin mantiksal strtculeri
silmeden ya da Storage Manager yaziliminin yapilandirmasini ilk duruma getirmeden
Once kiime fiziksel disk kaynaklarini, isletim sistemi bélimlerini ve atanmamig siriict
harflerini silmek igin Cluster Administrator ya da Disk Administrator programini
kullanmaniz gerekir.

Storage Manager yazilimini kullanarak mantiksal stricileri silmeden énce asagidaki

adimlar tamamlayin:

1. Silinecek mantiksal strtcilerin bulundugu kiime fiziksel disk kaynaklarini silmek
igin Cluster Administrator programini kullanin.

2. Bolumleri silmek ve mantiksal surdcdlerle iligkilendirilmis strtci harflerinin
atamasini kaldirmak icin Disk Administrator programini kullanin.

3. Mumkinse, yapilandirma bilgilerini kaldirmak igin kime digumlerini yeniden
baslatin.

hot_add yardimci programinin kullaniimasi

Sistemi yeniden baglatmadan yeni mantiksal siriicliler eklemek igin hot_add
yardimci programini kullanin. Bu yardimci program, bélim olusturmak, aygit adi
eklemek ve benzer islemleri gergceklestirmek Gizere Disk Administrator programini
kullanabilmeniz igin yeni mantiksal strlculeri igletim sistemine kaydeder. hot_add
yardimci programi, SMutil yazilim paketinin pargasidir. Programi ikinci kez
calistinyorsaniz ve yeni mantiksal strGciler Disk Administrator penceresinde
gorintilenmiyorsa, Fiber Kanal tanilama programlarini galistirmaniz ya da
anasistemi yeniden baslatmaniz gerekir.

Depolama altsisteminde mantiksal striici olusturma islemini tamamladiginizda,
hot_add yardimci programini kullanmak igin depolama altsistemine bagli anasistem
Uzerinde asagidaki adimlari tamamlayin:

94  windows, Linux, NetWare ve ESX Server icin DS3000 Storage Manager Kurulus ve Destek Kilavuzu



1. Bir komut isteminde kurulus_diziniutil dizinine gidin; burada kurulus_dizini, SMutil
yardimci programini kurdugunuz dizindir.

Varsayilan dizin c:\Program Files\IBM_DS3000\util dizinidir.
2. Asagidaki komutu girin:
hot_add

Yeni mantiksal surdciler, Disk Administrator programinda kullanilabilir.

SMdevices yardimci programinin kullaniimasi

SMutil yazilmi, SMdevices adi verilen ve bir isletim sistemi aygit adiyla iligkilendirilen
depolama altsistemi mantiksal strlicisinu gériintilemek icin kullanabileceginiz bir
yardimci programi igerir. Bu yardimci program, Disk Administrator ile sriict harfi ya
da boélim olusturmak istediginizde size yardimci olur.

Depolama altsisteminde mantiksal stirlicl olusturma islemini tamamladiginizda,
SMdevices yazilimini kullanmak igin depolama altsistemine bagli anasistem izerinde
asagidaki adimlari tamamlayin:

1. Bir komut isteminde kurulus_dizinAutil dizinine gidin; burada kurulus_dizini, SMutil
yardimci programini kurdugunuz dizindir.

Varsayilan dizin c:\Program Files\IBM_DS3000\util dizinidir.
2. Asagidaki komutu girin:
SMdevices

Yazilim, aygit tanitimi bilgilerini gériintiler. Ornegin, asagidaki bilgileri
gorebilirsiniz:
\\.\PHYSICALDRIVEx [Storage Subsystem

finans, Logical Drive borg,
LUN xx, WWN genel ad]

Burada:

* X, Disk Administrator iginde gorlnttlenen disk numarasidir
 finans, depolama altsisteminin adidir

* borg, mantiksal sUricinin adidir

*  xx, mantiksal sUrtcuyle iligkilendirilen LUN'dir

* genel_ad, mantiksal sUrlictiniin genel adidir

SMrepassist yardimci programinin kullaniimasi

Mantiksal strticl igin &nbellege alinan verileri temizlemek (izere SMrepassist
yardimci programini kullanabilirsiniz.

Onemli: FlashCopy siiriictisti, Windows Server 2003 ya da NetWare ortaminda
FlashCopy mantiksal stiricisinin temel mantiksal sUrlciisine sahip sunucuya
eklenemez ya da bu sunucuyla eslenemez. FlashCopy mantiksal stricisini bagka
bir sunucuyla eslemelisiniz.

Bir mantiksal striicinin énbellegindeki verileri temizlemek icin asagidaki adimlari
tamamlayin:

1. Bir komut isteminde kurulus_diziniutil dizinine gidin; burada kurulus_dizini, SMutil
yardimci programini kurdugunuz dizindir.

Varsayilan dizin c:\Program Files\IBM_DS3000\util dizinidir.
2. Asagidaki komutu girin:
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smrepassist -f mantiksal_siiriicii_harfi

burada mantiksal_sdirtict_harfi, mantiksal sGriictide olusturulan disk bélimiine
atanmis igletim sistemi slrtcisa harfidir.

Anasistem-araci yaziliminin durdurulmasi ve yeniden baslatiimasi

Anasistem-araci yaziiminin yénetim etki alanina depolama altsistemleri ekliyorsaniz,
anasistem-araci yazilimini durdurmaniz ve yeniden baglatmaniz gerekir. Hizmeti
yeniden baglattiginizda, anasistem-araci yazilimi yeni altsistemleri bulur ve bunlari
ybnetim etki alanina ekler.

Not: Yeniden baslatma isleminden sonra erisim mantiksal strtictlerinden higbiri
belirlenemezse, anasistem-araci yazilimi otomatik olarak durur. Anasistemden
DS3400 depolama altsisteminin bagdli oldugu SAN arasinda dogru sekilde
calisan bir Fiber Kanal baglantisi oldugundan emin olun. Daha sonra, yeni
anasistem-araci tarafindan yodnetilen depolama altsistemlerin bulunabilmesi igin
anasistemi ya da kiime digumun( yeniden baglatin.

Windows Server 2003 i¢in anasistem-araci yazilimini durdurmak ve yeniden
baslatmak Gizere asagidaki adimlari gergeklestirin:

1. Start » Administrative Tools » Services (Baslat — Y6netim Araglari —
Hizmetler) seceneklerini tiklatin. Services (Hizmetler) penceresi agilir.

2. IBM DS3000 Storage Manager 2 Agent dgesini sag tiklatin.

3. Restart (Yeniden Baslat) segenegini tiklatin. IBM DS3000 Storage Manager 2
Agent durdurulur ve yeniden baslatilr.

4. Services (Hizmetler) penceresini kapatin.

Depolama yonetimi yazilim bilesenlerinin kaldiriimasi

Bir ya da daha ¢ok Storage Manager 2 yazilim bilesenini kaldirmak igin asagidaki
yordami kullanin. Var olan depolama dizisi eslemeleri ve depolama bélimu
yapilandirmalari yazilim kaldirma sirasinda korunur ve yeni istemci yazilimi
tarafindan taninir.

Onemli: Teknik destek temsilciniz tarafindan belirtiimedikge MPIO aygit siiriiciisini
kaldirmayin. Anasistem-araci paketi MPIO islevinin dogru bicimde calismasini
gerektirir.

Storage Manager 2 yazilimini kaldirmak igin asagidaki adimlari tamamlayin:

1. Start » Settings » Control Panel (Baslat — Ayarlar — Denetim Masasi)
segeneklerini tiklatin. Control Panel (Denetim Masasi) penceresi agilir.

2. Add/Remove programs (Program Ekle/Kaldir) 6gesini segin. Add/Remove
Programs Properties (Program Ekle/Kaldir Ozellikleri) penceresi acillir.

3. IBM DS3000 Storage Manager Host Software 02xx.x5.yy 6desini se¢in; burada
XX, ana yayin dizeyini (6rnegin 17 gibi) ve yy, strim( (6rnegin 01 gibi) belirtir.

4. Change/Remove (Degistir/Kaldir) digmesini tiklatin. Uninstall (Kaldirma)
programi baglatilir.

5. Next (ileri) diigmesini tiklatin. “Uninstall options” (Kaldirma segenekleri)
penceresi acllir.

6. Kurulu ttm DS3000 anasistem yazilimi paketlerini ya da yalnizca belirli paketleri
kaldirmay secin ve Next (ileri) digmesini tiklatin. Tim anasistem yazilimi
paketlerini kaldirmayi sectiyseniz, program, kurulu tim anasistem yazilimi
paketlerini kaldirmaya baslar.
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7. Belirli bir anasistem yazilimi paketini kaldirmay sectiyseniz, kaldirmak istediginiz
anasistem yazilimi paketlerini secin ve Uninstall (Kaldir) d0gmesini tiklatin.

8. DS3000 anasistem yazilimi kaldirma islemini tamamlamak icin Done (Bitti)
digmesini tiklatin. MPIO’yu kaldiriyorsaniz, anasistem sunucusunu yeniden
baslatmaniz gerekir.
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Bolum 10. Ek 6zelliklerin etkinlestiriimesi ve kullaniimasi

Ek &zellikler, temel depolama altsistemi modelinizde sinirli olan ya da kullaniimayan
gorevleri gerceklestirmenizi saglayan gelistiriimis islevsellik saglar.

Bir DS3000 depolama altsistemi icin asagidaki ek 6zellikleri satin alabilirsiniz:

DS3200 Software Feature Pack

DS3400 Software Feature Pack

DS3000 FlashCopy Expansion License
DS3000 Volume Copy License

DS3000 FlashCopy Volume Copy License
DS3000 Partition Expansion License

Bir ek 6zelligi satin almaya iliskin bilgi icin IBM pazarlama temsilcinizle ya da yetkili
saticinizla gérasan.

Etkinlestirme anahtari dosyasinin edinilmesi ve bir ek 6zelligin
etkinlestirilmesi

Etkinlestirme anahtari dosyasini edinmek igin ek 6zelliginizle birlikte génderilen
Activation Instructions (Etkinlestirme Ydnergeleri) belgesindeki ydnergeleri izleyin.
Etkinlestirme anahtari dosyasi, ek 6zelliginizi etkinlestiren Storage Manager yazilimi
icin gereklidir.

DS3200 or DS3400 Software Feature Pack 6zelliginin ekinlestirilmesi

Asagidaki ek 6zellikleri etkinlestirmeden 6nce DS3200 Software Feature Pack ya da
DS3400 Software Feature Pack &zelligini etkinlestirmeniz gerekir:
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DS3000 FlashCopy Expansion License
DS3000 Volume Copy License

DS3000 FlashCopy Volume Copy License
DS3000 Partition Expansion License

IBM Web sitesinden 6zellik paketini etkinlestirme anahtari dosyasini edindikten sonra
Storage Manager yaziliminda Software Feature Pack 6zelligini etkinlestirmek igin
asagidaki adimlari tamamlayin:

1.

Subsystem Management (Altsistem Ydnetimi) penceresini acin ve Tools »
Enable Feature Pack (Araglar — Ozellik Paketini Etkinlestir) seceneklerini
belirleyin. Select Feature Pack Key File (Ozellik Paketi Anahtar Dosyasini Sec)
penceresi acllir.

IBM Web sitesinden edindiginiz 6zellik paketi anahtar dosyasini secin ve OK
(Tamam) dagmesini tiklatin.

Ozellik paketi etkinlestirildikten sonra satin aldiginiz 6zellik anahtarlarini
kullanarak ek 6zellikleri etkinlegtirin.

Not: Ek &zellikleri etkinlestirmeden 6nce DS3200 ya da DS3400 Software Feature

Pack 6zelligini yalnizca bir kez etkinlestirmeniz gerekir. Ek 6zellik anahtarlarini,
Ozellik paketini etkinlestirdikten sonra istediginiz zaman edinebilir ve
uygulayabilirsiniz. Ozellik anahtari edinmeye iliskin sorulariniz igin IBM
pazarlama temsilcinizle ya da yetkili saticinizla gértsin.
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DS3000 Partition Expansion License’in etkinlestirilmesi

DS3000 Partition Expansion License’ini depolama altsisteminde 4 bélimden 16

bélime blyutebilirsiniz. DS3000 Partition Expansion License anahtarini edindikten

sonra bu 6zelligi Storage Manager yazilminda etkinlestirmek igin asagidaki adimlari

tamamlayin:

1. Subsystem Management (Altsistem Ydnetimi) penceresini acin ve Tools »
View/Enable Premium Features (Araglar — Ek Ozellikleri Gériintiile/Etkinlestir)
seceneklerini belirleyin.

2. Enabled Premium Features (Etkinlestirilen Ek Ozellikler) altinda Upgrade a
feature (Bir 6zelligi buyut) secenegini tiklatin (bkz.|Sekil 29).

EEFAEIENEN

Tools = Visu/Enable Premium Features

View/Enable Premium Features
“ou must have the sppropriste premium festure key to ensble or upgrade = festure.

Enabled Premium Features
Unorade = feature

Storage Partitioning
Parlfions used: 0
Parttions allowett 4 (Upgradabls to maxiniutn of 16)

Disabled Premium Features
Enable a festure

m FlashCopy Logical Drives
@ Logical Drive Copy

Feature Enable Identifier: [31353994360091 3538393900454076D5

Close

Sekil 29. View/Enable Premium Features (Ek Ozellikleri Gériinttile/Etkinlestir) penceresi

Select Feature Key File (Ozellik Anahtari Dosyasini Seg) penceresi acllir.

3. IBM Web sitesinden edindiginiz 6zellik anahtari dosyasini segin ve OK (Tamam)
digmesini tiklatin.

4. Enable Premium Feature (Ek Ozelligi Etkinlestir) penceresinde Yes (Evet)
digmesini tiklatin.

DS3000 FlashCopy Expansion License’in etkinlestiriimesi

DS3000 FlashCopy Expansion License anahtarini edindikten sonra, Storage

Manager yaziliminda bu &zelligi etkinlestirmek igin asagidaki adimlari tamamlayin:

1. Subsystem Management (Altsistem Y6netimi) penceresini agin ve Tools »
View/Enable Premium Features (Araglar — Ek Ozellikleri Gérlntlle/Etkinlestir)
segeneklerini belirleyin.

2. Disabled Premium Features (Devre Disi Birakilan Ek Ozellikler) altinda Enable
a feature (Bir 6zelligi etkinlestir) segenegdini tiklatin (bkz.|Sekil 29). Select Feature
Key File (Ozellik Anahtari Dosyasini Seg) penceresi agllir.

3. IBM Web sitesinden edindiginiz 6zellik anahtar dosyasini segin ve OK (Tamam)
digmesini tiklatin.
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4. Enable Premium Feature (Ek Ozelligi Etkinlestir) penceresinde Yes (Evet)

diagmesini tiklatin.

DS3000 VolumeCopy License’in etkinlestirilmesi

Not: VolumeCopy ve Logical Drive Copy terimleri, bu belgede, Storage Manager

Client programi arabiriminde ve ¢evrimigi yardimda birbirinin yerine
kullaniimigtir.

DS3000 Volume Copy License’i etkinlestirmek igin asagidaki adimlari tamamlayin:

1.

Subsystem Management (Altsistem Yonetimi) penceresini agin ve Tools »
View/Enable Premium Features (Araglar — Ek Ozellikleri Gorlintlle/Etkinlestir)
segeneklerini belirleyin.

Disabled Premium Features (Devre Disi Birakilan Ek Ozellikler) altinda Enable
a feature (Bir 6zelligi etkinlestir) segenegini tiklatin (bkz.|$eki| 29 sayfa 100|).
Select Feature Key File (Ozellik Anahtari Dosyasini Seg¢) penceresi agilir.

IBM Web sitesinden edindiginiz 6zellik anahtar dosyasini secin ve OK (Tamam)
digmesini tiklatin.

Enable Premium Feature (Ek Ozelligi Etkinlestir) penceresinde Yes (Evet)
digmesini tiklatin.

FlashCopy ek 6zelliginin kullaniimasi

Bir FlashCopy mantiksal strlcisi, mantiksal strliciniin temel mantiksal siricu
olarak adlandirilan mantiksal anlik gérintistdir. FlashCopy mantiksal stirlictisi
asagidaki 6zelliklere sahiptir:

Kisa strede olusturulur ve normal bir mantiksal sGriiciden daha az yer gerektirir.
Bu siriciye bir anasistem adresi atanabilir, béylece temel mantiksal strtict
cevrimici ve erisilebilir durumdayken FlashCopy mantiksal strlcistnd kullanarak
yedekleme gerceklestirebilirsiniz.

FlashCopy mantiksal stirlicisini uygulama testi ya da hem senaryo gelistirme,
hem de analiz igin kullanabilirsiniz. Bu, gergek tretim ortamini etkilemez.

izin verilen FlashCopy mantiksal siiriiciisii sayisi (ist siniri, denetleyici modelinizin
destekledigi toplam mantiksal strlicl sayisinin yarisi kadardir.

FlashCopy 6zelligi ve FlashCopy mantiksal strlcUlerinin nasil yénetilecegiyle ilgili
bilgiler icin Subsystem Management (Altsistem Y&netimi) ¢evrimici yardimina bakin.

Onemli: FlashCopy siiriiciisii, Windows Server 2003 ya da NetWare ortaminda
FlashCopy mantiksal stricisinin temel mantiksal sdricisine sahip sunucuya
eklenemez ya da bu sunucuyla eslenemez. FlashCopy mantiksal slrlcisini baska
bir sunucuyla eslemelisiniz.

Bir FlashCopy mantiksal sirlcisi olusturmak igin asagidaki adimlari tamamlayin:

1.

Temel mantiksal strlictinin dogru anlk gérantisine sahip oldugunuzdan emin
olmak icin, temel mantiksal slrtctdeki uygulamalari durdurun ve énbellek
G/C’sini bu temel mantiksal siriictye ylkleyin.

Subsystem Management (Altsistem Ydnetimi) penceresini agin Configure -
Create FlashCopy Logical Drive (Yapilandir — FlashCopy Mantiksal Sirtictsu
Olustur) segeneklerini tiklatin ve sihirbazdaki yénergeleri izleyin.

FlashCopy mantiksal siriicisinu anasisteme eklemeye iliskin yonergeler igin
Subsystem Management (Altsistem Ydnetimi) gevrimici yardimina bakin.
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Not: Olusturulan FlashCopy Logical Drive’lari ydénetmek igin Modify (Degistir)
etiketini tiklatin ve Modify FlashCopy Logical Drives (FlashCopy Mantiksal
Sarlcilerini Degistir) secenegini belirleyin. Disable FlashCopy Logical Drives
(FlashCopy Mantiksal Surticilerini Devre Digi Birak), Re-create FlashCopy
Logical Drives (FlashCopy Mantiksal Sirtictlerini Yeniden Olustur) ya da
Expand the FlashCopy Repository (FlashCopy Havuzunu Genislet)
segenegini tiklatin ve sihirbazin yénergelerini izleyin.

VolumeCopy 6zelliginin kullaniimasi

VolumeCopy 6zelligi, bir depolama dizisindeki mantiksal siricl verilerini kopyalamak
icin kullanilan sabit yazilm tabanh bir mekanizmadir. Bu 6zellik bir sistem ydnetimi
aracli olarak, donanim biyitmeleri ya da basarim yénetimi icin verileri diger
sUrtculere yeniden dagitmak, veri yedeklemek ya da anlik gértnta birim verilerini geri
yUklemek gibi gorevler igin kullanilir. VolumeCopy isteklerinizi, iki uyumlu strici
belirterek génderebilirsiniz. Bir striict kaynak, digeri ise hedef olarak belirlenir.
VolumeCopy isteg@i kalicidir, bu nedenle kopyalama isleminin ilgili tim sonuglar size
bildirilebilir.

VolumeCopy 6zelligi ve VolumeCopy mantiksal strtcilerinin nasil yénetilecegiyle
ilgili ek bilgi icin Subsystem Management (Altsistem Yénetimi) gevrimici yardimina
bakin.

Bir VolumeCopy olusturmak icin Subsystem Management (Altsistem Y&netimi)
penceresini acin, Configure » Create Volume Copy (Yapilandir — VolumeCopy
Olustur) segeneklerini tiklatin ve sihirbazin ydnergelerini izleyin.
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Not: Olusturulan VolumeCopy mantiksal sdricllerini ydnetmek icin Modify -
Manage Logical Drive Copies (Degistir — Mantiksal Strlici Kopyalarini
Yonet) segeneklerini tiklatin. Bir VolumeCopy istekleri listesi gortintilenir. Her
bir VolumeCopy icin Re-Copy (Yeniden Kopyala) ya da Stop (Durdur)
secenegini belirleyebilir ve dznitelikleri degistirmek icin Permissions (izinler) ve
Priority (Oncelik) 63esini secebilirsiniz. icinde bu arag
gosterilmektedir.

% ¥PN_S5 IBM System Storage D53000 Storage Manager 2 (Subsystem Management)

@ [ 2|4

.@‘

Summary Configure Modify Tools Support
Modify = Manage Logical Drive Copies
Manage Logical Drive Copies @ view Frequently Asked Questions

Priority

Source Logical Drive Tatget Logical Drive Status Titnestarnp

FRe-Copy. |
Stop

Bermiszsions. .. |
Priarity... |
Remove |

Total number of copies: 1 Estirnated time remaining: 3 minutes

i Read-only logical drives

Cloze

Sekil 30. Manage Logical Drive Copies (Mantiksal Sdrcicii Kopyalarini Yénet) penceresi
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Ek A. Depolama altsistemi ve denetleyici bilgisi kaydi

[Cizelge 12]iginde depolama altsistemi adlarini, yénetim tiplerini, Ethernet donanim
adreslerini ve IP adreslerini kaydetmek icin bir veri sayfasi yer alir. Bu ¢gizelgenin bir
kopyasini ¢ikarin ve icine kendi depolama altsistemleriniz ve denetleyicilerinizle ilgili
bilgileri doldurun. Bu bilgileri ag sunucusu i¢in BOOTP cizelgesi ve anasistem ya da
DNS (Domain Name System; Etki Alani Ad Sistemi) gizelgesini hazirlamakta kullanin.
Bu bilgiler ayrica ilk kurulustan sonra depolama altsistemi eklerken de yararli
olacaktir. Her bir situn bashgi, bilgiyi elde etmeye ydnelik ayrintili ydnergeler igin
sayfa bagvurusu igerir. Bilgi kaydi érnegini gérmek igin, bkz. [Cizelge 11 sayfa 31}

Cizelge 12. Depolama altsistemi ve denetleyici bilgisi kaydi

Depolama
altsisteminin adi
(sayfa[30)

Yoénetim yéntemi
(sayfa[7)

Denetleyiciler: Ethernet ve IP adresleri ve
anasistem ad (sayfa[30]ve 31)

Anasistem: IP adresi ve
anasistem adi (sayfa[31)

© Copyright IBM Corp. 2006
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Ek B. Erisilebilirlik

Bu kisimda, DS3000 Storage Manager yaziliminin erisilebilirlik 6zelligi olan, diger
klavye kullanarak gezinme hakkinda bilgi verilmektedir. Erisilebilirlik 6zellikleri,
hareket ya da gérme bozuklugu gibi fiziksel engeli bulunan bir kullanicinin yazilim
arOnlerini basariyla kullanmasina yardimci olur.

Bu bélimde agiklanan diger klavye islemleriyle, Storage Manager gérevlerini
gerceklestirmek ve fareyle de gergeklestirebileceginiz birgok meni islemini baglatmak
icin tus ya da tus birlesimlerini kullanabilirsiniz.

Bu bélimde agiklanan klavye islemlerine ek olarak Windows icin DS3000 Storage
Manager 2 yazilim kurulusu paketi, bir ekran okuyucu yazilim arabirimini igerir. Ekran
okuyucuyu etkinlestirmek icin, Storage Manager 2 yazilimini Windows anasistemine
ya da ydnetim istasyonu ortamina kurmak zere kurulus sihirbazini kullanirken
Custom Installation (Ozel Kurulus) secenegini belirleyin. Daha sonra Select Product
Features (Urtin Ozelliklerini Segme) penceresinde gerekli diger anasistem yazilim
bilesenlerine ek olarak Java Access Bridge 6zelligini de isaretleyin.

Klavye odagi, yardim gériintileme penceresinin bélmelerinde her zaman net bir
sekilde goérintilenmez. Klavye odagdinin nerede oldugunu géremiyorsaniz, Ctrl+F1
tuslarina basin. Odak, ara¢ cubugundaki Geri, ileri, Yazdir ya da Sayfa Diizeni
digmesindeyse, diigme icin diger metin gértntllenir. Diger metin gérintilenmezse,
klavye odagi bir digme zerinde degildir. Odagin gezinme etiketlerinden birinde
(Contents (igindekiler) etiketi, Index (Dizin) etiketi ya da Search (Ara) etiketi) olup
olmadigini gérmek icin Ctrl+Sekme tuslarina basin. Odak, gezinme etiketlerinden
birindeyse, odagi ara¢ cubugu bdlmesine getirmek icin Ust Karakter+Sekme tuslarina
basin.

icinde kullanici arabirimi bilesenlerinde gezinmek, bu bilesenleri segmek
ya da etkinlestirmek icin kullanabileceginiz klavye islemleri agiklanmaktadir. Tabloda
asagidaki terimler kullaniimigtir:

» Gezinme, bir kullanici arabirimi bilesenindeki giris odagini baska bir bilesene
tasimak anlamina gelir.

+ Sec¢me, genellikle ardisik islemler igin bir ya da daha fazla bileseni se¢mek
anlamindadir.

» ,Etkinlestirme, bir bilesene iligkin islemi gergeklestirme anlamina gelir.
Genellikle bilesenler arasindaki gezinme isleminde asagidaki tuglar kullanihir:

Not:

« Sekme: Klavye odagini sonraki bilesene ya da sonraki bilesen grubunun ilk
Oyesine tasir

+ Ust Karakter+Sekme: Klavye odagini dnceki bilesene ya da énceki bilesen
grubunun ilk bilesenine tagir

* Ok tuslari: Klavye odagini, bilesenler grubundaki bilesenler arasinda
hareket ettirir

Cizelge 13. DS3000 Storage Manager yazilimi diger klavye islemleri

Kisayol islem

F1 Yardim’i agar.
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Cizelge 13. DS3000 Storage Manager yazilimi diger klavye islemleri (devami var)

Kisayol islem

F10 Klavye odagdini ana menl gubuguna ve sonraki ilk
mendye tasir; kullanilabilir segcenekler arasinda gezinmek
icin ok tuglarini kullanin.

Alt+F4 YOnetim penceresini kapatir.

Alt+F6 Klavye odagini, standart olmayan pencereler arasinda ve

ybnetim pencereleri arasinda hareket ettirir.

Alt+ alti ¢izili harf

Alti gizili harflerle iliskilendirilen meni 6gelerine,
digmelere ve diger arabirim bilesenlerine erisim saglar.

Meni segeneklerinde ana menuye erismek igin
Alt+alti_cizili_harf segeneklerini belirledikten sonra, tek bir
meni 6gesine erismek icin alti gizili harfe basin.

Diger arabirim bilesenleri icin Alt+alti_cizili_harf
seceneklerine basin.

Ctrl+F1 Klavye odagi ara¢ gubugundayken arag ipucunu
g6rintiler ya da gizler.
Ara gubugu Bir 6geyi secer ya da bir baglantiyi etkinlestirir.

End, Page Down

Klavye odagini listenin son 6gesine tasir.

Esc

Gegerli iletisim penceresini kapatir (klavye odaginin
iletisim kutusunda olmasi gerekmez).

Home, Page Up

Klavye odagini listenin ilk 6gesine tasir.

Ust Karakter+Sekme

Klavye odagini ters yéndeki bilesenlere tasir.

Ctrl+Sekme Klavye odagini bir gizelgeden sonraki kullanici arabirimi
bilesenine tasir.
Sekme Klavye odaginin bilesenler arasinda gezinmesini saglar ya

da bir baglantiyi etkinlestirir.

Asagi Ok Tusu

Klavye odagini listede bir altta yer alan 6geye tagir.

Sola Ok Tusu

Klavye odagini sola tasir.

Saga Ok Tusu

Klavye odagini sagda tasir.

Yukari Ok Tusu

Klavye odagini listede bir Ustte yer alan 6geye tasir.
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Ek C. Yardim

ve teknik destek alinmasi

Yardima, hizmete ya da teknik yardima gereksinim duyuyorsaniz ya da IBM
aranleriyle ilgili daha fazla bilgi almak istiyorsaniz, size yardimci olabilecek ¢ok cesitli
IBM kaynaklari bulabilirsiniz. Bu ekte, IBM ve IBM Urtnlerine iligkin ek bilgi igin
bakmaniz gereken yerler, sisteminizle ya da istege bagl aygitinizla ilgili bir sorunla
karsilastiginizda yapmaniz gerekenler ve gerektiginde, hizmet i¢in baglanti kurmaniz
gereken Kigiler belirtilir.

Aramadan once

Aramadan 6nce, sorunu kendi baginiza ¢ézmeyi denemek lizere asagidaki adimlari
gergeklestirdiginizden emin olun:

» TUm kablolarin bagli oldugundan emin olun.

* Sunucunun ve istege bagl aygitlarin agik oldugundan emin olmak igin
acma/kapama digmelerini denetleyin.

* Sunucu belgelerinizdeki sorun giderme bilgilerini ve sunucunuzla birlikte gelen
tanilama araglarini kullanin. Tanilama araglarina iligkin bilgileri, sunucunuzla
birlikte gdnderilen IBM Documentation CD’sindekiHardware Maintenance Manual
and Troubleshooting Guide (Donanim Bakim Elkitabi ve Sorun Giderme Kilavuzu)
ya da Problem Determination and Service Guide (Sorun Belirleme ve Hizmet
Kilavuzu) adli yayinlardan bulabilirsiniz.

 Teknik bilgileri, ipuglarini ve yeni aygit surticilerini denetlemek ya da bilgi igin
istekte bulunmak (izere http://www.ibm.com/systems/support]| adresinden IBM
Support (Destek) Web sitesine gidin.

IBM’in gevrimigi yardimda sagladidi ya da IBM Uriinindzle birlikte génderdigi
belgelerde saglanan sorun giderme yordamlarini izleyerek birgok sorunu disaridan
yardim almadan ¢dzebilirsiniz. IBM sistemleriyle birlikte gelen belgelerde,
gerceklestirebileceginiz tanilama sinamalari da agiklanmaktadir. Birgok sistem,
isletim sistemi ve program, sorun giderme yordamlarini ve hata iletilerinin ve hata
kodlarinin agiklamalarini iceren belgelerle birlikte génderilir. Bir yazilim sorunundan
sUpheleniyorsaniz, igletim sisteminin ya da programin belgelerine bakin.

Belgelerin kullaniimasi
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IBM sisteminiz ve varsa, dnceden kurulmus yazilimla ya da istege bagli aygitlarla
ilgili bilgiler, rtinle birlikte gdnderilen belgelerde bulunur. Bu belgeler, yazih belgeleri,
cevrimigi belgeleri, benioku dosyalarini ve yardim dosyalarini igerir. Tanilama
programlarini kullanmaya iligkin yénergeler icin sisteminizle birlikte génderilen
belgelerde bulunan sorun giderme bilgilerine bakin. Sorun giderme bilgileri ya da
tanilama programlari, sizin ek ya da gliincellenen aygit siriicllerine ya da diger
yazilimlara gereksiniminiz oldugunu belirtebilir. Internet’te en son teknik bilgileri
edinebileceginiz ve aygit suricdlerini ve gincellemeleri yikleyebilecegdiniz IBM
sayfalari vardir. Bu sayfalara erigmek igin|nttp://www.ibm.com/support| adresine gidin
ve ybnergeleri izleyin. Ayrica, bazi belgelere |http://www.ibm.com/shop/publications/|
adresindeki IBM Publications Center icinden erigebilirsiniz.
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Internet’ten yardim ve bilgi alinmasi

Internet’te IBM Web sitesinde, IBM sistemlerine, istege bagli aygitlara, hizmetlere ve
destege iliskin bilgiler bulunur. IBM System x ve xSeries bilgilerini
http://www.ibm.com/systems/x/ adresinde bulabilirsiniz. IBM BladeCenter bilgilerini
http://www.ibm.com/systems/bladecenter/ adresinde bulabilirsiniz. IBM IntelliStation
bilgilerini|http://www.ibm.com/intellistation/| adresinde bulabilirsiniz.

IBM sistemleri ve istege bagh aygitlarina iliskin hizmet bilgilerini
Ihttp://www.ibm.com/systems/support| adresinde bulabilirsiniz.

Yazihim Hizmeti ve Destegi

Belirli bir Gcret karsihdinda IBM Destek Hatt'ndan System x ve xSeries sunucularina,
BladeCenter Urlnlerine, IntelliStation is istasyonlarina ve aygitlara iliskin kullanim,
yapilandirma ve yazilim sorunlariyla ilgili telefon yardimi alabilirsiniz. Ulkenizde ya da
bélgenizde Destek Hatti tarafindan desteklenen Grlnlerle ilgili bilgi almak i¢in bkz.
http://www.ibm.com/services/sl/products/ .

Destek Hattr’'na ve diger IBM hizmetlerine iliskin bilgi icin|http://www.ibm.com/|
services/| adresine bakin ya da destek telefon numaralari igin |http://www.ibm.com/

lanetwide/ adresine bakin. ABD ve Kanada’'da, su numarayi arayin:
1-800-IBM-SERV (1-800-426-7378).

Donanim Hizmeti ve Destegi

IBM Services (IBM Hizmetleri) ya da IBM tarafindan garanti hizmeti verme yetkisi
verilmigse, IBM yetkili saticinizdan donanim destegi alabilirsiniz. Destek telefon
numaralari icin |http://www.ibm.com/planetwide/ adresine bakin ya da ABD ve
Kanada’da, su numarayi arayin: 1-800-IBM-SERV (1-800-426-7378).

ABD ve Kanad_a’da, donanim hizmetine ve destegine haftada 7 giin 24 saat
ulasabilirsiniz. Ingiltere’de, bu hizmetler Pazartesi'den Cuma’ya kadar sabah 9:00,
aksam 18:00 saatleri arasinda verilmektedir.

IBM Tayvan Urin hizmeti

518 IBM i i iz 55 e i U7 =

5 5 B 5 g 5 e e 00 15 PR 22 ]
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FE7% 1 0800-016-888

=,

IBM Tayvan Uriin hizmeti iletisim bilgileri:
IBM Taiwan Corporation
3F, No 7, Song Ren Rd.
Taipei, Taiwan
Telefon Numarasi: 0800-016-888
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Ek D. Ozel Notlar

Bu yayindaki bilgiler, ABD’de kullanima sunulan Uriin ve hizmetlere iliskindir.

IBM, burada anilan Urtnleri, hizmetleri ve aksami diger Ulkelerde satisa sunmamig
olabilir. Ulkenizde hangi tiriin ve hizmetlerin saglandigini égrenmek icin yerel IBM
temsilcinize basvurun. IBM Grlinlerine, programlarina ya da hizmetlerine yapilan
gbndermeler, yalnizca o Grliniin, programin ya da hizmetin kullanilabilecegini
gbstermez. IBM’in fikri malkiyet haklari g6z dniinde bulundurularak, ayni iglevi géren
farkh Grin, program ya da hizmetler de kullanilabilir. Ancak IBM disi kaynaklardan
saglanan Urun, program ve hizmetlerle gerceklestirilen islemlerin degerlendiriimesi ve
dogrulanmasi kullanicinin sorumlulugundadir.

IBM’in, bu belgedeki konularla ilgili patentleri ya da patent bagvurular olabilir. Bu
belgenin size verilmis olmasi size bu patentlerin lisansinin verildidi anlamina gelmez.
Lisans sorulariniz igin asagidaki adrese yazil olarak basvurabilirsiniz:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

ABD

IBM BU YAYINI, HAK iHLALI YAPILMAYACAGINA DAIR ZIMNi GARANTILERLE
TICARILIK VEYA BELIRLI BIR AMACA UYGUNLUK ICIN ZIMNi GARANTILER DE
DAHIL OLMAK VE FAKAT BUNLARLA SINIRLI OLMAMAK UZERE ACIK YA DA
ZIMNI HICBIR GARANTI VERMEKSIZIN “OLDUGU GIBi ESASIYLA”
SAGLAMAKTADIR. Bazi tlkeler (ya da bélgeler) belirli islemlerde acik ya da zimni
garantilerin reddedilmesine izin vermezler; bu nedenle, bu agiklama sizin igin gegerli
olmayabilir.

Bu yayinda teknik yanlishklar ya da yazim hatalar olabilir. Buradaki bilgiler diizenli
araliklarla giincellenir ve yayinin yeni basimlarina eklenir. IBM, bu yayinda s6z{
edilen GrGn ve/veya programlarda istedigi zaman duyuruda bulunmaksizin gelistirme
ve degisiklik yapabilir.

Bu bilgilerde, IBM disi Web sitelerine yapilan géndermeler yalnizca kolaylik
saglamak icindir ve IBM’in bu tiirden Web sitelerinin kullanimini onayladigi ya da
kabul ettigi anlamina gelmez. iigili Web sitelerindeki bilgiler, bu IBM Griintine iliskin
bilgilerin bir bdlimu degildir ve bu Web sitelerinin kullanimi sonrasinda ortaya
¢ikacak sonuglar kullanicinin sorumlulugundadir.

IBM, size higbir sorumluluk yiklemeden, sizin sagladiginiz ve uygun olduguna
inandid1 her turlQ bilgiyi kullanabilir ya da yayabilir.

Ticari Markalar
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Asagidaki terimler, IBM Corporation’in ABD’de ve/ya da diger Ulkelerdeki ticari
markalaridir:

BladeCenter IntelliStation System x
IBM ServerProven TotalStorage
IBM (logo) System Storage xSeries
FlashCopy
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Intel, Intel Xeon, Itanium ve Pentium, Intel Corporation’in ya da yan kuruluglarinin
ABD’deki ve/veya diger Ulkelerdeki ticari markalari ya da tescilli ticari markalarndir.

Microsoft, Windows ve Windows NT, Microsoft Corporation’in ABD’deki ve/veya diger
Ulkelerdeki ticari markalaridir.

UNIX, The Open Group’'un ABD’de ve diger Ulkelerdeki tescilli markasidir.

Java ve tim Java tabanli ticari markalar ve logolar, Sun Microsystems Inc.’in ABD’de
ve/veya diger Ulkelerdeki ticari markalaridir.

Linux, Linus Torvalds’in ABD ve/veya diger Ulkelerdeki ticari markasidir.
Red Hat, Red Hat “Shadow Man” logosu ve tiim Red Hat tabanl ticari markalar ve
logolar, Red Hat, Inc.’in ABD’deki ve/veya diger Ulkelerdeki ticari markalari ya da

tescilli ticari markalaridir.

Diger sirket, Griin ya da hizmet adlari, diger firmalara ait ticari marka ya da hizmet
markalari olabilir.

Onemli notlar

IBM, ServerProven 6zelligine sahip IBM digi Grlnler ve hizmetler igin 6neride
bulunmaz ya da ticari kullanima ve 6zel amagclara uygunluk yéninde &rtik de olsa
hicbir garanti vermez. Bu Urlinler yalnizca G¢lincl kisiler tarafindan sunulur ve garanti
hizmeti altina alinir.

IBM, IBM disi Urtnlerle ilgili higbir dneride bulunmaz ya da garanti vermez. IBM disi
arinlere iligkin destek (varsa), IBM tarafindan degil, G¢tlinct kisiler tarafindan
saglanir.

Bazi yazilimlar, perakende siriminden (varsa) farkli olabilir ve kullanici elkitaplarini
ya da tim program islevselligini icermeyebilir.
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